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be3onacHOCTb

B aTom paspene paccmMaTpuUBarTCA cneayrouime Bonpocobl.

®  DJIEKTPUUECKUS DE3OMUCHOCTD w.oovrverrversreresseesssesssesssensssssssssssssssssssessssessaesssssssssssssssssssssssnees 8
®  Be30NAaCHOCTD NMPU IKCTUTYOTALM . coceemreeemsreenseeessseeessseesssssessssasssssessssssssssssssssssssssssasssssesssssesees 9
o Be30MnacHOCTb NPU OOCTYIKUBAHUM .....ceeereeerrerersenssesssesssssssssssssssssssanns 12
e CvMMBOJbI HO NpHUHTEpE e 13

JaHHbIN NPUHTEP M PEKOMEHAYEMbIe PACXOAHbIE MATEPUAIbI PA3pABOTAHbI C yUETOM CTPOTUX
TpeboBAHWIM TEXHWUKKM HE30MACHOCTH W MPOLLIM NMPOBEPKY HA COOTBETCTBME 3TUM TpeboBAHHUAM. TouHoe
coblofieHK e cneayioLLMX NpABKa 06ecneunT AnuTenbHyto U 6esonacHyto paboTy npuHTepa Xerox®.
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be3sonacHocTb

JneKkTpuyeckana 6e3onacHoCTb

Obuwme NHCTPYKLU MK

A\ NPEAYNPEXAEHUA.

e  He BCTaBnsTe HUKAKMX NPEAMETOB B LN U OTBEPCTUA NpuHTepa. KOHTAKT ¢
BbICOKUM HANpPAXeHNeM U KOPOTKOE 3aMbIKAHWE MOTr'yT NpUBECTU K NOXapy Uiu
NMOPAXEHUIO I/IEKTPUYECKUM TOKOM.

e He cHMMaliTe KPbILWKK U OrpaXKAEHWSA, 30KPerJIeHHble BUHTAMM, 30 UCK/IOYEHUEM
C/ly4aeB YCTAHOBKMW A0MOJIHUTENIbHOrO 060pPYL0BAHUS U BbINOSIHEHUA CNELUAIbHbBIX
WMHCTPYKLUMH. MNP BbINOSIHEHWW TOKOW YCTAHOBKK NUTAHKWE Ao/KHO 6b1Tb OTKJ/IIOYEHO.
YcTaHaBAMBAA JONOSHUTENbHOE 060pYA0BAHMWE, BbIHbTE LUHYP MUTAHWA U3 PO3ETKHU.
Kpome ycTaHasnvMBaemMoro fonoIHUTENbHOro 060pyA0BAHMSA, MOA STUMH KPbILLKAMHU
HeT AeTanew, NoANEXaLLMX 06CNYHKUBAHUIO MOJIb30OBATENEM.

Yrpo3a Bawe 6e30MacHOCTY BO3HUKAET B CNeAYOLMX CyYasX:
e LUHyp NUTaHWA NOBPEXAEH NI U3HOLLEH.

e B npuHTep nonana )XuMaKoCTb.

e [lpyHTEp HaMOK.

Mpy BO3HUKHOBEHWU NOBOM M3 NEepeUYrCIEHHbIX CUTYALMI BbINOJIHUTE ClieAylolue AeNCTBUS:
1.  HemeaneHHO BbIKAOUYAUTE NPUHTEP.

2. BblHbTe WHYP NUTAHUA U3 PO3ETKM.

3. ObparuTech B yNONHOMOYEHHOE CEPBUCHOE NPeACTABUTENbCTBO.

JlazepHas 6e30nacHOCTb

JlaHHbIM Na3epHbIM NPUHTEP COOTBETCTBYET CTAHAAPTAM AJ1 JIA3EPHbIX YCTPOMCTB, YCTAHOBAEHHbIM
NPABUTENBCTBEHHBIMM, FOCYAAPCTBEHHBIMU U MEXAYHAPOAHBIMW OPraHU3ALMSAMU, U CEPTUPHULMPOBAH
KOK fla3epHoe yCTporcTBo knacca 1. NpuHTep He SBNAeTCA MCTOYHUKOM OMACHOTO U3NTyYeHus,
MOCKOJIbKY JIO3ePHbIM S1y4 HAXOAWUTCS B MOJIHOCTBIO 3AKPbITOM NMPOCTPAHCTBE BO BCEX PEXUMAX paboThl 1
06CNYKMBAHUS.

A\ NPEAYNPEXAEHUE. Mcnonb30oBaHWe He YKA3AHHbIX B STOM PYKOBOACTBE CPEACTB YNPAB/EHHS,
HACTPOEK 1 Npoueayp MOXeT NPUBECTH K ONACHOMY BO34EMUCTBUIO IA3€PHOr0 U3NTyYeHUs.
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be3sonacHocTb

be3onacHOCTb NpU 3KCNNyaATAL MUK

MpuHTep 1 pacxoaHble MaTepuasibl pa3paboTaHbl C y4eTOM CTPOrMX TPe6OBAHMIM TEXHUKK 6€30MacHOCTH
W NPOLLKW NPOBEPKY HA COOTBETCTBUE STUM TPebOBAHUAM. ITO BK/IOUAET MPOBEPKY U YTBEPKAEHHE
AreHTCTBAMM M0 TeXHUKe 6e30MaCHOCTH, a TAKKE COOTBETCTBME YCTAHOBIEHHBIM CTAHAAPTAM OXPAHbI
OKpyXawLlen cpeapl.

CO6J'HO£I,€HVI€ BAMMU MNMepeynCcneHHbIX yCﬂOBMﬁ obecneunt ONNTEJIbHYHO U 6630I'ICICHyIO pCl60Ty NnpuHTEpPA.

Bbiaenernume o3oHa

B npouecce HOpMCU'IbHOI‘/’I pC16OTbI NPUHTEPA BblAENAETCA O30H. KonunuecTtBo BblAENAEMOro 030HA
30BUCHT OT 06BEMOB KOMMPOBAHMUA. O30H TsXkenee BO34YyXd M BblAENAETCA B KOJIMYECTBAX,
HeAOCTATOYHbIX ANnA NpUYNHEHUA Bpead 340POBbiO. anHTep caneayet yCtTaHAB/IMBATL B XOPOLWO
npoBeTpnuBaAEMOM NMNOMELLEHUHN.

HononHuTtenbHble cBeaeHuna ana CLUA v KaHaabl cm. Ha Beb-carTe www.xerox.com/environment . B
ZApYrux permoHax obpaTuTecb B MECTHOE NPeACTABUTENLCTBO XErox Uamn nocetTute Beb-camt
www.xerox.com/environment_europe.

PasmeleHune npuHTepa

e  Place the printer on a level, solid non-vibrating surface with adequate strength to hold the weight of
the product. The base printer weight without any packaging materials is approximately 19.2 kg
(42.2 1b.).

e He 6710KMpyITE M HE 30KPbIBAMTE LWENWU U OTBEPCTUA NPUHTEPA. ITU OTBEPCTUA NPeAHA3HAYEHbI AN1A
BEHTUNALMK W NpeA0TBPALLEHMA Neperpesa NpUHTepa.

e  PasmelwyaiiTe npuHTEp TaKMM 06paA30M, UTOBbI OCTABAIOCH AOCTATOYHO CBOBOAHOTO MecTd AJis
paboTbl M 06CNYKMBAHUS.

e [puHTep He ciegyeT YCTAHAB/IMBATD B MblJIbHBIX MOMELLEHUAX U MPOCTPAHCTBAX.

o anHTep HeNb3A XPAHUTb U SKCNTYATUPOBATb B YC/T0BHUAX BbICOKUX U HU3KUX TeMNEPATYP 1IN
BJIAXKHOCTH.

e  He pasmellanTe NpuHTEpP PAAOM C UCTOYHMKOM Tena.

e  He pasmelyaite npuHTEp B MECTAX, F€ OH MOXET NOABEPrHYTbCS BO3AEUCTBUIO NMPAMbIX COJTHEYHbIX
Ny4yel, BO U36exaHWE NOBPEKAEHNUSA UYBCTBUTESNIbHBIX K CBETY KOMMOHEHTOB.

° He pCl3M€LLI,ClﬁT€ NPUHTEP HA NYTKU NOTOKA XOJI04HOIo BO34yxXa U3 KOHANLHUOHEPA.
° He yCTClHClB)'IMBClIZTe NPUHTEP B MECTAX, NOABEPXHKEHHbIX Bl46pClL|,MM.

e  Haunyuwas nporssoauTenbHocTb obecneumBaeTcsa Ha BbicoTe HUXe 3100 m (10 170 ¢yToB) Hag,
YpPOBHEM MOpH.
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be3sonacHocTb

NHCTPYKUMKM NO 3KCNyaTaL MK

°

He cHumariTe notok ana 6ymaru, BbiI6paHHbIM B ApaMBepe AW HA NAHENW YyNpaB/IeHUs, Koraa
BbIMOJIHAETCA NeydTb.

He oTKkpbIBaiTE iBEpLbl BO BpeMs NeyaTh.
He nepemelyaiite npuHTEp BO BpeMs neyatu.

CnepuTte 3a TeMm, UTobbl PYKH, BONOCHI, FAICTYK U T. M. HE NMONAAAIM MEXIY PO/IMKAMU BbIBOAA U
noaauu.

OnacHble y4acTKM NPUHTEPA 3AKPbIThbl KPbILUKAMM, KOTOPblE€ CHUMAIOTCA C MOMOLL b MHCTPYMEHTA.
He cHUMmaliTe 3aWMTHBIE KPbILLIKM.

LLHyp nuTaHmsA

Ucnonb3yiTe WHYP NUTAHKUA, NOCTABASAEMbIN C MPUHTEPOM.

MNoakntouanTe LWHYP NUTAHWA HANPAMYIO K NPABU/IbHO 303eM/IEHHOMN SN1EKTPUYECKON pO3eTKe.
MpoBepbTe HAAEKHOCTb NOAKIOUYEHUA HO 060MX KOHLOX LWHYPA. EC/iM Bbl He 3HaeTe, 3a3emMneHa fiu
po3eTKa, MoNpocuTe CneLmMaIncTa NnpoBepHUThb ee.

He ncnonb3yiTte BUAKY aaanTtepda C 3a3emMneHneM A5 NOAKIIIUYEHHUA NPUHTEPA K CETeBOW po3eTKe
6e3 KOHTAKTA 3a3eMJIeHUA.

NPEAYNPEXAEHUE. MNpaBuabHoe 3a3eMieHWe NPUHTEPA NO3BOJIUT M36eXaTb NOparKeHUA
3/71eKTPUYECKUM TOKOM. [pK HENPABUIBHOM MCMO/Ib30BAHWU 3N1EKTPUYECKHUEe NPUBOpPbI MOTYT
NpeacTaBfATb ONACHOCTD.

Cnep,yeT MCNON1b30BATb TOJIbKO YAJIUHUTENU, PACCHUTAHHDbIE HA pc16oqee HAanpAXxXeHue NnpuHTepa.

Y6epuTech, UTo NPUHTEP NOAKIIHOYEH K pOo3eTKe, obecneunBatoLLelt COOTBETCTBYIOLLEE HANPSIKEHHUE
MUTAHUA U MOLLHOCTb. B cniyyae HeobxoamMmocTn obcyauTe Co CneLManncTOM PeXUMbl MUTAHUS
NpUHTEpA.

He pasmelyaite npuHTEp B TAKOM MeCTe, FAe HA LIHYP NMUTAHUS MOTYT CAIy4aiHO HACTYNWUTb.
He cTaBbTe npeamMeTbl HA LWHYP MUTAHMS.

Mpy1 noBpexaeHUn UM U3HOCE LUHYPA NMUTAHWS 30MeHUTe ero.

He BbIHMMATe BUJIKY LWUHYPA MUTAHWS U3 PO3ETKM, KOTAA NPUHTEP BKJTHOYEH.

Bo n3bexaHre NopaxxeHUs 3NEKTPUUECKUM TOKOM U NOBPEXKAEHWA LUHYPA NUTAHUS NPH
OTCOe[IMHEHWM €ro OT PO3ETKU AePHUTECH 30 BUIIKY.

LLIHYp NUTaHKUA NOAKNIOUAETCA Yepe3 Po3eTKy Ha 3a4Hel naHenun npuHTepa. Ecnun TpebyeTtca nonHoCTbO
OTKJIOUYUTD INIEKTPOMNUTAHUE NPUHTEPA, BbIHbTE BUJIKY LLIHYPA NMUTAHWUA U3 PO3ETKHU.

PacxoaHble maTtepuanbl Ana NpuHTEpaA

10

Wcnonb3yiite pacxoaHble MATEPUAbI, NPEAHA3HAYEHHbIE AN STOM MOAENW NPUHTEpPd.
Mcnonb3oBaHWe HENOAXOAALMX MATEPUAIIOB MOXET NPUBECTU K YXYZLLIEHUIO paboTbl NpUHTEPA U
npeacTasnsATb yrpo3y Ballen 6e3onacHOCTy.

Cnepy¥iTe npepynpexaeHUsiIM HO MAPKUPOBKE U MHCTPYKLMSIM, MOCTAB/SIEMbIM C MPOAYKTOM,
ZLOMOJIHUTENIbHBIMU Y3/1AMU U PACXOAHBbIMU MATEPUAIAMM.

XpClHMTe BCE pacxogHble MmaTtepuaibl, C06J'I}O,£I,CIF| YKA3aHUA, N3/TOXKEHHbIE HA YNAKOBKeE.
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be3sonacHocTb

XpaHuWTe BCe pacxoAHble MaTeprasibl B HEAOCTYMHOM A5 fleTel mecTe.

M3beraiTe KOHTAKTA TOHEPA, TOHEP- U NPUHT-KAPTPUZKEN UK COOPHUKOB TOHEPA C OTPbITbIM
OrHeMm.

Mpv obpatleHnn C KApTPUAKAMM, HANPUMEP TOHEP-KAPTPHULKAMM, Pblo3epom U T.N., U3beramnte
KOHTAKTA TOHepaA C KOXen 1 rnasamu. lMonagaHne ToHepa B r1a3a MOXKET MNPUBECTU K
pasapaXKeHuto 1 BocnasneHuto. He nbiTaiTech pa3obpatb KAPTPUAK: STO NOBbILLAET PUCK KOHTAKTA
TOHEepPAa C KOXKEeW UK M1a3amu.

BHUMAHMUE! He pekomeHayeTcs MCNOb30BATL PACXOAHbBIE MATEPUAbI 4PYTHX MPOU3BOAUTENEN.
FapanTus Xerox®, cornaterune o6 o6cnyxuBanmm u Total Satisfaction Guarantee (O6was rapaHTUs
Ka4yecTBa) He pacrnpoCTPAHATCA HA MNOJIOMKH, HEMPABWUIbHYO paboTy MM CHUXEHWE KadecTBa,
BbI3BAHHbIE MCMOJIb30BAHWEM PACXOAHbIX MATEPUAIOB APYTrMX NPOU3BOAUTENEN UK
MCNOJIb30BAHMEM PACXOAHbIX MATEPUANIOB Xerox, He NpeAHAa3HAYeHHbIX AJ151 3TOro NpUHTEpA.
lapaHTtua Total Satisfaction Guarantee (O6wasn rapaHTusa kavectsa) gericteyeT B CLUA 1 Kanage. B
APYrMX PerMoHax MoryT IeWCTBOBATb ApYrie rapaHTUiMHbIe YCI0BUA. 3a AONOHUTEIbHOM
nHpopmavmei obpallanTecb B MECTHOE NPesCTaBUTENbCTBO KOMMAHWK Xerox.
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be3sonacHocTb

be3onacHOCTb Npu 06CYKUMBAHMH

e He BbINONHANTE HUKAKKUE JEWCTBHUA NO 06CNYKUBAHUIO, HE ONMUCAHHbIE B JOKYMEHTALMU MPUHTEPA.
e He npumeHsiiTe a3po30sibHble OYUCTUTENN. N5l UNCTKU MCNONb3YITE TONBbKO CyXyto 6e3BOpPCOBYHO
TKQHb.

e  He okuraiiTe pacxofiHble MATEpUAbl U KOMMOHEHTbI, MOANEXALLUE PETYIAPHON 3AMEHE.
NHPOPMALMIO 0 MPOrPAMMAX YTUAM3ALIMM PACXOAHBIX MaTepuanos Xerox® cM. Ha Be6-caiiTe

www.xerox.com/gwa.

12 Phaser 6700 Color Printer
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be3sonacHocTb

CUMBOAbI HO NPUHTEpPE

CumBon OnucaHue

«[peaynpexaeHue» Unun «BHUMaHue!»:

Hecobntopenne TpeboBaHMit 3TOro NpeaynpexaeH1a MOXET MPUBECTU K TAXENON TPaBMe K
AQKE K NIETAIbHOMY UCXOAY.

HecobntopeHune M3n10KeHHbIX 34ecb TpebOBAHWI MOXET NMPUBECTH K TPABME WK K
MOBPEXAEHUIO BALLEro UMYLLLEeCTBA.

He cxxuraite c6OpHUK OTXOA0B.

He oxuranTe AAHHBIM KOMMOHEHT.

He ponyckaiTe Bo3zencTBUA CBETA HA 6/10K GOPMUPOBAHMSA M306parkeHUs fonblie 10

‘ o MUHYT.
00:10

He npukacaiTeck K 610Ky $OpMUPOBAHUS M306PAKEHUS.

Phaser 6700 Color Printer 13
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Pexxumbil

B aTom pasgene pacCMaTpmBardTCA cneagyrouime sonpochol.

KomnoHeHTbl npuHTEpa

MHbopMaLMOHHbIE CTPAHHMLbI

Pexxmm sHeprocbepexeHus

®DyHKUMM AMUHUCTPUPOBAHMS

ﬂ.OI’IO)’IHVITeJ'I bHbleé CBeJeHNA

Phaser 6700 Color Printer
PykoBoacTBO nosb3oBarens
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Pexxumbl

KOMMOHeHTbI NpUHTepa

B 3TOM pasgene paccMaTpuBatoTCA CeaytoLme BOnpochl.

O B L CMIEPELM ettt s s ss s s s s s s S RS RRRA e SRR A ssaentae 16
O BUL CNIPOBQ ettt s sss s s s s sss s ssss s s s s s s s s s s st es s s s s s sesessessnssssssassssanssnes 17
O BUL CBOMM ettt sttt s bttt et a bt ae st as st e sasassas et sassasaen 18
®  [TOHEIID YTIPOBIIEHMS c...ceveereeeeeeeeseesseaesssssesssesssssssssssssssssssssasssssssssssssssssssssssssssssssssesssssssssssssssesssessssssasesssesssesssesssesnsssssssnes 18
®  BHYTPEHHUE KOMIMOHEHTDI ..o eeereesreeseeessssssessssssssssssssssssesssssssssssssssssssessssssssesssssssssssssssssssssssssssssssssessssssssssssssssssssssnessss 19
®  HOOOPD A1 OBCTIYIKUBAHUS c.cc.eereeereerreeessesessessssssssssssssssssssssssssssssssssssssssssssesssssssssssssssssssssssssssssssssessssssssssssssssssssssesess 19
©  DUIHUILLIEP oot cess e cessse s sss s ess e s be a8 R A2 R 18R£8 RRERR e RR e 20

Bua cnepeam

1. laHenb ynpasneHusa 7. [ononHuTenbHble yCTPOMCTBA Noaauun Ha 550 nuctoB (N0TKM 3 1 4)
2. BbixogHoM noTtok 8. [dononHutenbHbIM NoaaTunK 6osblion emkocty Ha 1100 nuctos

3. Jlotok 1 (noTkn 51 6)

4. BbIknouatenb NMUTAHUS 9. Pyuku nepeaHeit ABepLbl

5. TepeaHss asepua 10. C6opHHK OTX0A0B

6. JloTok 2 11. [Jeepua otceka 610KoB GOPMHMPOBAHKA U306paXKeHHn

12. ToHep-KapTpUaXu

[prmeyaHme. B npUHTEP MOXHO YCTAHABAWBATDL A0 LLECTU JIOTKOB.

npeﬂyCMOTpeHbl aneaywouime BaApUAaHTbl KOMNNEKTALNKU NOTKAMMU:

16 Phaser 6700 Color Printer
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Pexxumbi

o JlotTkm1wu2

e JloTkn 1 1 2 v oaHO yCTpOKMCTBO nogauun Ha 550 nucros

e Jlotkn 1 n 2 n gBa ycTporcTea nogayn Ha 550 nncros

e Jlotkn 1 1 2 v ogmH NnoaaTynK 60onbLuor emkocty Ha 1100 nuctos

e JloTkn 1 1 2, 0AHO YCTPOWCTBO Noaauu Ha 550 NMCTOB M 0AMH NOAATYMK bosbLioK emKocTH Ha 1100
JIUCTOB

e Jlotkn 1 1 2, oBa ycTpOMCTBA Noaauu Ha 550 NMCTOB M 0AMH NOAATUMK bonbLiok emKkocTH Ha 1100
JINCTOB

I'Ipwvleanme. npep.yCMOTpeHbl TOJIbKO YKA3AdHHbI€ BAPHUAHTbI KOMIJIEKTALUHA.

Bua cnpasa
1. TpaBas gBepua 3. Jlotok 1
2. 3awenka Nnpason AeepLbl 4. Tpasble ABepubl 10TKOB 3—6

Phaser 6700 Color Printer 17
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Pexxumbl

Bupa czagm

s wnN -

any

9
Y,
MNpubopHas naHenb 6. KHonka npobHoi neuaTu
He3p0 NUTaHKUA dUHULWEpa 7. Pa3svem USB
He3p0 NUTAHWA NpUHTEpPA 8. Mopt USB-HakonuTenew (Tonbko ans
KHonka cbpoca ycTporcTBa 3aLmTbl OT YTEUKHM 06CyKMBAHMSA)
TOKA HA 3eMJT0 9. Pa3vem Ethernet

Kpbliwka nprbopHoOM naHenu

MNaHenb ynpasneHus

Ha naHenu ynpaBneHus HaX0AWUTCA CEHCOPHBIM SKPAH U KHOMKK AN ynpasfieHns GYHKUUAMU NPUHTepA.
®yHKUMM NaHeNM yNpaBieHus:

18

OTobparkeHue TeKylero paboyero CoCToAHUA NPUHTEPA.

ObecneueHue pocTyna K GyHKLMAM NPUHTEPA.

ObecneyeHre fOCTYNA K CNPABOYHbLIM MATEPHUAIAM.

ObecneyeHure goctyna meHto «CUcT. cpeacTBar» U «HacTporkay.
O6ecneueHure goctyna meHio «loUCK K ycTp. Hencnp.» U BULEOPOSIUKAM.

BbiBOZ NpeaynpexaeHuit o Heob6xoAMMOCTH 3arpy3uTb Bymary, 3aMeHUTb PACXOAHbIE MATEPUAIIbI
WK YCTPAHUTb 30CTPEeBAHME.

OTobpaxeHuWe OWMOOK 1 NpeaynpexaeHUi.
Bocnpow3sepeHne BUAEOPOSIMKOB B 3BUCUMOCTH OT COOLITHH.

1 Ready

Phaser 6700DN

CeHCopHbIW 3KPAH — 0TObpaXeHue HHPopMaL MK U AOCTYN K GYHKUMAM NPUHTEPA.

JHeprocbeperkeHHe — BXOJ, B PEXUM CHA U BbIXOZ, U3 PEXUMA HU3KOIO SHepronoTpebneHns nnm
peXuMma CHa.

I'Iaysa — BpeMeHHOe npepbiBaAHKUE TEKyLLI,eI;I pCl60TbI ONs €€ OTMEHbI MK NPHUOCTAHOBKMW.
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Pexxumbi

BHyTpEHHI/Ie KOMIMOHEHTDbI

1. YucTAawmm ctepeHb 5. PemeHb nepeHoca
2. [lBepua oTceka 610K0B GOPMHUPOBAHMSA 6. Ponuk nepeHoca
M306paKeHNs 7. JynnekcHbit 610K

3. Bnoku popMHpoBaHUSA U30OpaAKEHUS
4.  Oblozep

[MprumeuaHve. PeMeHb nepeHoCca M posivK NnepeHoca BXoAsT B HAOOP AN 06C/yKUBAHMS.

Habop ana obcnyxmBaHuma

1. PemeHb nepeHoca 3. Ponuku nopaum

2. Ponuk nepeHoca 4.  KapTpuax ponnKOB MOAAYH

Phaser 6700 Color Printer 19
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Pexxumbl

OuHuwep

1. TepepHss asepua duHULWEPA 4.  BnoK ropM3oHTA/IbHOroO TPAHcnopTepa
2. BbIxogHOM NOTOK PpUHMLLEPA 5. Pyuka npopgguxeHus bymaru

3. Pbuvar pns koHeepTtoB 6. KapTtpuax cumsatens

[Mpumeuarve. ns ocBobOXKAEHUA TPAKTA NoAaYM GUHULLEPA OT 3aCTpsiBLIer ByMarv noBepHUTe
PYYKy NPoABHKeHUA bymaru.

20 Phaser 6700 Color Printer
PykoBoacTBo nonb3osarens



Pexxumbi

NHopMaLMOHHbIE CTPAHMLbI

B npuHTEpe npeaycMoTpeHbl MHPOPMALMOHHbIE CTPAHMLbI AN1A NedYaTH. B HUx copeputcs nHdopmaums
0 KOHdUrypauum v WpUdTax, AEMOHCTPALMOHHbIE CTPAHWLbI U T.A.

MeuaTb MHPOPMALIMOHHBIX CTPAHWL, C MAHENW YNPAB/IEHUA:

Ha naHenu ynpasneHua Haxkmute KHonky MpuHTep.

Ha sknaake «MHdopmauus» HaxkMUTe KHOMNKY MevaTb CNpAaBOYHbIX MATEPUANIOB.

[ns yKa3aHWA KOJIMYeCTBA KOMUM HABKMUTE KHOMKY #.

YKaXKnTe KONMUYeCcTBO NevyaTaemMbliX KOMui ¢ Knasnuatypbl UK C NOMOLLbIO KHOMKK + UJTN -,
Haxkmute kHonky OK.

C nomMoLLblo CTPENKU BBEPX MY BHU3 BbiGEpPUTE B CMIMCKE CTPAHULY ANS NeUdTy.

NouLbswnN-=

HaxxmuTe kHonKy Meuats.

MpumeyaHme. MHGOPMALMOHHbIE CTPAHMLBI TAKKE MOXHO pacnedatatb u3 CentreWare Internet
Services.

YKa3aHWe N0TKA UCTOYHUKA A5 NeYaTH MHPOPMALMOHHBIX CTPAHWLL:

Ha naHenu ynpaBneHus Haxxmute KHONKy MpuHTep.

MNepenanTe Ha BKNaaky CUCT. cpeacTBA M HAXKMUTE KHOMKY YNpaB/eHUe IOTKAMM.
HaxxmuTe UcTOUHNK MHOpPM. CTpaHuL,

BbibepuTe NOTOK MK HAXKMUTE ABTOMATUYECKMU.

Ana noaTeepxaeHUA HACTPOMKU HaXMUTe KHomnKy OK.

ok wN-=

[nsa Bo3sparta Ha BKNAAKy «CUCT. cpeacTBa» HAXKMUTe KHonKy Hasag,. 1na Bo3BpaTa K OCHOBHOMY
3KPAHY HAXMUTE KHOMKY OCHOBHbIE peXHUMBI.

MNpumeyanus.
e [lopafoK neyaTu CTPAHML, C MHPOPMALMEH No YCTPAHeHWI0 Npobaem C KaYeCcTBOM NeydaTH CMm.
pasgen Mcnonb3oBaHMe BCTPOEHHbIX CPeACTB YCTPAHEHWA HEeMCNPABHOCTEN Ha cTp. 141.

e Ha HeKoTOopbIX 3KPAHAX, OTOBPAXAEMbIX HA NAHENW YNPABIEHUS, COAEPKATCA CCbISIKK HA
YacTo Ucnosnb3yemble MHGOPMALUOHHbIE CTPAHULbI.

[MeuaTb oTyeTa O KOHPUrypaumu

1. Ha nanenu ynpasneHua HaxxmuTe KHOMNKy MpuHTtep.
Ha Brknagke «MHbopmaumsa» HaxxmuTe KHOMNKY MeyaTtb CNPABOYHbIX MATEPUAIIOB.
HaxxmnTe OTUET 0 KOHOUTYpaLUH.

5w N

HaxkmuTe kHoMKy Meuarsb.

MNpumeyaHue. Mo yMONYAHMIO OTYET O KOHOUTYPALMM NeYaTaeTcs NpuU BKAKYEHMU NpUHTepa. [na
OTKJIIOYEHMWS JAHHOM HACTPOWKH BblbepuTe MpuHTep > CucT. cpepcTBa > Hactpoiika > O6wume
HACTpPoiKKn > HauanbHaA cTpaHvua > BeikniounTo.
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Pexxumbl

Pexxnm sHeprocbeperxkeHus

MoxHo 3aaaTb BpemMA NpoCToA NpUHTEPA B peXXHUMe roOTOBHOCTHU A0 ABTOMATHUYECKOIO nepexoaa B
PEXUM NMOHUXKEHHOTO BHEPFOI'IOTp66)'IEHMF|. Kpome TOro, d)yHKLI,M}O ABTOMATHYECKOro nepexoaa MOXHo
OTKNHOYUTDb.

1. Ha nanenu ynpasneHua Haxxmute KHoMky MpuHTtep.
2. lNepenpnte Ha BkNaaKy CucT. cpeacTBa n HaxkmuTe KHoNKy Hactpoiika.
3. HaxmuTe KHONKY DHeprocbepexeHue.
4. BKknoyeHWe aBTOMATHUYECKOro NepexoAd B PeXMUM SKOHOMWKU SHEPruu:
a. YcraHoBuTe GNAXKOK BKAOUMTL SKOHOMMUIO SHEPTHUH.
b. Hakmute MpaBka ans UaMeHeHUA ONUUK:
e /3 pexxnMma roToBHOCTHU B PEXMM SKOHOMUU SHEPrUK
e V3 pexxnMma 3KOHOMWK SHEPTMU B PEXMM CHA

c. Bsepute c knaBuatypbl MUHYTbI (1-120). 3HaYEHWE NO YMONUYAHUIO A1 NEPEXOAA B PEXUM
SKOHOMMM 3Hepruu: 15. 3HaueHre No yMoNUaHUIO ANA Nepexoaa B PeXUM CHa: 45.

d. [ns noarBeprkaeHUa U3MeHeHUa HaXMUTe KHomnKy OK, ans oTmeHbl Haxmute X.
5. [nsa Bo3Bpara K 3KpaHy «HacTpoika» Haxkmute KHomky OK.

lNpumeyanus.
e Y106bl OTKNOUMTL PYHKLMIO ABTOMATUYECKOrO MEPEXOAd, CHUMUTE BNIAXKOK «BKounThb
SKOHOMMIO SHEPrum».

e [IpyHTEp BbIXOAWT U3 PEXUMA SHEProcbepeeHus, Koraa nosydaeTt paboTy neyartu, d TaKKe
MPU HAKATUM KHOMKK «DHEprocbepeeHmer.
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Pexxumbi

POyHKUMM AGMUHUCTPUPOBAHMUSA

B 3TOM pasgene paccMaTpuBatoTCA CeaytoLme BOnpochl.

O CONIIEWAIE INTOIMEE SOIVICES ..ot eeeseeesseeessesesesesessesesnsessesesenseenseesaseesnsesasesasessasessassesasessnees 23
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Bonee noapobHyio MHpopmaumio cMm. B System Administrator Guide (PykoBodcmse cucmemHo20
admuHucmpamopa) no agpecy www.xerox.com/office/6700docs .

CentreWare Internet Services

CentreWare Internet Services — 3To nporpammHoe obecneyeHve A AAMUHUCTPUPOBAHMS U HOCTPOMKM,
YCTQHAB/IMBAEMOE HA BCTPOEHHbIV Beb-cepBep npuHTepd. OHO NO3BOJNISET OCYLLECTBAATL HACTPOMKY M
ynpasneHne NPUHTEPOM C MOMOLLbIO Beb-6pay3epa.

Ana CentreWare Internet Services Tpebyetcs:

e  TCP/IP-noakntoueHune npuHTepa K cetn B cpeae Windows, Macintosh nan UNIX.

e  Ha npuHTepe pomkHbl 6bITb BKAOYeHbI NpoTokonbl TCP/IP v HTTP.

e [logkntoueHHbIM K ceTh KomnbloTep ¢ Beb-6pay3sepom, noaaepxusatowmm JavaScript.

Bonee noapobHyio nHpopmaumio cm. B pasgene “Cnpaska” B CentreWare Internet Services nnu B System
Administrator Guide (PykoBodcmBse cucmemHo20 adMUHUCMPamopa,.

MNonyuenune poctyna k CentreWare Internet Services

Ha komnbtoTepe oTKpoiTe Beb-6pay3ep, BBeauTe B aapecHow ctpoke IP-aapec npuHTepa, 3atem
HaXmuTe Knasuwy Beog nnn Return.

Onpepenenune IP-agpeca npuHTepa

IP-appec npyHTEPA MOXKHO Y3HATH HA MAHENW YNPABEHUSA UM B OTUYETE O KOHOUIypaL K.
JononHutenbHble cBeileHUs cM. [leyaTb oTyeTa o KoHbUrypaummn Ha cTp. 21.

Onpegenenue IP-aapec c naHenu ynpaeneHms:
1. Ha naHenu ynpaBneHuA HaxMUTe KHOMNKY MpuHTep.
2.  Ha Bknagke «MHpopmauma» Haxkmute KHonky CBeeHUA o NpUHTepe.
3. epengute Ha BKkNaaKy CeteBas.
IP ykasbiBaeTcs B pasgene TCP/IP (v4).
Ecnun 3apaH agpec IPv6, ans npocmoTpa Haxkmute TCP/IP (v6).
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Pexxumbl

4.  Touch Home to return to the main screen.

[Mpumeuarve. IP-afpec TakkKe MOXeT 0TOOPAKATLCSA B BEPXHEM NPABOM WJIW JIEBOM YTy OCHOBHOIO
3KpaHa. [insa HacTporkK aaHHon ¢yHKuuK B CentreWare Internet Services BbibepuTe CBoWcTBO >
06wme HaCTPOIKHU > DKpaH "OCHOBHbIe peXHUMbl”. loNONHUTENbHbIE CBELEHUS CM. pa3aen
«Cnpaeka» B CentreWare Internet Services.

CueTumkm ydeTa 1 NCnoJib30BAHUA

CyeTumKM yyeTad M MCNoJIb30BAHWA OTOBpaXKaTCs HA IKpaHe «CueTunku yueTta» Mcxoas ms
0TObpaXKAEMOro KOIMYeCTBa OTMEUYATKOB NMPOM3BOAMTCA onnaTtd. JlononHUTebHble CBeleHHUA O
NPoBepKe CYHETUMKOB CM. pasgen CYeTumKK yueTa U Mcnosib3oBanusa Ha cTp. 107.
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|[I,OI'IO)'IHMTG)'I bHbl€ CBeJeHUA

ﬂ'OI'IOJ'IHI/ITe}'IbeIe CBelEHUA O NPUHTEPE MOXHO NOJNTYYUTb U3 CiefyrounX NCTOYHHNKOB!

Pecypc MecTononoxeHue

PykoBodcmso no ycmaHoBKe

BxoauT B KOMMNNEKT NpUHTEpa

Pexxumbi

Kpamkoe pykosodcmBo nosib3oBamens

BxoauT B KOMMNNEKT NpuHTEpa

System Administrator Guide (PykoBodcmBo cucmemHo20
aomuHucmpamopa,)

www.xerox.com/office/6700docs

YyebHble BUAEOKYpChI

Ha naHenu ynpasneHus npuHTepa 1 Ha Beb-caiTe

www.xerox.com/office/6700docs

Recommended Media List (Cnucok pekomeHayemblix
MaTepuanos)

CLUA: www.xerox.com/paper
EBpona: www.xerox.com/europaper

TexHuueckas noanepxka PhaserSMART nossonset
OBTOMATHYECKH BbIABASATL HEUMCNPABHOCTHU NPUHTEPA B
CeTW M NpeanaraeT peLleHUa Mo UX YCTPAHEHHIO.

www.phasersmart.com

ConpoBoauTeNibHble CBEAEHUS TEXHUUECKOTO XapaKTepa:
MHTEpHEeT-CNYX6a noaaepxku, cuctema Online Support
Assistant (OHNAMHOBBIM ACCUCTEHT NOALEPKKM) U
3arpysKad 4panBepos.

www.xerox.com/office/6700support

CBefeHWsA 0 MeHo 1 coobuyeHunsax o6 owmnbke

KHonka «Cnpaekax (?) Ha NaHeny ynpasnieHus

MHpOpMaLMOHHbIE CTPAHULbI

MeyaTb M3 MEHI0 NAHENW yrnpaBaeHus

3aKa3 pacxofHbIX MATEPUAIOB AJ1F NPUHTepa

www.xerox.com/office/6700supplies

Pecypc, BKIIOUAOLLMM MHCTPYMEHTASbHbIE CPEACTBA U
MHGOPMALMIO, HANPUMEP MHTEPAKTHUBHbIE YYebHble
KypCbl, LLABNOHbI AN NeYATH, Nosie3Hble COBETbI U
HOCTPAMBAEMbIE PEXMUMbI, OTBEUAIOLLUE
MHAMBHUAYIbHBIM NOTPEBHOCTAM.

www.xerox.com/office/businessresourcecenter

MecTHble LeHTpbl MTPOAMK U NMOALAEPIKKH

www.xerox.com/office/worldcontacts

Perucrpauwmsa npuHtepa

www.xerox.com/office/register

MHTepHeT-marasuH Xerox® Direct

www.direct.xerox.com/

Phaser 6700 Color Printer
PykoBoacTBO nonb3osarens

25







YCTAHOBKA M HACTPOWKA

B aTom paspene paccmMaTpuUBarTCA cneayrouime Bonpocobl.

e  KpaTkue cBeleHHUs MO YCTAHOBKE N HACTPOMKE ....cunvernrrernreennees 28
¢ UN3meHeHWe 06LMX HACTPOEK 29
e  YCTQHOBKA NPOrpaMMHOro obecneyeHus 30
Cm. makke:

PyKOBoacmBO no ycmaHoBKe, BXOAUT B KOMIJIEKT NpUHTEPA.

System Administrator Guide (PykoBodcmBo cucmemHo20 adMuHUcmpamopa) no aapecy
www.xerox.com/office/6700docs .
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YCTaHOBKA M HACTPOWKA

KpaTtkune cBegeHMA no yCTAHOBKE U HAOCTPOMKE

Mpexae YeM NeyaTaTb, KOMNbIOTEP U NPUHTEP CNeAyeT NOAKOUUTL K CETU NEKTPONMUTAHKA, BKIIOUUTD
W NOAKNIOUMTL B ceTH. BbibepuTe nepBoHaYaNbHble HACTPOMKK NPUHTEPA, 30TEM YCTAHOBUTE HA
KOMMblOTEP APAMBEP U YTUNUTBI.

MpuHTEP MOXHO MNOAKJIIOUMTB MO CEeTH C NomoLLbio Kabens Ethernet nnu HanpsmMyto K KomnbloTEpY
kabenem USB. TpeboBaHus Kk annapatype v Kabensim 3aBUCAT OT TUMA NMOAK/TIOUEHUS.
MapLupyTH3aTopbl, CETEBbIE KOHLLEEHTPATOPbI, CETEBbIE KOMMYTATOPbI, MOZeMbl U kabenu Ethernet u USB
He BXOAAT B KOMIMJIEKT NOCTABKW NPUHTEPA U NpUobpeTatoTcs oTaenbHo. PekomeHayeTca noaktoueHue
uepes Ethernet, nockonbKy oHO, KaK Npasuo, obecneumBaeT bosiee BbICOKYH CKOPOCTb Nepeaauu, Yem
yepe3 USB, a Takxe pgoctyn k CentreWare Internet Services.

[na nonyyeHusa ceefeHUM 0 NOAKIIIOYEHWUM M HOCTPOWKE CeTU pacneyaTanTe ctpaHuuy "Hactporika
noAaxknoveHmna":

1. Ha nanenu ynpasneHua Haxkmute KHOMKy MpuHTtep.

2. Ha Bknagke «MHpopmMauma» HaxkmuTe KHOMNKy MeuaTtb cNpaBoYHbIX MATEPUAIOB.
3.  Haxmute Hactpoika nogKoueHuUs.

4. Haxmute KHoOMKy Meuarb.

MoapobHOCTH NO YCTAHOBKE HACTPOEK NpUHTepa cM. System Administrator Guide (PykoBoacTso
CUCTEMHOr0 aAMUHUCTPATopa) no agpecy www.xerox.com/office/6700docs .

Dusnuyeckoe NOAKIOYEHME MPUHTEPA K CETH

Use a Category 5 or better Ethernet cable to connect the printer to the network. An Ethernet network is
used for one or more computers and supports many printers and systems simultaneously. An Ethernet
connection provides direct access to printer settings using CentreWare Internet Services.

MopsfoK NOAKNIOUYEHHUA NPUHTEPA:
1. MNopKnounTe WHYP NUTAHWUA K NPUHTEPY U K SNIEKTPUYECKOM pO3eTKe.

2. TopkniounTe oanH KoHel Kabens Ethernet He HWe 5-11 kaTeropuu k nopty Ethernet Ha npuHTepe.
Mopkntounte apyrok KoHel, kabens Ethernet kK HacTpoeHHOMY ceTeBOMY NMOPTY KOHLEHTPATOPA UK
mMapLipyTusaTopa.

3. BkntouuTe npuHTEp.

[MepBOHAYANIbHASA YCTAHOBKA NPUHTEPA

Mepep yCcTAHOBKOM NpOrpaMMHOro obecneyeHusi NpUHTepa ybeanTech, UTo OH HACTPOeH. B HacTporiky
BXOZMT BKJ/IOUEHHWE JOMOSIHUTENBHBIX PYHKLMIM U HasHaveHHWe IP-aapeca ana noaKnioueHus K ceTu
Ethernet. Eciv npuHTEp He Bbln NOAKIOUEH M HACTPOEH, cM. System Administrator Guide (PykoBodcmso
cucmemHo20 admuHucmpamopa) no agpecy www.xerox.com/office/6700docs .
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YcTaHOBKA U HACTPOMKa

N3meHeHne obLmnx HacTpoeK

HGCTpOﬁKM NPUHTEPA, TaAKME KAK A3bIK, 4ATA U BpeMA, e JUHULbI U3MePEHUA, APKOCTb AUCTJIEA U
Ha4yasibHAA CTPAHULA, MOXXHO M3MEHATb C NaHEeNN ynpaBieHHUA.

1.
2.
3.

Ha naHenu ynpaeneHuna HaxmuTe KHonKy MpuHTep.

MepenanTte Ha BKkNaaKy CHCT. cpeAcTBa U HAXMUTE KHOMKY HacTpoika.

HaxxmmTe ObLimne HaCTPOWKH 1 BbibepuTe HOCTPOMKY AN U3MEHEHUS:

e  f3bIK/KnasuaTypa - yCTAHOBKA A3bIKA MHTepdenca 1 packnagKu KIaB1aTypbl.

e Jlata/Bpems - yCTAHOBKA YACOBOMO NOSCA, AATbl, BpeMeHU U GOpMaTA OTOOPAXKEHHUS.

lNprmeyaHve. lata v BpeMs YCTAHABIMBAKOTCA aBTomaTuuecky yepes npotokon NTP (Network Time
Protocol). ins nsmeHeHus aanHbix HacTpoek B CentreWare Internet Services Ha Bknagke
«CBOMCTBA» YCTAHOBUTE ANs napameTpa «HacTporka AaTbl U BpemeHW» 3HavyeHre BpyuHyto (NTP -
BbIKJ/IIOUEHO).

L Cucrtema M3mepe|-|m7| - YCTaAHOBKA €ANHUL U3MEPEHUA U pa3aennTena paspAanos.

e  TaWm-ayT cMcTeMbl - YCTOHOBKA BpeMeHU oxuaaHua Beoga (15-600 cek.), No nucredeHmu
KOTOPOro NPOUCXOAMUT BO3BPAT HO OCHOBHOM 3KpaH. HacTporka no ymonyanwuio: 60.

e  fpKOCTb Aucnes - yCTAHOBKA APKOCTHU ceHcopHoro 3kpaHa (1-10). Hactporika no
ymonuauto: 8.

e  3BYK - yCTOHOBKA FPOMKOCTH AJ11 TOHOB BbI60pad, KOHPAMKTA U HEUCMPABHOCTH.

e HauanbHasa cTpaHUUA - YCTAHOBKA MEYATH HAYQIbHOM CTPAHMLLbI NPU BKIKOYEHWH NPUHTEPA.
YCcTaHOBHWTE HYKHble HACTPOMKMU.

[na noaTBepXaeHUA n3meHeHUsa HaxXmuTe KHonKy OK, ans oTMmeHbl HaxmuTe X.

MNpn HeObX0AMMOCTH M3MEHWTE ApYrMe HOCTPOMKK. [inA BO3BpATA K OCHOBHOMY SKPAHY HAXMUTE
KHONKY OCHOBHbIE PeXHUMbI.
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YCTaHOBKA M HOCTPOMKA

YcTaHOBKA NporpaMmHoro obecrneyeHums

B 3TOM pasgene paccMaTpuBatoTCA CieaytoLue Bonpochl.

e  TpeboBAHMA K OMEPALNOHHBIM CUCTEMOM .ouuucevmrerrmsieresssecessscssssesssssesesssesesssesssaseessssesssnncs 30
o Installing Drivers and ULilitieS fOr WINAOWS............ovverrrennreesnreeesnrseessssesssssssssssssssssssssssssssssssssssssssssssssssssssssssens 30
e  YcTaHoOBKaA ApariBepoB u yTUAWT ana Macintosh OS X Bepcuun 10.5 unu 6onee nosgHem................. 31
e YcraHoBKka gpareepoB U yTUAUT ana UNIX v LinuX ...ceeeneeneeee. 32
®  JIDYTUE [PAMBEPDI ...ccoureuumrcemmeeesmseeessseessssesssssesssssesssssesssssssssasesssssesssssesssssesssssessssseessssessssse s ssseesesaesesasesssassssaseessssseseses 33

lMpexnae ueM yCTAHABMBATL AparBepbl, ybeanTech, YTO MPUHTEP NOAKIIOYEH K CETH SNIEKTPONUTAHMA,
BKJItOYEH, MPABWBbHO NOAKIIIOUEH K ceTh 1 obnagaet gonyctumbiM IP-agpecom. Kak npasuio, IP-agpec
OTObpAXKAETCA B BEPXHEM NPABOM Yry NaHenu ynpasnenus. Ytobwl y3Hate IP-agpec, cm. Onpeaeneque
[P-appeca npuHTepa Ha cTp. 23.

Ecnu Software and Documentation disc oTCyTCTBYET, MOXHO 3Arpy3uTb Noc/ieiHUE APANBEpPbI C
Beb-cTpaHuubl www.xerox.com/office/6700drivers .

Tpe6OBOHMFI K ornepaymoHHbIM CMCTeMam

e Windows XP SP1 u 6onee nosgHue Bepcun, Windows Vista, Windows 7, Windows Server 2003,
Windows Server 2008, Windows Server 2008 R2
e Macintosh OS X Bepcuu 10.5 nnu bonee nosgHen

e UNIXu Linux: LOHHBIM NPUHTEP NOAAEPKMUBAET NOAKIOUEHHWE K pasinyHbimM naatdopmam UNIX
yepes ceTeBor MHTepderic. bonee noapobHyto MHbopmMaUMIO CM. B pasaese
www.xerox.com/office/6700drivers .

Installing Drivers and Utilities for Windows

Install the Xerox® print driver to access all the features of your printer.

To install the print driver software:
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9.

YcTaHOBKA U HACTPOMKa

BcrasbTe Software and Documentation disc B nprBoj, KOMNAKT-AUCKOB. [IporpamMma yCTaHOBKM
3anycTUTCA aBToMATHYecku. Ecnv nporpamma He 3anycTuiach, OTKPOWTe HA KOMMbloTepe
KOMMOKT-AUCK M ABAXKAbI LWENIKHUTE $pain yCTaHOBKK Setup.exe.

Ecnu HY)XXHO M3MEHWTB A3bIK, HAXKMUTE KHOMKY A3bIK, BbibepuTe A3bIK M HAXKMUTE KHOMKY OK.
HaxmuTe kHonky MpuHUMato, YTobbl NPUHATL YCI0BUS JIMLEH3UOHHOTO COALLEHHS.
BbibepuTe NnpuHTEp B CNHCKE HAOMAEHHBIX MPUHTEPOB U HAXKMUTE KHOMKY YCTAHOBUTD.

Ecnu npuHTEp B CNMCKe HAMAEHHbIX MPUHTEPOB OTCYTCTBYET, HAXKMUTE KHOMKY PaclumpeHHbIv
MOMCK.

Ecnun no-npexxHemy NpuHTEpA HET B CNUCKe HAOMEHHbIX NPUHTEPOB, HO Bbl 3HaeTe IP-agpec:
a. HaxkmuTe 3HAUOK ceTeBOro NpuHTepa (CNpasa) BBEPXY CEPOro OKHA.

b. Beegute pna npunHtepa IP-aapec nnu nma DNS.

¢.  Haxkmute KHOMKY MOMCK 1 BbibeprTe NpUHTEpP B CMMCKE HAWAEHHbIX MPUHTEPOB.

d. Koraa B okHe NOABUTCA MMA NPUHTEPA, HAXKMUTE KHOMKY Janee.

Ecnn no-npexkHemy NpuHTEpa HET B CMMCKe HAMAEHHbIX NPUHTEPOB 1 Bbl 3HaeTe IP-aapec:
a. HaxmuTe KHONKY JlONOAHUTENbHBIA NOUCK.

b. Ecnv u3BecTeH aapec Wio3a U MACKA NOACETH, HAXMUTE BEPXHIO KHOMKY W 3aMN0JIHMTE Nons
«LWnto3» n «Macka noacetu».

c. Ecnnmseecren IP-agpec agpyroro npuHTepa B 3TOM NnoaceTH, BBeauTe ero B none IP-agpeca.
d. Haxmute kHoNKy MoUCK 1 BbibepUTe NPUHTEP B CMUCKE HOMAEHHbIX NPUHTEPOB.

e. Korpa B okHe NoABUTCA MMA NPUHTEPA, HABKMWUTE KHOMKY Jlanee.

BbibepuTe gparisep npuHTEpA:

e  PostScript (pekomeHayetcs)

e PCL5

e PCL6

HaKkmuTe YCTAHOBUTD.

10. TMocne 3aBepLUEHUA YCTAHOBKM HAXMUTE KHOMKY FoToBO.

YcraHoska gpansepos n ytuaunT ansa Macintosh OS X sepcun 10.5 nnum 6onee
no3aHen

Install the Xerox® print driver to access all the features of your printer.

YcTaHoBKa ApanBepa npuHTepa:
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YCTaHOBKA M HACTPOWKA

BcrasbTe Software and Documentation disc B npuBoA KOMNAKT-UCKOB.

JBaKAbl WEeNKHUTE 3HAYOK AUCKA Ha paboyeM cTosie, UTobbl BbIOpaTh A NpuHTepa damn .dmg.
OTkpovite parn .dmg v neperigute K yCTaHOBOYHOMY Ganny ans LAHHOW onepaunoHHON CUCTEMDI.
OTKpbITb YCTAHOBOYHbIN dak.

Haxkmute MpogonkuTb, uToObl NOATBEPAMTE NPeAyNpPeXaeHHe U BCTYNUTeIbHOe coobLyeHue.
Haxkmute kHONKy MpoaomxkuTb, UTo6bI MPUHATL YCII0BUA JIMLIEH3UMOHHOMO COIALLEHUS.

No s wN=

Ytobbl noATBEPANTH YKA3AHHOE MECTO YCTAHOBKH, HABKMUTE KHOMKY YCTaHOBUTb. nu BbibepuTe
Zlpyroe Mecto YCTAHOBKKU MU HAPKMUTE KHOMKY YCTAHOBUTb.

BeesuTe naponb n HaxkmuTe KHonKy OK.
9. BblbepuTe NpUHTEpP B CNUCKE HOMAEHHbIX MPUHTEPOB M HAXKMUTE KHOMKY MpoaomKuTb.
10. Ecnv npuHTEp B CNUCKe HOMAEHHbIX MPUHTEPOB OTCYTCTBYET, BbINONHUTE CleaytoLLee.

a. LUlenkHuTe 3HaUYOK ceTeBOro NpuUHTEpPA.

b. BseauTe IP-agpec npuHTEpa U HAXMUTE KHOMNKY MpoaocmKUTb.

c. BbibepuTe NpuHTEp B CNCKe HOMAEHHbIX MPUHTEPOB U HAXKMUTE KHOMKY MpoaomxuTb.
11. Haxkmute kHonky OK ana noatsepxaeHWs cooblueHrsa ouepeam neyarw.

12. BbibepuTe nnu cHUMUTE Gk HacTpouTb KAk NpuUHTEp No ymondavuio v NMevaTtb npobHo#M
CTPAHULbI.

13. Hakmute kHonKy MpopomKuTb, 3aTeM HAXKMUTE 3AKPbITb.

MpumeyaHue. NMpuHTep aBTomaTUuecKK f06aBMTCA B odepeab nevatn B Macintosh OS X sepcun 10.4
u bonee no3gHew.

Y6eauTtech, uto ApariBep NpUHTEP Onpeaesia YCTAHOB/IEHHbIE OMNUWK:

1. From the Apple menu, open System Preferences > Print.

Select the printer in the list, then click Options and Supplies.

Click Driver, then confirm that your printer is selected.

Confirm that all of the options installed on the printer appear correct.

If you change settings, click Apply Changes, close the window, and quit System Preferences.

s wnN

Ycranoska gpaneepos u ytuant ana UNIX v Linux

MakeT nporpamm Xerox® Services ans cuctem UNIX ycTaHaBAMBAeTCA B ABA 3TANA. YCTAHOBKA NAKETA
Xerox® Services Tpebyetca ana nporpammHoro naketa cuctem UNIX 1 nakeTa noaaepyku NpuHTepa.
Naket Xerox® Services ans nporpammHoro naketa cuctem UNIX ycTQHABAMBAETCA 10 YCTAHOBKM NAKETA
NoAZEepPKKKU NPUHTEpPA.

MprvmeyaHue. Ansa yCTAHOBKKM HA KomnbioTep apareepa npuHTepa UNIX TpebytoTcs npasa ROOT
WK CynepnoJsib3oBaTens.

1. Ha npuHTepe BbINONHUTE CrieaytoLlee:
a. Ybeputech, uto BKAOYeH NpoTokon TCP/IP 1 BbIGpAH HYXHbIM pasbem.
b. Ha naHenu ynpasneHus NpUHTEPA BbINOSHUTE OMH WX CleyiolmMx BapuaHTos ansa IP-aapeca:
e Bknounte aBTOMATUYECKYIO HaCcTporKy aapeca DHCP.
e  Beeaute IP-agpec Bpyunyto.
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C.

YcTaHOBKA U HACTPOMKa

Pacneyaraite otyeT 0 KOHOUIypaLmMn 1 UCNONb3yMTe ero aAnsa cnpasky. bonee noapobHyto
nHdopmavmio cm. B pasgene OTyeT 0 KOHPUrypaLuu.

Ha KOMMbOTEPE BbIMOJHUTE Chejyloulee:

a.
b.
C.

OTkpowiTe cTpaHuuy www.xerox.com/office/6700drivers v BbibepuTe Mozenb NpUHTEpA.
B cnucke onepauuoHHbIx cuctem BolbeprTe UNIX M HaxkmuTe KHOMKY Go.

Buibepute naxkeT Xerox® Services for UNIX Systems, cooTBeTCTBYHOL{MI OMNEPALIMOHHOV
cucTeme. 3To 6a30BbIV NAKET, KOTOPbLIM CneayeT YCTAHOBUTL Nepes, yCTAHOBKOW NakeTa
NoAAEPKKKU NPUHTEpA.

Utobbl HaUaTb 3arpy3Ky, HaxkMuTe KHomMKy Start (CrapT).

MoBTOpHTE NYHKTbI A M b, 3aTeM 3anycTUTe NAKET NPUHTEPA A1 UCMONb30BAHUSA C paHee
BbI6GpaHHLIM naxeTom Xerox® Services ana cuctem UNIX. Tenepb BTopas 4acTb nakeTta
ZparBepa rotoBd K 3arpysKe.

UTobbl HauaTb 3arpy3Ky, HaxmuTe kKHonky Start (Ctapr).

B npumeuaHmsx nog BbI6paHHbIM NAKETOM JpariBepda LWeIKHUTe cCbIKy PykoBoAcTBO NO
YCTOHOBKE W ClielyWTe YKA3aHWAM MO YCTAHOBKE.

MNprmeyanus.

e [lpu 3arpy3ke gpariBepos nNpuHTepa ans Linux Heo6XxoAWMO BbINOAHWUTL NPUBEAEHHYIO
npoueaypy, TONIbKO B KOYeCTBe OMepaLMoHHON cucTembl BbibpaTsk Linux. Beibepute gparisep
Xerox® Services for Linux Systems 1 Linux CUPS Printing Package. Take MOXHO
ncnonb3osarb gparsep CUPS, BxoaAwni B naker Linux.

e JlpaiBepbl and Linux goctynHbl no agpecy www.xerox.com/office/6700drivers .

e (Ceegenus o gpameepax gnsa UNIX u Linux cm. B System Administrator Guide (Pykosodcmse
cucmemHo20 adMuHucmpamopa) no aapecy www.xerox.com/office/6700docs .

Apyrve gpansepsbl

JparBepbl ansa 3arpysKku, 4oCTynHble No agpecy www.xerox.com/office/6700drivers :

[ )

Xerox® Global Print Driver - g5 Bcex NPWHTEPOB, YCTAHOBJIEHHbIX B CETH, B TOM YMCIe ANA MoAaenewn
Apyrux npoussoauTtenei. MNpu ycTaHOBKe OH KOHOUIypUpYyeTCA aBTOMATUYECKH AJ151 KOHKPETHOrO
NpUHTEpA.

Xerox® Mobile Express Driver™ - 1 BCcex NPUHTEPOB, MOAKTIOYAEMbIX K KOMALIOTEPAM U
NoAAEPKMUBAIOLMX CTAHAAPTHBIM PostScript. Mpu Kaxaoh neyaty oH KoHPUrypupyeTcs
OBTOMOTHYECKM A5 BbIBPAHHOIrO NpuHTepd. Ecnv Bam yacto npuxoautcsa 6biBaTh B OAHMX U TEX Ke
MECTAX, MOXHO COXPAHWTb UCMO/b3yeMble TaM NPUHTEpPbI, YTOObI B ApariBepe COXPAHHUIIUCH
BbIOPAHHbIE HACTPOWKH.
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bymara n martepuaibl

B aTom pasgene pacCMaTpmBardTCA cneagyrouime sonpochol.

e [lopaepxuBaemMble TUMbl Bymaru

e 3arpyska bymaru

e [leyaTb Ha cneyunanbHon bymare
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bymara 1 matepuasnsl

[MoaaepxnBaemble TMMNbl bymaru

B 3TOM pasgene paccMaTpuBatoTCA CeaytoLme BOnpochl.

®  PEKOMEHAYEMBIE MOTEPHOIIB covurecevusecermsseeesssesessseeesssesssssessesssesssssesssssessssssessssesssssesssssesssssssesns .36
®  BUKOSB DYMUATH coerrreverrreensreessessssssssssssssssessssssssssssssssssesssssesssssessssssssssssessssssssssssssssssssssssssssessssssssssssssssssssssnessssssssssssssssssssssns 36
o O6LME YKASAHHUSA MO 3ATPY3KE BYMUTH oouverevereeereraeseesssssssssssesssssssssssssssssssssssssssssssssssssasssns 36
e bymara, KOTOPasa MOMXKET MOBPEANTD MPUHTEP ...cvcureureereereesseesssssssssssssssssssssssssssssssssssnns 37
®  YKO3AHMWA MO XPAHEHMIO BYMOTH ccounevmrnermncemmecesmecssssecesaseesssssesesssesesssesssassesenns 37
o [loaneprMBaemMble TUMbI U MIOTHOCTD OYMOMM .....urvereerreereessesesssessssssssssssesssssssssssssssssnns 38
o T[loaaeprk1Baemble CTAHAAPTHbIE GopmaTbl Bymard ....... . 38

e [loppepxuBaemble GopMaThbl M MIOTHOCTL Bymaru 4s ABTOMATUUYECKOMW [iBYCTOPOHHeW nedyatu. 39

e [oaaepXvBaeMble HECTAHAAPTHBIE PASMEPDI BYMATM.......currreeeesssnneeesssssssssssssssssssssssseees 39

anHTep nogaepXneaeT MCNOJIb3OBAHHUE PA3J/IMYHbIX TUMNOB 6yMClFM N Apyrux MmaTtepuanos. ﬂ,)’lﬂ
OOCTUXKEeHUA Hauny4dlero Kadecrea nevyaTtm 1 Bo n3bexaHue yacToro 3aCTpeBAHUA 6yMClFVI BbINONHANTE
YKa3aHuA, npuBeaeHHbIe B JAHHOM pasgene.

,D,J'IFI AOCTUXKEHUA HAaUNTyYLLUX pe3ynbTaToB MCﬂOﬂb3yﬁTe TOJIbKO 6yMC1Fy M MATEPUAIIbI Xerox®,
peKoMeHAOBAHHbIE ANA AAHHOIO NpUHTEPA.

PekomeHayemble maTepuaibl

Cnu1cok peKomeHAyeMbIX TUMOB BymMarn 1 MaTepUaoB AJs IPUHTEPA JOCTYMNEH Mo aapecy:
e www.xerox.com/paper Recommended Media List (Cnncok pekomeHayembix matepuanos) (CLUA)

e www.xerox.com/europaper Recommended Media List (Cn1cok pekomeHayembix MATepPUAOB)
(EBpona)

3akas bymaru

[na 3akasa 6ymaru, NaeHKU Unu apyrux MatepruanoB obpaTuTecb K MECTHOMY TOPrOBOMY
NpeacTaBUTENIO MK NoceTUTe Beb-canT www.xerox.com/office/6700supplies .

Obuwme ykazaHusa no 3arpyske bymaru

e Mcnonb3yiiTe ToNbKo pekoMmeHayemble Xerox® TUnbl nieHKU. KauecTBo neuaTu Ha Apyrux naeHKax
He rapaHTHpyeTcs.

e He meuyaramnTe HA NCTAX C yAANIEHHBIMW HAKNENKAMM.

e UNcnonb3yiTe TONbKO ByMaXkHble KOHBepTbI. [leyaTaiTe TONbKO HA OAHOM CTOPOHE KOHBEPTOB.
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bymara v matepuansi

e He neperpyxavite noTku ana bymarn. He 3arpyxaite 6ymary Bblille JUHWUA MAKCUMAJIbHOM
3arpysKu JIOTKA.

e  Hacrpoiite HanpaensitoLMe B COOTBETCTBUM C pa3mepoM bymaru.
e  Pacnyctute nuctol bymarv nepef, 3arpy3Koi B IOTOK.
o If excessive jams occur, use paper or other approved media from a new package.

Bymara, KoTopas MOXeT NoBpeAUTb NPUHTEP

Mcnonb3oBaHue HEKOTOPbIX TMNOB 6yMClI'VI N APYrux MatepmnasoB MOXKET Bbi3blIBATb CHUXEHKWE KayecTBa
neyartu, 4acTble 3acTpeBAHUA U AAXKE NOJIOMKHU NPUHTEPA. 3(JI'I|DELLI,C1€TCF| MCMNOJ1Ib30BATb:

e [pybas vnu nopuctas bymara

e bymara anfa cTpynHbIX NpUHTEPOB

e [nsaHueBas bymara unv bymara c NOKpbITUEM, He NPeAHA3HAYEHHAA AJ15 IA3€PHbIX NPUHTEPOB

e  bymara, ucnonb3oBasLLascsa AnA GOTOKONUPOBAHUS

e  (CmATas UK CNOXeHHaA bymara

e bywmara c Bblpe3amu v neppopauuen

e Cwwutas 6ymara

e  KoHBepTbl C OKHAMH, METAIIIMYECKUMU 3AKUMAMM, BOKOBBIMU CTBIKAMW U KIIENKUMU YYACTKAMM,
30KPbITbIMKY 3ALLMTHBIMK MONOCKAMM

e KoHBepTbl C MAFKOM NOAJ/I0KKOM

° MNnactrkosble marepuanbl

A\ BHUMAHME! FapaHTus Xerox®, cornawenus 06 o6cnyxusanmnu 1 Total Satisfaction Guarantee
(061was rapaHTHs kauectsa) Xerox® He pacnpOCTPAHSAIOTCA HA MOBPEXAEHHS, BbI3BAHHbIE
MCNob30BAHWEM HENOAAEPKUBAEMON Bymark nau cneumanbHbix Matepuanos. Total Satisfaction
Guarantee (06uias rapanTus kadectsa) Xerox® geiicteyet B CLUA 1 Kanaze. B apyrux pervoHax
MOryT AeMCTBOBATL APYrue rapaHTHiHble yCnoBUA. 1A nonyyeHna 4oNoNHUTENIbHbIX CBeAeHUH
CBSAXKMUTECH C MECTHBIM MPEeLCTABUTENBCTBOM.

YKasaHus no xpaHeHuto bymaru

AN oNTUMANbHOIO KAYeCTBA NeYaTH HeobXoAUMO obecneunTb Hagiexdallee XxpaHeHue bymaru u
MATEepHasoB.

e  XpaHuTe bymary B TEMHOM, MPOX/IAAHOM U JOCTATOYHO CyXOM MecTe. BosbluMHCTBO TUNOB Bymaru
UYBCTBUTEJIbHbI K BO3EMCTBUIO YIbTPAdUONETOBbBIX Jyuel U BUAMMOro cBeTd. YnbTpaduronetosoe
U3Nly4yeHne, UICTOYHMKOM KOTOPOTO ABMIAKOTCA COJTHLIE W IAMIMbl AHEBHOIO CBETA, 0COBEHHO
PO3pYLLUMTENIbHO AeNCTBYeT Ha bymary.

° He octaBnanTe 6yMClI'y noj, BO3AENCTBUEM CUJIbHOIO CBETA HA AJIUTENIbHOE BpemMs.

e [lpu xpaHeHun Bymaru He gonyckamTe KonebaHum TeMnepaTypbl U OTHOCUTENBHOW BAAXKHOCTH
OKpyXatLen cpeapl.

° He XpaHuTe 6yM0.Fy HQ YepAaKax, B KYXOHHbIX NOMeLleHUAX, rapaxax 1 nogsanax. B 3Tmx
nomMeuweHnAx 4acTto 6bIBAET NOBbILLIEHHAS BIAXHOCTb.

e  bymary cnepyet XxpaHWTb B NOAZLOHAX, KAPTOHHBIX KOPOOKAX, HA MOJIKAX UK B LLUKADY.
e  He xpaHuTte ey M HANUTKKU B MECTAX XPAHEHHS U UCMOJIb3OBAHKSA Bymaru.
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e  He oTKpbiBa¥iTe 3ane4YaTaHHble YNAKOBKH, eC/iv He cobupaeTech 3arpy)arb bymary B npuHTep.
XpaHWTe 6ymary B OPUrMHaNbHOM YNAKOBKe. YNAKOBKA 3aLLMLLAET 6ymMary OT BbICbIXAHWS U
MPOHUKHOBEHMA BNATH.

e HekoTopble cneumanbHble MATepUabl MOCTABAAIOTCA B FTePMETUYHO 3AKPbITbIX MIACTUKOBBIX
naxkeTax. Jlo MOMeHTA UCMOJIb30BAHUA XPAHWUTE MATepua B nakete. HeMCnonb30BaHHbIA MATEPHUA
CKNaAbIBAKMTE B NAKET U MOBTOPHO 3ANeYdATbIBAWTE €ro B LiefAX 3aWunTbl.

nO,D,,EI,ep)KMBCleMbIe TUIMbl N TVTIOTHOCTb 6yMClFI/I

JloTkun Tunbl U NNOTHOCTbL

NoTtkun 1-6 0O6blyHas, C nepdopavmert u nonb3osarensckas (60-90 I'/MZ)
PupMeHHble 6aarku, Mnotras (80-120 g/m?, 22-32 Ib. Bond)
Kaptoukw (105-163 g/m?, 40-60 Ib. Cover)

MnoTHble kapTouku (160-220 F/Mz)

Hakneiku (106-169 I'/MZ)

Cnanuesas kapTtoteuHas (105-163 g/m?, 40-60 Ib. Cover)
MnoTHble rnaHLEeBble KapTouku (160-220 F/Mz)

C neyvarbto, MNepepabotaHHasa (60-90 F/Mz)

Tonbko ana notkos 11 2 KoHBepTbl

Mpo3p. nneHka

MpumeuaHme. CNUCOK NOAAEPHKUBAEMbIX TUMOB BYMArv U APYrMX MATEPUAIOB MOXHO pacrneyaTaTb.
Ha nanenu ynpasnenus Boibepute MpuHTep > Meuarb cnpaBoyHbix MaTepuanos > CoBeTbl No
pa6ote c 6ymaroii > Meuarsb.

MNoppepurBaemble CTAHAAPTHbIE dopmMaTbl bymaru

Homep notka EBponeiickue ctaHaapTHble popmatbl  CeBepoaMepUKAHCKUE CTaHAAPTHbIE

dopmarbl
Bce notku A4 (210 x 297 mm, 8,3 x 11,7 aronma) Executive (184 x 267 mm, 7,25 x 10,5 grorima)
A5 (148 x 210 mm, 8,3 x 5,8 aronma) Letter (216 x 279 mm, 8,5 x 11 grorimoB)

JISB5 (182 x 257 mm, 7,2 x 10,1 grorima) Legal (216 x 356 mm, 8,5 x 14 froimos)
US Folio (216 x 330 mm, 8,5 x 13 atormoB)

Notkn 1mn 2 KonBepTbl C5 (162 x 229 Mm, KoneepTtbl Monarch (98 x 190 mm,
6,4 x 9 gloimoB) 3,875 x 7,5 prorima)
KoneepTbl DL (110 x 220 mm, KonBepTbl Ne 10 (241 x 105 mm,
4,33 x 8,66 grorima) 4,125 x 9,5 grorima)
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Tonbko notok 1 | A6 (105 x 148 mm, 4,1 x 5,8 grorima) Statement (140 x 216 mm, 5,5 x 8,5 atonma)
ISO B5 (176 x 250 mm, 6,9 x 9,8 atonma) KoneepTbl A7 (133 x 184 mm, 5,25 x 7,25 proiima)

K C6 (114 x162 mm,
A,OSHEZI,D;;IAIOH(MQ) X MM Mpumeuarre. Ha bymare dopmara Statement

MOHO MeyaTaTb U3 N0TKOB 2—6, Ucnonb3ys
Mpumeuarue. Ha 6ymare popmarta ISO BS | MONb30BATENLCKYIO HACTPOMKY.

MOXHO NeYyaTaTb M3 JIOTKOB 2-6,
MCMOob3ys NONb30BATENIbCKYHO
HACTPOWKY.

Moanepxuaemble GopMaTbl U MAOTHOCTb ByMarv aasi aBTOMATUYECKOM
LBYCTOPOHHEN NeyaTu

MuHKUMYM Makcumym

Paswvep 140 x 210 mm (5,5 x 8,3 arorima) 215,9 x 355,6 mm (8,5 x 14 arorimoB)

[MnoTHOCTL 60 r/m? 220 r/m?

MoanepxunBaemble HECTAHAAPTHbIE pa3mMepbl bymaru

Homep notka ®opmartbl 6ymarv (MMHUM. — MAKCHUM.)

NoTok 1 WnpuHa: 76,2-215,9 mm (3-8,5 arorima)
AnvHa: 127,0-355,6 mm (5-14 grorimoB)

NoTku 2-6 WnpuHa: 98.4-215.9 mm (3,9-8,5 aroima)
AnvHa: 190.5-355.6 mm (7,5-14 arorimoB)
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3arpy3ka bymarwu

B 3TOM pasgene paccMaTpuBatoTCA CeaytoLme BOnpochl.

®  3arpy3Ka BYMArU B TOTOK T .coeuceeeceiecesecimecnmsecssssesssseessaseessassesssnseses

e Loading Paper in Trays 2-6

e  UN3meHeHWe dopmaTa, TUNA U LBETA BYMAMM .....ceeereeeeeeareeeessennennnns

3arpy3ka bymaru B 10TOK 1

1. Otkpowite notokK 1.

2. BblaBuranve yanuHuTens notka ans 6osblimMx Gopmaros.

3. PasgBuWHbTE OrpaHUUMUTENN LWMPUHDBI K KPASIM JIOTKA.
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4. BcrtaBbTe 6ymary nuLeBo CTOPOHOM BHU3, HUXKHWUM Kpdem Brepes.

MNpumeuanus.

e [lepdopupoBaHHyto bymary ciegyeT 3arpy»aTtb MLEBOM CTOPOHOW BHM3 TAK, UTOObI KpaM C
nepdopaumert boin obpatleH K nepegHer CTOPOHe NPUHTEpA.

e [Ina aBycTOpoHHeH neuatn 6J1aHKKU M Bymary ¢ neyaTbio ciegyeT 3arpy»arb JIMLEBOM
CTOPOHOM BBEpX.

5. OtperynupyiTe HaNpaBasioLue, YTOObl OHWU CIErKa KAacaancb KPOMOK Bymaru.

6. Ecnun Ha naHenu ynpaeneHWsa NoABMTCA 3aNpoc, NOATBepAnTe Gopmart, TUM 1 LieeT bymaru Ha
3KpaHe «lNapameTpbl NOTKOB». [InA U3MeHeHMA HACTPOMKK BblbepuTe Pasmep, Tun unu LiBeT. Ecm
n3meHeHuA He TpebytoTca, HaxxmuTe OK.

7.  Haxmute kHonky OK.

Loading Paper in Trays 2—6

All of the trays are loaded the same way.
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MNpumeyanus.
e To avoid paper jams, do not remove the tray while printing is in progress.
e Use only laser print media. Do not use ink jet paper in this printer.
e For printing from the multipurpose feeder or printing envelopes, see Printing on Special Paper.

1.  BbIHbTE NOTOK U3 NpUHTEpA.

2. Adjust the width guides:
a. Pinch the guide lever on each guide.
b. Slide the guides to the size of the print media.
c. Tosecure the guides in position, release the levers.

3. Adjust the length guide to the size of the paper.
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4. TeperHuTe nUCTbl BNepea-HA3aa, pacnycruTe UX BEEPOM W BbIPOBHANTE KPOMKM CTOMKW HO POBHOM
NOBEPXHOCTU. ITO NPEAOTBPATUT CIUNAHUE IUCTOB U YMEHBLLIMT BEPOATHOCTb UX 30CTPEBAHMS.

MprmeuaHue. To avoid jams and misfeeds, do not remove print media from its packaging until
necessary.

5. Load the print media in the tray with the recommended print side facing up.

Mpumeuarue. Do not load print media above the maximum fill line. Overfilling the tray can cause
jams.

N3meHeHWe popmata, TMNa 1 ueeta bymaru

Koraa ana notka 1 3a4aH pexum «06x. 10TOK» MK «C NOJIHOW peryinpoBKO», HACTPOMKK Bymaru
MOXHO U3MEHATb NpKH KQ)KLI,OI‘/'I 3Arpy3Ke JioTKa. KOF[],CI JIOTOK NyCT, HA NAaHeNn ynpasneHUA NOABIAETCA
3anpoc Ha yKasaHue ¢opmara, TMNa v ueeTa bymarm.

Ecnu ansa notkoB 2-6 3a0H pexunm «C NosHON perynMpoBKOM», OTKPOWTE BbIOPAHHbIN NOTOK U
3arpysuTe HyKHyto bymary. lNocne 3akpbITUA NOTKA HA NAHENW YNPAB/IEHUA MNOABAAETCA 3AMNpoC HA
YKa3aHue dopmara, TUMA 1 UBeTa bymaru.

Korpa ans noTtka 3a4aH peXxmum «HasHaYeHHbIM», B HEro MOXHO 3arpy»aTb TOJIbKO bymary 304aHHOM0
¢dopmara. MNpu ycTaHOBKe orpaHnunTesnei Ha Apyroi ¢opmat 6ymarn Ha NaHeNM ynpasaeHns
BbIBOAWTCA cooblueHne 06 owmnbke. 3arpysuTe bymary, 3aTem MsmeHuTe Gopmar, TUN U LBeT bymaru Ha
NaHesu yrnpasfeHus.
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YcraHoBka dopmaTta, TMNA MK LBETA bymaru:

Ha naHenu ynpasneHua Haxkmute KHoMKy MpuHTep.

MepenanTte Ha BKNAAKY CHCT. CpeACTBA U HAXKMWUTE KHOMKY YNpaBaeHUe IOTKAMMU.
Haxkmute kHoMNKy MapameTpbl NOTKOB U BblbeprTe HA3HAYEHHbIM JIOTOK.

[na nameHeHWa HACTPOEK NOTKA HaxXMKTe PepakTup.

BbibepuTe Pasmep, Tun vnu Liser.

C NomMoLLbHO KHOMKK CO CTPESIKOM BBEPX UM BHU3 BblibepuTe HACTPOMKY bymaru.
Haxxmute kHonky OK.

NoubswN=

MpumeyaHme. ns [OCTYNA K MEHIO «YNpaBieHWe I0TKAMU» MOXeT NoTpeboBaTbCsi BOMTU B
CUCTEMY, UCNONb3YA YUETHYIO 3AMNUCb CUCTEMHOMO AAMUHUCTPATopA. Mo ymonyaHuio Ans cUCTEMHOMO
UAMUHWUCTPATOPA YCTAHOBJIEHO ClieaytoLlee: UMs nosib3oBaTens — admin, napons — 1111.
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[leuatb Ha cneumanbHoM bymare

B 3TOM pasaene paccmMaTpuBaloTCA ceaytoLme Bonpochl.

® K OHBEPTDI ceeureureuseenseemseeseessesssesssesssesssesssesssesasesssesasesssesssesssesssesasssasssssssesssssssssssssssssssssssssssessssssssssssssssssssesasesssessesssssssssssssnses 45
®  HOKIIEUIKM oareeeeeeeeeeeesetie ettt s ettt bt baes 51
®  [JIAHUEBOA KOAPTOTEUHOS cecverrerreeeeeeseseessesssssssssssssssessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssanes 52
®  [TPOBPAUHBIE MITIEHKM ccueereeeeeeeeeeeseesseeesesssssssessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssesssssssesssssssssssssssssnnes 52

[nsa 3akaza 6ymaru, NaeHKU UK Apyrux MatepuasioB obpaTtuTecs K MECTHOMY TOPrOBOMY
NpeacTaBUTENIO UM NoceTUTe Beb-cant www.xerox.com/office/6700supplies .

Cm. makke:
www.xerox.com/paper Recommended Media List (Cnncok pekomeHayembix matepuanos) (CLUA)

www.xerox.com/europaper Recommended Media List (Cnucok pekoMeHayeMbIX MATepHUAoB)
(EBpona)

KoHBepThl

MeyataTb HO KOHBEPTAX MOXHO M3 0TKA 1 UK 2. ECiK HY»HO BbINONHWUTL NedaTs 6osiee uem Ha NATH
KOHBepTax, Xerox peKoMeHZyeT UCMOoJIb30BATb JIOTOK 2.

YKa3aHuA no neyaru Ha KOHBepTax
e  KauecTBO NeyaTy 3aBUCUT OT KAYECTBA M UCMOJTHEHUSA KOHBEPTOB. EC/in He yaaeTca focTrub
HY)XHOr0 pe3y/bTaTa, NonpobyMTe MCNOIb30BATL KOHBEPTHI APYrOM MAPKH.

e [lpu xpaHeHun Bymaru He gonyckamTe KonebaHum TeMnepaTypbl U OTHOCUTENbHOW BAAXKHOCTH
OKpy)Xarlen cpefpl.

e  XpaHWTE HEUCMOJIb3OBAHHbIE KOHBEPTbI B YNAKOBKE, YTOObI OHW HE OTChIPeNH U He Nepecoxsiu,
MOCKO/NbKY 3TO MOXET NOBJ/IMATb HO KAYECTBO NeYaTH UK NPUBECTH K 06PA30BAHMIO CKIAAOK.
lMoBbIlWeHHaA BNAXKHOCTb MOXKET NPUBECTU K CKIIEUMBAHWUIO KOHBEPTOB NPW XPAHEHWK WM BO BpeMS
neyarw.

e He ncnonb3yiTe KOHBEPTbI C MATKOM HABWBKOW. Mcnonb3yiTe TONbKO NI0CKWE KOHBEPTDI.
e He ncnonb3yinTe KOHBEPTbI, CKIEUBAIOLLUECH NMPU HAFPEBAHUM.

e He ncnonb3yinTe KOHBEPTbI C KNAMAHAMM, CK/IEUMBAIOLLMMMUCA 3a CYET NPUKATHA.

e [lepen 3arpy3Kon yaanuTe 3 KOHBEPTOB BO3AYX, MOOXKMB HA HUX TAXKENYIO KHUTY.

e B Hactporikax gpariBepa npuHTepa B nose “Tun bymaru” Boibepute "KoHBepT".

e UNcnonb3yiTe TONbKO BYMAXKHblEe KOHBEPTbI.

e He ncnonb3yiTte KOHBEPTbI C OKHAMW U METQTTMYECKMMU 3AKUMAMM.
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3arpy3ka KOHBEpTOB B IOTOK 1

[MprumeuaHve. 3arpyxaiiTe B IoTOK 1 He 6bonee NATH KOHBEPTOB. Ype3mepHas 3arpy3ka J0TKa
MOXET BbI3BATb 3ACTPEBAHUE B NMPUHTEPE.

1.  BbIHbTe 6ymary 13 noTka 1 ¥ 3aKpoMTe NOTOK.

2.

3. [Ansa nepekntoueHUs ¢blo3epa B peXMM NevaTH HO KOHBEPTAX ONYCTUTE PbIYCKOK HA Pblo3epe B
BEPXHEM JIEBOM Yrny.
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[Mpumeuarve. Mpu neyat Ha Apyrux MAaTepuandax NOAHUMKUTE HA dblo3epe PbIYKOK As
KOHBEPTOB.

4. [pu MCNONB30BAHWM JOMOJIHUTENBHOIO GUHMLLEPA OMNYCTUTE PbIYAKOK HA BbiBOAe bymare.

anMel-lClHMe. an neyaTtu Ha pyrux martepuaniax onycrtmte Ha ¢bro3epe PbIHAXKOK A4 KOHBEPTOB.

5. 3akpo#nTe npasyto asepuy.

6. OtkpowTe noToK 1.

7. PQ3,D,BI4HbTe OrpaHnyYmTE NN LUMPUHDbI K KPpasaM NO0TKA.
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8. 3arpysuTte KOHBepTbI C 3AKPbITbIMU KJIANAHAMM, CTOPOHOM C K/IANAHOM BBEPX U KOPOTKOM CTOPOHOM
Bnepea.

e  KoHBepTbl Ne 10, Monarch nnu DL

e  Konseptbl C5
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/Y BHUMAHME! He ncnonb3yiTe CaMOKNEALLMECs KOHBEPTbI U KOHBEPTbI C OKHAMK. OHW MOTYT CTATb
NMPUYUHOWM 3aCTPeBaHMA bymari v NoBpeXAeHUA NPpUHTEpA.
lNprumeyarus.

e Ecnu KOHBepTbl He 3arpy3uTb B NOTOK 1 cpasy nocsie M3BneYeHUs UxX U3 YrIaKoBKK, OHU MOTYT
Aedopmuposatbes. Bo n3bexaHve 3acTpeBaHMi UX HEOBXOAMMO PA3rNAAMTD.

e Ecnu KoHBepTbI BCE PABHO NOAAKTCSA HEMPABU/ILHO, 3ArHUTE NepesiHUiA Kpai KOHBEPTOB He
bonee yem Ha 5 mm.

9. OTperynvpyiTe orpaHUuUTENM MO pa3Mepy KOHBEPTOB.

10. Ecnv Ha naHenu ynpasfieHWA NOABUTCS 3aMNpoc, noaTeepauTe dopmar, TN U LBeT bymaru Ha
3KpaHe «lMapameTpbl NOTKOB». 1151 U3MEHEHUs1 HACTPOMKH BblbeprTe Pasmep, Tun nnu Liset. Ecnu
M3MeHeHUs He TpebytoTcs, HaxmuTe OK.

11. Hakmute kHonky OK.
MNprmeyanus.

° Nocne 3aBepLIeHnA NeYvaTr Ha KOHBEPTAX BEPHUTE HA ¢bro3epe PbIYAXXOK A1 KOHBEPTOB B
NnoJioXKeHune AnA neyvyaTty Ha 6yM0re.

e [Ipy UCNONB30BAHWMM [OMOSIHUTENIBHOIO GUHMLLIEPA NOC/IE 3ABEPLUEHUS NeYaTH HO KOHBEPTAX
ONYCTWUTE PbIYAKOK HA BbiBOAE bymare,

Loading Envelopes in Trays 2-6

1. OTKpoWTe npasyto ABepLy, NPUNOAHSAB ee 3aLeNnKy.
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2. [inA nepekntoyeHus Gblo3epa B PeXMM NMeydaTH Ha KOHBEPTAX ONYCTUTE PbIYAXKOK Ha dblo3epe B
BEPXHEM JIEBOM Yry.

[Mpumeuarve. Mpu neyaTm Ha Apyrux MATepUanax NOAHUMMUTE HA dblo3epe PbIYAKOK As
KOHBEpTOB.

3. If you are using the optional Finisher, raise the lever in the upper right corner.

[Mpumeuarre. When printing plain paper, be sure to push down the lever.

4, 3aKpoWTe Npasyio ABepuy.
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5. Load the envelopes in the tray:
e Load #10, Monarch, or DL envelopes with the flaps closed, flaps down, and flaps on the leading
edge, toward the left.
e Load C5 envelopes with the flap closed, flap down, and flap toward the right.
Haknenku

Ha Haknerkax MoHO neyaTtatb U3 N06Oro NoTKa.

Guidelines for Printing Labels

°

[ ]

[ ]

A

Use labels designed for laser printing.

Do not use vinyl labels.

Do not feed a sheet of labels through the printer more than once.

Do not use dry gum labels.

Print only on one side of the sheet of labels. Use full sheet labels only.

Store unused labels flat in their original packaging. Leave the sheets of labels inside the original
packaging until ready to use. Return any unused sheets of labels to the original packaging and
reseal it.

Do not store labels in extremely dry or humid conditions or extremely hot or cold conditions. Storing
them in extreme conditions can cause print-quality problems or cause them to jam in the printer.
Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and
jam in the printer.

BHUMAHME! Do not use any sheet where labels are missing, curled, or pulled away from the backing
sheet. It could damage the printer.
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['naH LueBad KapTtotedyHas

Ha rnaHueBoi kapToTeyHon Bymare MOXKHO NeyaTaTb 13 1loboro NOTKA.

YKa3aHuA No neyaTty Ha rsHLeBOoW KapToTeuHou bymare
e He oTKpbIBaKMTE 3aMe4YaTaHHble YNAKOBKM C MSHLEBOM KAPTOTEYHOM ByMarom, ecnm He
cobupaeTech 3arpyatb bymary B npuHTEp.

e XpaHuTe rNsHLEBYo KAPTOTEUHYO bymary B OpPUrMHANIbHOM YNAKOBKE, HE BbIHUMAWTE NAYKM C
6ymMaroi U3 KApTOHHbIX KOPOBOK A0 HAYAIA UCMONb3OBAHMA.

o [lpexae uem 3arpyxatb rMsHLEBYI KAPTOTeYHyto bymary, ybepute Bclo bymary us fioTka.

e 3arpyamTe CTOJIbKO MMAHLEBOM KAPTOTEYHOM Bymaru, CKoibKo cobupaeTecb MCNOJb30BATb. He
0OCTaBASINTE MAHUEBYO KAPTOTEUYHYO Bymary B IOTKE NOC/Ie OKOHUYAHMWS NeudaTy.
Hencnonb3oBaHHYO KAPTOTEUHYI0 Bymary nomectuTe 06paTHO B OPUTMHA/IBHYIO YNIAKOBKY W
3aneyaramre.

e 3anacbl AOMKHbI NEPUOANYECKH 06HOBNATLCA. [Py ANUTENBHOM XPAHEHUW B SKCTPEMASIbHBIX
YCI0BUAIX BO3MOXHA AePpOPMALUA IMCTOB MISHLEBOW KAPTOTEYHOW 6ymary U Ux 3aCTpeBaHUE B
NpUHTEpE.

e B okHe gpariBepa npuHTEpA BblbEPUTE HYXKHbIW TUM FSHLEBOW KAPTOTEYHON ByMarv Uan yKaxuTte
NIOTOK C AAHHOW BymaroM.

[po3payHble nneHKu

MNeuatartb Ha NPO3PAYHbIX MIEHKAX MOXXHO U3 NOTKA 1unu 2.

YKasaHMA no neyartu Ha MNPO3pPAYHbIX MJIEHKAX

e [lepen 3arpy3Koi NpPO3paAYHbIX MNJIEHOK B JIOTOK yAA/IMTE U3 Hero BCto bymary.

e [lneHku cnepyet 6pathb 3a Kpas AByMst pyKamu. OTNeUYATKHU NasbLEB MK CKIAKW HA NJIEHKE MOTYT
MPUBECTU K YXYALIEHWIO KAYeCTBA NeYdTy.

e  He ucnonb3yiiTte nneHKu ¢ 6OKOBLIMK NONOCAMM.

e He nepenuctbiBaiTe NPO3PAYHYIO MIEHKY.

e [locne 3arpy3ku N1€HOK U3MEHUTE TUMN MATEPMAIa HO CEHCOPHOM 3KPaHe NPUHTEpPa Ha
“Mpo3pauHas nneHka".

e B HacTpoiikax fpariBepa NpUHTEpPA As HACTPOWKHK «Tun Bymarus» BolbepuTe 3HaYeHue
«[po3payHas nneHKa.

e  3arpyxaviTe He 6onee 100 nneHok. Ype3mepHas 3arpy3Ka IOTKA MOXKeET BbI3BATb 3ACTPEBAHME B
npuHTepe.
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[leyaTb

B aTom pasgene pacCMaTpmBardTCA cneagyrouime sonpochol.

e KpaTkue cBeieHHWs 0 neyatu 54
e  Bbibop napameTpoB neyaTu 55
o OyHKUMM NeyaTH 59
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MeuaTb

Kpatkue ceBefieHrs o neyatm

Mpexpae yem NeyaTaTb, KOMMNbLIOTEP U MPUHTEP CNeayeT NOAKNIOUUTD K CETU 1EKTPOMMUTAHWSA, BKIIOUMTb
W NOAKIOYNTL B CETU. YbeamnTech, UTo Ha KOMMbloTepe YCTAHOBJIEH MPABWJIbHBIN ApaviBep NMpUHTepA.
MoapobHOCTH cM. YCTaHOBKA NporpamMmHoro obecrneyenms Ha cTp. 30.

1. BbibepuTe noaxoasiuyto bymary.

2. BnoxwuTe bymary B COOTBETCTBYIOLMIA NOTOK. Ha naHeny ynpasneHuns npuHTepa yKaxuTte popmar,
LBET M TUN Bymaru.

3. OTKpoWTe OKHO HACTPOEK NeyaTy B UCMOJb3yeMOM NMPUIOKEHWUU. B BONbLIMHCTBE NpUNOXKeHWIH ans
3Toro MoXHo HaxaTtb CTRL+P (ansa Windows) nnn CMD+P (ana Macintosh).

BbibepuTe B cnvcke cBOM NpUHTEp.

5. TepenanTe K HACTPOMKAM aparBepd NpuHTepd, Bbibpas CeowcTtea vy Mapametpbl B Windows
unn Gynkuum Xerox® Ha komnbloTepe Macintosh. Ha3BaHUs KHOMOK MOTYT OT/IMYATLCA B
30BUCUMOCTH OT MPHUJIOKEHHUSA.

6. WM3meHHTE Hy)Hble HOCTPOWKK AparBepa NpuHTepa 1 HaxmuTe OK.
7. [insa oTnpaBku paboTbl HAO NPUHTEP HAXMUTE KHOMNKY MeuvaTs.
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Bbibop napameTpos neyaTtu

B 3TOM pasgene paccMaTpuBatoTCA CeaytoLme BOnpochl.

e CnpaBoYHAS CUCTEMA APANBEPA MPUHTEP ccoureerreesrressreessessssssssssssesssssssssssees 55
o [1apAMETPDBI MEUATHU WINUOWS ...ttt s sessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssasssssssssssanes 56
e [lapameTpbl neyat Macintosh w57

MapameTpbl NeyaTH, KOTOpble HA3bIBAIOT TAKKE NAPAMETPAMU APAMBEPA NPUHTEPA, YKA3AHbI KAK
"MapameTpsbi neyath” B Windows 1 nog 3aronoekom "®yHkLmmn Xerox®" Ha komnbloTepe Macintosh. B
HWUX BXOAST NAPAMETPbI ABYCTOPOHHEN NEYATH, MAKETA CTPAHULIbI M KaYecTBa nedaTtu. Hactporiku
neyaru, 3aaaHHble B pasgesne "MapameTpbl neyaTtu”, CTAHOBATCA HACTPOMKAMM MO YMOJTUAHHIO.
MapameTpbl Nneyatu, 3agaBaemMble B MPOrPAMMHOM MPUIIOKEHUH, SIBAAIOTCA BpeMeHHbIMU. [ocne
3AKPbITUA NPUNOKEHUSA 304AHHbIE HACTPOMKKU HE COXPAHSOTCA.

CnpaBoyHas cucTtema gparesepa NpUHTepd

CnpaBoyHas cucTema Apaisepa npuHTepa Xerox® focTynHa B okHe "TMapameTpsbl neyatu”. Ytobb
OTKPbITb CMPABOYHYIO CUCTEMY, HAXKMUTE KHOMKY CNPABKU (?) B HAXKHEM SIeBOM Yrny okHa "TlapameTpsl

neyarun”.
(o — |
| i i i i
N Al —
D — : I— -
[E— ]
vi/d0mE 0000 —
:./ =) =]
()= (=] == | = |

CBepeHUs 0 HACTPOMKAX B OKHe “TlapameTpbl neyaTn” oTOBPaXKATCA B OKHE CMPABKU HA ABYX
BK/IQAKAX:

o CopaepikaHue - CNMCOK BKNAAOK BBepXy M obnacTtei BHM3y okHa "TapameTpbl neyaTtu”. Ha Bknaake
"CopepxaHue” MOXKHO HOMTH ONUCAaHUWE BCeX NoJsier U obnacter okHa "TlapameTpbl neyaTu”.

e lowuck - none gns BBOAA pasgena unu GyHKL MK, No KOTopbiM TpebyeTca nHbopmaums.
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NapameTpbl neyatn Windows

YcraHoBka napameTtpoB neyatu ansa Windows

Bo Bpems neyaru 13 ntoboro NpUNoKeHUA NpUHTEp 06paALLAETCA K HACTPOMKAM 30A0HWS NeYaTh,
30/1aHHbIM B OKHe "TlapameTpbl neyaTn”. MoXKHO 3a4aTb HaMbosee 4aCTO UCNO/b3yeMble NApaMeTpbl
NeyaTu U COXPAHWUTb UX, YTOObI HE NPUXOAUNOCH UX KAXKABIA Pa3 MeHATb.

Hanpumep, ecnu 3agaHus no 6onblier 4yacTy TpebytoT neyaTy Ha 0berx CTOpoHax bymaru, BbibepuTe B
OKHe "TlapameTpbl NeyYaTh»" ABYCTOPOHHIOK MeydTb.

Bbibop napameTpoB neyaT No yMOAUYAHHIO:
1. Ha naxenu 3apay Windows Bbibepute Myck > Hactporika > MpuHTepbl M paKcbl.

2. B nanke "MpuHTepbl U GaKCbI” LWEeNKHUTE NPABOM KHOMKOM MbILLIK 3HAYOK NPUHTEpA U Bbibepute
nyHKT MapameTpbl neuarty.

3.  Ha Bknagkax B okHe “TlapameTpbl neyatu”, BbibepuTe HACTPOMKK U HaxkMUTe OK ansa coxpaHeHus.

[MpumeyaHuve. Ans nonyvyeHUsA ONONHUTENBHBIX CBEAEHMIM O 3TUX HOCTPOMKAX ApPaMBepa NpuHTepa
ans Windows HaXXMUTe KHOMKY cnpaBku (?) B okHe "TlapameTpbl neyatk”.

Hactpoika napameTpoB neuartu gns otaenbHon pabotbl (Windows)

Uto6bl yka3aTb NApAMETPbI NEYATH OTAENIbHOM paboTbl, Nepes ee OTNPABKOM HA NPUHTEP HYXHO
M3MEHWTb NAPAMETPbI NEeYATH B NMPUIOKeHWW. Hanpumep, ecnu ansa oTAeNbHOrO JOKYMEHTA TpebyeTcs
MCNonb30BATb pexnmM GoTorpadryeckoro KAUeCTBd NeyaTu, nepes neyarbio paboTbl yctaHoBUTE
HacTporiky "®oTo" B okHe "TlapameTpbl neyatu”.

Bbi6op napameTpoB ¢puHULWIHOK 06paboTku B Windows

Ecnu Ha npuHTEpe ycTaHoBeH duHULEep, NnapameTpbl GUHULLIHOM 06pabOTKM BbIOUPAIOTCS B OKHE
"MapameTpbl neyath” Apaiisepa NpuHTEpd. MOXHO CLIMBATL A0 50 NMCTOB GyMark NAoTHOCTHI0 90 r/m?
M MCNONb30BATL CABMI U yKNaaKy (ao 1000 nucros).

Bbibop BapHaHTA CLUMBAHUA B ApariBepax npuHTepa PostScript n PCL:
1. B oKHe gpariBepa NpuHTepa nepensuTe Ha BKNaAKy Bymara/BeiBog,.
2. HaxkmuTe cTpenky cnpasa oT pasgena «ClunmBaHue» 1 BbibepuTe BapuaHTa 1 ckpenka.

Bbibop BapuaHTa cagura B gpareepax npuHTepa PostScript u PCL:

1. B apaksepe npuHTepa nepeiauTe Ha BKAAAKY [lononHuTenbHo.

2. HaxmuTe + pagom c pasgenom «bymara/Bbios».

3. Hakmute 3anpoc caBura.

4.  HaxmuTe CTpeniKy CnpaBad OT Nonsa 1 Bblbepute CABUN KAXKAOIro KOMMIEKTA.
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CoxpaHeHue Habopa Hanbonee YACTO UCMOJIb3yeMbIX MAPAMETPOB NEYATH
(Windows)

MoxxHo COXPAHATb HCl60pr napameTpos ne4vyartu noj otaesibHbIMM UMEHAMU ANA UCNOJ1Ib30BAHKUA C
HOBbIMHU pG6OTQMM neyartu.

CoxpaHeHue Habopa NapamMeTpoB NeyaTu:
1. B npunoxeHuu, rae oTKpbIT AOKYMEHT, BbibepuTe Paitn > Meuars.

2. Bbibepute npuHTEp M HaXMKTe CBOMcTBA. Ha BKNagKax B okHe "TlapameTpbl neyatu” BbibepuTte
HACTPOWKM.

3. Haxmute kHonky CoxpaHeHHble HACTPOMKH B HUMHKHEN YacTH OKHa "TlapameTpbl neyatun” u
BblbepuTe NyHKT COXPAHUTb KAK.

4. BsepwuTe ms Habopa NnapameTpoB nedyaTu U Haxmute OK, 4To6bl COXpaHMTL Habope HaCTpoeK B
cnmcke "CoxpaHeHHble HACTPOMKHK'.

5. ﬂ,)’lﬂ neyaTtu C npUMEHEeHUEM 3TUX HACTPOEK Bbl6epMTe B CMMUCKe 3aa4aHHOE UMA.

MNapameTpbl neyatn Macintosh

Bbi6bop napameTpoB neuatu B Macintosh

Utobbl 304aTb ONpeseneHHble NAPAMETPbI NeYdTH, nepes oTnPABKOM paboTbl HA MPUHTEP HYXKHO
M3MEHWUTb HAOCTPOMKM.

1. B npunoxeHuw, rae oTKpbIT JOKYMeHT, BbibepuTe File > Print.

BbibepuTe npuHTEp B cnvcke “Printers”.

B meHio "Copies & Pages" (Konuu 1 ctpanmuibl) Boibepute nyHKT Xerox® Features (QyHKLMKM Xerox).
B pacKpbIBAIOLLMXCA CNUCKAX BbIOEPUTE HYMHHbIE NAPAMETPbI NeYaTy.

e wnN

Ans oTnpaBku paboTbl HA NPUHTEP HAXMUTE KHOMKY Print.

Bbi6bop napameTpoB ¢puHULLIHOM 06paboTku B Macintosh

Ecnu Ha npuHTepe ycTaHoBAEH dUHULLIEP, NapaMeTpbl PUHULLIHOM 06paboTKM BbIBMPAIOTCA B OKHe
"MapameTpbl neyatu” Apaisepa NpUHTepd. MoXHO cluMBaTh A0 50 AMcTos 6ymaru naoTHOCTbI0 90 r/m’
M MCNONb30BATL CABMI U yKNaaKy (ao 1000 nucros).

Bbibop clumBaHMA B gparBepe npuHTepa Macintosh:
1. B OKHe apaiBepa npuHTepa B MeHio Konuu BbiGepute OyHkumn Xerox®.

2. B pvanoroesom okHe «bymara/BeiBof» HAXMUTE CTPESIKY cnpasd oT pasgend «PuHuwep»
BblbepuTe BApMaHT 1 cKpenka.

Bbibop capura B gparisepe npuHTepa Macintosh:

1. B OKHe apaiBepa npuHTepa B MeHio Konuu BbiGepute OyHkumn Xerox®.

2.  Ha Bknapgke «JononHuTensHo» BbibeprTe 3anpoc caBura.

3. HaxmuTe cTpesnky cnpasd oT nosis v Bbibeprte CABUT KAXKAOIO KOMIMJIEKTA.
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CoxpaHeHue Habopa 4acTo UCMNoJIb3yeMblX NAPAMETPOB NEYATH HAO KOMNbloTepe
Macintosh

MoxxHo COXPAHATb HCl60pr napameTpos ne4vyartu noj otaesibHbIMM UMEHAMU ANA UCNOJ1Ib30BAHKUA C
HOBbIMHU pG6OTGMM neyartu.

CoxpaHeHne Habopa NapameTpoB NeyaTw:

1. B npunoxeHuw, rae oTKpbIT JOKYMeHT, BbibepuTe File > Print.

BbibepuTe npuHTEp B cnucke "Printers”.

BbibeprTe napameTpbl NeYaTH B PACKPbIBAIOLLMXCA CMMCKAX AUAIOrOBOTO OKHA NeYaTy.
BbibepuTe Presets (MpeaycraHoBkH) > Save As (CoxpaH1Tb Kak).

v &~ WN

BeeauTe MMsA Habopa NnapameTpoB nevaTy U HaxmuTe OK, uTo6bl COXpPaHUTL Habope HACTPOEK B
cnucke "Presets”.

6. [lns neyartu c npUMeHeHWeM 3TUX NAPAMeTPOB BbibepuTe UMA B crivcke "Presets”.
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DyHKUMM NeyaTu

B 3TOM pasgene paccMaTpuBatoTCA CeaytoLme BOnpochl.

e JIByCTOPOHHAA NeuaTtb ... 59
e  Bbibop napameTpos bymaru ans neuyatu 60
e [leyaTb HECKONbKKX CTPAHUL, HO OAHOM SiMCTe (neyaTtb 6/10KoM) 60
e [leyatb H6powitop 60
e  Hcnonb3oBaHue onuui LBeTa 61
e [leyatb 0bnoXKeK 62
e [leyaTb Ha BCTABKOX 62
e [leyaTb CTPAHML-UCKITIOYEHUH .63
e  MacwrabuposaHue 63
e [leyatb BOAAHbIX 3HAKOB 64
e [leyaTb 3epKAIbHbIX U30OPAKEHUH .. 65
e Co3paaHWe M COXpOaHEeHWe HECTAHAAPTHbIX PA3MepoB 65
e  Bbibop yBegomneHns o 3aBeplieHUM PABOTBI B WINAOWS......ccceueceemeeeeneereneesessecessseensaeessssesesanes 66
e [leyaTb cneuMabHbIX TUNOB paboT 66

ﬂ'ByCTOpOHHFIFI neyartb

Meuatb ABYCTOPOHHEro JOKyMeHTa

Ecnu npuHTep noaaepxuBaeT ABTOMATUYECKYIO ABYCTOPOHHIOK NEeYdTb, €e NapaMeTpbl YKA3bIBAKTCA B
HACTPOMKAaX ApanBepa npuHTepa. lpaneep NpyHTEpA UCNONb3YeT HACTPOMKU A1 BEPTUKASIbHOM MU
rOPU3OHTATLHOM OPUEHTALMU U3 MPUIIOKEHNA, OTKYAA NEeYaTaeTca JOKYMEHTA.

NapameTpbl MmakeTa ABYCTOPOHHEMN CTPAHULLbI

MapameTpbl MOKETA ABYCTOPOHHEN CTPAHULIbI ONPeAENsoT PA3BOPOT HAMEUYATAHHbIX CTPAHUL,. JJaHHbIe
HOACTPOMKK MUMEIOT NPUOPUTET HAZ HOCTPOMKAMMW OPUEHTALMM CTPAHWL, 3040HHBIX B MPUIOXEHWU.
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BepTuKanbHbIH ANnb60OMHbIN

2 [ <
¥ | 2 I A
BepTuKanbHbIN BepTuKanbHbIN Anb60OMHbIN Anb60OMHbIN
2-CTOPOHHSAA NeyaTb 2-CTOPOHHSAA Neyartb, 2-CTOPOHHSAA NeyaTb 2-CTOPOHHSAA Neyatb,
nepeBOpPOT N0 KOPOTKOM nepeBOpPOT MO KOPOTKOM
KpOMKe KpOMKe

Bboibop napameTpos bymaru ana neyatu

CyuiectByeT aBa cnocoba Bbibopa bymaru ans pabotbl neyat. Bymara MoxkeT BbIGUPATLCS MPUHTEPOM
B 30BUCMMOCTH OT 304AHHOIO popmaTd, TUNa v ueetd. Kpome Toro, MOXHO BbI6paTh BbIOpATh NOTOK C
HY>XHOM 6ymaromn.

[leyaTb HECKONIbKMX CTPAHUL, HA O4HOM nncTe (Nneyatb 6,10K0M)
anI neyaTtr MHOroCTpaHMYHOIoO JOKYMEHTA MOXHO HanevyataTb HECKOJ/IbKO CTPAHUL HA OAHOM JIUCTE

6ymaru. Beibpas Ha Bknagke "MakeT/BoasHble 3HOKKW" HaCTpoiKy "CTpaHuu Ha incTe (Neyatb 610Kkom)”,
HA OJHOM NUCTe MOXHO neyatatb 1, 2, 4, 6, 9 nnu 16 crpanuu,

[Neuatb 6powtop

B pe)xvme ABYCTOPOHHEN NeyaTy MOXKHO HANeYaTaTb JOKYMEHT B BUAe HebonbLion bpolutopbl. Takue
6poLutopbl MOXHO CO3A4,0BATL HA bymare ntoboro dopmara, NPUrogHOM ANnA ABYCTOPOHHEN MeydTu.
JpaiBep aBTOMATHYECKM YMEHbLUAET KAXAYI0 CTPAHMLY U NeYaTaeT YeTblpe U300parKeHUs CTPAHUL, Ha
NUCTe, NO ABA U306PAXKEHUA HA KAKA0M cTopoHe. CTPaHMLbl MeYaTaroTcs B TAKOM NopsKe, YTobbl
nocse crubaHus 1 CLUMBAHUSA NOAyunnack bpoluopa.

Mpu neyatu 6poLutop c nomolybto gparsepa Windows PostScript unn Macintosh moxHo 3aaaTb none
nepenseTa v CABUT U306paXKeHus.

o [lone nepenneta - roOpU3OHTASIbHBIN MPOMEXKYTOK MeXAY M306PIKEHUAMMU HA CTPAHULLE
(n3mepsietca B nyHKTAXx). MyHKT paseH 0,35 mm (1/72 provima).
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e CaBHr M306paXKEeHUA - CAABUT M30OPAKEHUI CTPAHML, OTHOCUTENIbHO NepenneTd (C TOYHOCTbIO 10
AEeCcATOM YacTh NyHKTA). CABUI CKOMNEHCUPYET TONLLMHY CNOXEHHOM ByMaru, YTObbl UCKNIOUMTD
CABMT M306PaKEHNI HAPYXKY NPY CKNOAbIBAHWM bpoLutopbl. BoibepuTe 3HaueHWe oT Hyns Ao 1
MYHKTA.

MNone nepenneta CaBur nsobpakeHus

I

el 8

Ncnonb3oBaHue onuun LBeTa

OnumuK uBeTa CNyXar ANa HACTPOMKM LiBeTonepeaayu B neyaraembix JokyMeHTax. Jparsepbl Windows
PostScript n Macintosh o6ecneunBaloT LWMpPOKHUE BO3MOXKHOCTH A1 HACTPOMKKU M KOppeKuuu ugeTd. B
KAXXA0M CUCTeMe NpesyCMOTPEHO TPU CTAHAAPTHLIX PEXUMA HACTPOMKU LBETA A8 06bIYHbIX
nosb3oBarenen v pasaen "Tlonb3oBateNbCckUe NapamMeTpbl LBeTa” Ans 6osiee onbITHbIX MONb30BATENEN.

Tpu CTAHAAPTHBIX LBETOBbIX PEXUMA:

e  ABTOHOCTPOMKA UBETA - /1A TEKCTA, PUCYHKOB U poTOorpadui npumeHsaeTca Hambonee
NoAXOAALAA LBETOBAA KOPPEKLMA. ITO peKOMeHAyeMas HOCTPOMKA.

e  flpKui UBET - ABTOMATHUYECKASA LLBETOBAS KOPPEKLMSA AN NoNyyeHUsl bonee HACbILLEHHbIX LiBETOB.

e YepHo-benbliii - npeobpasoBaHMe BCEX LIBETOB B YepHO-6eible MK OTTEHKKW Ceporo.

B okHe "Tonb3oBaTesibckMe NapameTpbl LBeTA" NpeaycMOTPEHO TPKU CNocoba HAOCTPOMKK LiBETOB.
HaxmuTe “Tonb3osaTenbckue napameTpsl LeTa’. OTKpoeTca oKHO “Tlonb3oBaTensckue napameTpol
useta”.

e  OnucaHue UBETA - TPEXLIArOBbIM NPOLECC NONb30BATENLCKOM LIBETOBOM KoppeKLumK. [lenas Bbibop
B KAXAO0M M3 TpeX noneﬁ, Bbl COCTAB/IAET NpeanoXeHue, onnucbiBaroulee ynpasjieHue LBETOBbIMA
XOUPAKTEPUCTUKAMU IOKYMeHTA. [lna 6oniee TOUHOro ynpasieHus LBETAMU JOKYMEHTA MOXHO
COCTABWTb HECKOJIbKO MPEeasIOKEHUHN.

CTpyKTypa npeasiox)eHusi COCTOUT U3 TpeX YaCTen:

e  Kako# LuBeT U3MeHUTb? - PACKPbIBAIOLMMCA CMMCOK A5 BbIbopa LBETA MW AUANA30HA
LBETOB AJ151 HACTPOWKM, Hanpumep “Bce canaToBble LBeTa".

e  M3MeHUTb HACKOJIbKO? - BbI6OP BENMUYMHBI MU3MEHEHWS BbIDPAHHOIO LIBETA, HAMPUMEP
“Topaszpgo 6onblue”.
e  Tun uameHeHUA? - pACKPbLIBAIOLLMIACS CMIMCOK A1A BbI6OPA TUMNA U3MEHEHUA LiBETd, HANPUMEpP

"HApKuin”.
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Mocne cocTtaBneHus ynpasnawowero npeaioxeHna OHO NoABAAETCA B OKHE NoJ, Bbl6pClHHbIMM
NnoJsIAMH.

e LiBeTOBas KOppEeKLUA - CMUCOK UMUTALMK KOMMEPUYECKOM NeyaTH, LiIBeTOBOM 3a1nBKH, LieeTa CIE n
I'IOﬂyTOHOBOFO M306pCl)KeHMFI anA BbI60pCl B COOTBETCTBMU C LIBETOM LI,OI-(yMeHTCl.

e HacTtpoiika uBeTOoB - HA60p U3 LLECTU NON3YHKOB A1 HACTPOWKU OTAENbHbIX COCTABNAIOLLIMX
Bbl6paHHbIX UBeTOB. [peflycMOTpeHbl NON3YHKKU A5 HACTPOMKKW OCBETIEHHOCTH, KOHTPACTHOCTH,
HACbILWEHHOCTH W ToNyboM, MyprnypHOM U KeNTON COCTABNAIOLLEN LIBETOB.

MeuaTb 06N0XKeEK

0610KKa — 3TO NEPBASA UM NOCNIEAHAN CTPAHWULIA IOKYMEHTA. [11s 06/10KeK MOXHO BblOpATb MCTOUHMK
6ymaru, OT/IMYHbBIN OT UCMOJIb3YEeMOro AJA MeYdTH OCHOBHOW YaCTH JOKyMeHTd. Hanpumep, MOXHO
MCnonb30BaATb 6/1AHK CBOEW KOMMAHWM [/1S1 NeYaTH NepBor CTPAHWLbI JOKYMEHTd. TaKKe MOXHO
MCNonb30BATb MJIOTHYO bBymary Ans neyatv NepBoM W NociefiHel CTpaHuL, otueTa. Jas nogaum obnoxek
MOXHO MCMOJIb30BATH 10601 NOAXOAALLMI NOTOK.

BbibepuTe onumio ana nevaty obnoxekK:
o be3 0bnoxeK — 0TMeHa Bcex NpeablAyLLMX HACTPOeK ANnA 0bnoxekK.

e  TonbKo NepeaHsAA - NneyaTb NepPBOM CTPAHMULbI HO Bymare U3 3a4aHHOro NoTKa. Mpu
OBTOMOTHYECKOW ABYCTOPOHHEN MeYdTy Ha 06/10KKe NeuaTaroTcs [iBe NepBble CTPAHULbI.

o Tonbko 3a4HAA - NeyaTb NocnegHen CTPAHHULDbI HA 6yM0re 13 3aJAaHHOro noTKa. an
aBTOMATHUYECKOM ﬂByCTOpOHHEI‘/’I neyatu Ha obsIoXKKe neyaTarTcs Ase nocneaHue CtpaHuubl, Korga
UYMUCNO CTPAHUL, HETHOeE.

o lMepeaHsasa v 3a4HASA: OAUHAKOBbBIE - MeYATH NEPBON U NocneAHel 0610XeK HA bymare U3 oiHOTO
JIOTKA.

° I'IepeAH;m U 304HAA: pa3Hble - NeYaTb nepBoﬁ W nocneaHemn 06n0¥eK Ha 6yM0re M3 PA3HbIX
JIOTKOB.

[MeyaTb Ha BCTABKAX

MoHO BCTABAATbL IMCTbI 6€3 NEUATH UK C NeYdTbIo Nepes NEPBOM CTPAHULLEN KAXKAOMO AOKYMEHTA UK
nocsie yKa3aHHbIX CTPAHWL, B AoKyMeHTe. [lobaBneHne BCTABOK NOC/E YKA3AHHbIX CTPAHUL, B JOKYMEHTE
MCNONb3YyeTca ANA OTAENEHWUA PA3AENIOB UM B KAYECTBE 3AKNAKW WK 3amnonHuTens. Ybeaurech, Uto
yKasaHa bymara nsi BCTABOK.

BbibepuTe HOCTPOMKM NeYaTH Ha BCTABKAX:

e  Onuuu BCTABKH - MecTo BCTABKM: "Tlocne ctpanuubl X' (rae X - 3aaaHHas cTpaHuubl) wnu “TMepeg
cTpaHuuen 1°.

o  KonuuectBo BCTABOK - KOIMYECTBO JIMCTOB, BCTABNIAEMbIX B KQAXKA0OM MECTe.

e CTpaHMUbI: CTPAHWLA MJIM AUANA30H CTPAHWL, MOC/E KOTOPbIX HYXHO A060BUTL BCTABKY.
Paspenante oTaenbHble CTPAHMLBI MM AMANA30HBI CTPAHML, 3anATbIMKW. [lnA yKasaHua gnanasoHa
CTpaHML, McnonbsyiTe geduc. Hanprumep, utobbl 406aBUTL BCTABKKM Nocsie cTpanuy 1,6,9,10m 11,
cnepyert ykasate: 1, 6, 9-11.

e bymara - otobpaxkeHune ¢popmaTa, LBeTa U TUNA bymaru, BbIBpaHHbIX B pasgene "Mcnoib3oBatb
napamMeTpbl 3a4aHKs" AN BCTABOK. BoibepuTe dopmar, uBeT v TMN BymMarn HaXaTtuem CTpesikv BHU3
cnpasa ot nons "bBymara”.
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Hactpo¥iku paboTbi - oTobparkeHWe aTpubyToB bymaru, UCNonb3yemMon Afis OCTAIbHOM YacTH
paboTbl.

[NeyaTb CTPAHML-MCKNIOYEHUH

HacTpoliku cTpaHML-MCKNOUEHWIH OTIMYAKOTCSA OT HACTPOEK OCTA/IbHbIX CTPAHHUL, B paboTe. OTanyarses
MOTYT, HOMPUMEP, 30aHHbIe HACTPOMKK GopmaTa, TMNA U LBeTa 6ymaru. TaKKe MOXHO YKa3bIBATb
LPYryto CTOPOHY iucTa 6ymaru ans nedatv pabotbl. B pabote neyatn MoryT cogeparbcs pasHble
MCKIOYEHUS.

MycTb B paboTe neuatu cogepxutcsa 30 CTPAHML, M HY)XXHO HAMEYATATb NSATb CTPAHUL, HO OHOM CTOPOHE
creuManbHon bymaru, a ocTasibHble CTPAHULbI HANeYaTaTb HaO 06enx CTOpoHAxX 06bIuHOM Bymaru. ns
neyaTy TAKOM paboTbl MOXHO MUCNONb30BATb GYHKLMIO CTPAHUL-MCKITIOUEHWH.

B okHe "[lo6aBWUTb UCKIIIOUEHWA" 3a4aMTe NApAMeTpbl CTPAHWL-UCKNIOUYEHWH W BbIbEpHUTE ANs HUX APYroi
MCTOYHMK Bymaru:

CTpaHuMLbl - CTPAHULIA MW AMAMA30H CTPAHMLL, AJ1A KOTOPbIX MPUMEHAITCA MapaMeTpbl
CTPAHML-HUCKOYEHWH. PasgensiTe oTAeNbHbIe CTPAHULbI MW ANANA30HbI CTPAHML, 3anATbIMK. [lns
YKA30aHKWA AManasoHa CTpaHuL, ucnonbsyite gedunc. Hanpumep, utobbl 3aaate cTpanunubl 1, 6,9, 10
n 11, cnepyet Beectu 1, 6, 9-11.

Bymara - otobpaxeHue ¢popmara, LBeTa U TMNa 6ymarwu, BbIGpaHHbIX B pasgene «Mcnonb3osartb

HACTPOMKY paboTbi». BbibepuTe dpopmart, UBET U TUM BYMArv HAXXATHUEM CTPESIKM BHU3 CMPABA OT

nonsa «bymara».

2-CTOPOHHSAA NeYaTb - BblbOp HACTPOEK ABYCTOPOHHEN NeuaTtu. [1na Bbibopa HACTPOMKKU HAXKMUTE

CTpesniKy BHMS.

e 1-CTOPOHHAA NeYATb - NeYATb HA CTPAHULLAX-UCKIIIOUYEHUAX BbIMOSHAETCA TOSIbKO C OAHOM
CTOPOHbI.

e  2-CTOPOHHASA NMeYdTb - NeYdaTb HA CTPAHULLAX-UCKIOUYEHUSIX BbIMOJHAETCA C 06enx CTOpPOH
JINCTA, A JIMCTbl NEPEBOPAYMBAIOTCA MO JJIMHHOW KpOMKe. PaboTy 3aTem MOXHO CLUMBATL BAOJIb
AJIMHHOM KPOMKM JIMCTOB Bymarw.

e  2-CT. NeydaTtb, NePeBOPOT NO KOPOT. KPOMKE - NeyaTb HA CTPAHMULLOX-UCKITIOUEHUSAX
BbINOJIHAETCSA C 06eUX CTOPOH SIMCTA, A JIMCTbI NEPEeBOPAYMBAIOTCS MO KOPOTKOW KPOMKE.
PaboTy 3aTem MOXHO CLUMBATL BAOJIb KOPOTKOW KPOMKHW JIMCTOB Bymaru.

Hactpo¥iku paboTbl - oTobparkeHWe aTprbyTos 6ymaru, UCNonb3yemMon AN OCTAIbHOM YacTu

paboTbl.

[Nprumeuanus.
e  Ecnv npuHTep He nogaepX1BAET ABTOMATHUYECKYIO ABYCTOPOHHIOIO MEYATb, HEKOTOpble
napameTpbl HeAOCTYMHbI.

e CoueTaHue ABYCTOPOHHEN NeYaTH C HEKOTOPbIMU TUMAMU U GOpMATAMKM ByMaru MoXeT
NMPUBECTU K HEMpeACKa3yemMblM pe3ysibTATAM.

MacwTtabuposaHue

MN306parkeHne MOXKHO YMeHbLIMTb A0 25 % McxoaHOoro unu yesennuntb Ao 400 % . Hactpoika no
ymonuanuto: 100 % .
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B cpene Windows pasgen "Onumu macutaba” B OkHe ApanBepa NpUHTEPA HOXOAUTCA HA BKAAAKE
"Bymara/BbiBog" B none "bymara”. ina gocryna k pasgeny "Onumun macutaba’ HaxXMUTe CTpesiKy cnpasa
oT nonA "bymara” n BbibepuTe NyHKT "Apyrov pasmep”.

e Be3 macwTabupoBaHus - pasmep U306paKEHUsI OCTAETCA TAKUM XKe, KOK B OpUrMHane.

e ABTOMATHYECKOE MACLITABUPOBAHUE - U3MEHEHWE OHOIO CTaHAAPTHOro dpopmara bymaru Ha
Apyroi. OpyUrMHan oKymMeHTad MmacwtabupyeTcs no BbIbpaHHOMY GOpMaATy, YKA3aHHOMY B rosie
"Pa3smep otneuarka”.

e  MacwTtabrupoBaHUe BPYUHYIO - U3MEHeHWe pa3Mepd OTNEeYATKA HA BEJIMUKUHY, YKA3AHHYI0 B
NpoLeHTax B nose nog rpadpuyeckum n3obpaxeHnem cnpasa oT pasgena "Onuun macwtaba”.

[MeyaTb BOASAHbBIX 3HOKOB

BoasAHOM 3HOK — 3TO cneumnasibHbIM TEKCT, KOTOPbIM MOXET Ne4aTaTbCA HaO OAHOM UM HECKOJIbKMX
CcTpaHuLax. Hanpumep, BMeCTo NpoCTaBNEHUs LUTAMMNOB Nepej pacnpoCcTPaHEHUEM JOKYMEHTOB HA HUX

B KQYeCTBe BOAAHbIX 3HAKOB MOTYT NeuaraTbcsa Takue cnosa, "Konua®, "HepHoBuK" nnm
"KoHbunaeHuManbHo".

C NoMoLLbIO ONUMI BOAAHBIX 3HAKOB MOYHO BbINOJHATH CleyoLre onepaumm:
e  Co3paHuWe UK pefJaKTUPOBAHKWE BOASAHbIX 3HAKOB C MOMOLLbIO PeAAKTOPA BOAAHbIX 3HAKOB!
e  Wmsa - npucBOEHWe UMEHU HOBOMY BOASHOMY 3HAKY.
e Onuuw - UCNONb30BAHME TEKCTA, METOK BPEMEHHW WK rPAdPUKK AN BOAAHOMO 3HAKA.
e  TekcT - BBOA B Nnosie TEKCTA, KOTOPbIM ByAeT NeyaTaTbCsl KAK BOASIHOM 3HAK.
e  LUpudT u LeT - ykasaHue wpudTta, pasmepa, CTUAA U LiBETA BOAAHOMO 3HAKA.
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e Yron - yCTQHOBKA yrJjid MOBOPOTA TEKCTA MU FPadUKKN A5 BOAAHOIO 3HAKA.
e  [InOTHOCTb - yKA3aHME NIOTHOCTH NEYATU BOAAHOIO 3HAKA HA CTPAHMLIAX.

L MonoxkeHue - pacnonoxeHne soOAAHOIO 3HAKA HA CTPAHULE. Mo YMOJIHAHHIO OH pacnonaraeTca
B LUEHTpe nevyaraemblX CTPpAHUL,.

e  PasmelaTb BOAAHOM 3HAK HA NEPBOM CTPAHMLLE MJTM HA BCEX CTPAHMLIOX IOKYMEHTA.

e [leyataTtb BOASHOW 3HAK HA NepefiHEM MW HA 3a4HEM NJIaHe, KW 06beANHATL ero ¢ paboToM
neyaru.

MeyaTb 3epKaNbHbIX N306parKEHUH

Ecnu yctanoBneH gpaeep PostScript, CTpaHMubl MOXXHO NeyaTaTb B 3€pKAIbHOM 0TObpaXeHUH. B aToM
cyyae nNpu NevyaTy M306pakeHns oTobpaXKAKOTCA B 3epKASIbHOM BUJie C/1IeBA HAMPABO.

CO3ﬂ,ClHMe N COXpAHEHHNE HECTAHAAPTHbLIX pA3MepOoB

MeyataTb Ha Bymare HECTAHAAPTHOrO pa3mMepa MOXHO U3 N0TKoB 1-6. HacTpoliku 6ymaru
HeCTaHAAPTHOro pasmepa COXPAHATCA B ipaiMBepe NpUHTEpPaA W AOCTYMHbI A/1A BbIbopa BO Bcex
MPUNOXKEHUAX.

CeepneHus o bymare HeCTAHAAPTHBLIX PA3MEPOB, NOAAEPKUBAEMbIX KAXKABIM JIOTKOM, CM.
MoaneprMBaeMble HECTOHAAPTHbIE pasmepbl bymaru Ha cTp. 39.

Co3aaHune 1 coxpaHeHWe HeCTaHAAPTHbIX pa3mepos B Windows:
1. B oKHe gpaviBepa NpuHTepa nepeiauTe Ha BKNaLKy Bymara/BbiBog,.

2.  HaxkmuTte cTpenky cnpaea oT nons "bymara” v Boibepute pyrow ¢popmar > Pasmep oTneyartka >
Co3parb.

3. B okHe "HoBbli HaCTpanBaemblii pasmep” BBEAUTE BbICOTY M LUMPUHY JIUCTA U BbibepuTe eMHUL b
n3mMepeHus.

4, BeeawuTe Ha3BAHWE HOBOro pasmepa B nose "NUmsa” u ana coxpaHeHust HaxkMUTe KHonky OK.

Co3paaHue 1 coxpaHeHne HeCTaHAAPTHbLIX pasmepos B Macintosh:
1. B npunoxennu BoibepuTe File (Paiin) > Page Setup (MapameTpbl cTpaHULbl).

2. B pasgene Paper Sizes (Pa3mepbl 6ymaru) Boibepute Manage Paper Sizes (YnpasneHue
pasmepamu bymarm).

B okHe "Manage Paper Sizes" HaxkMUTe 3HAYOK ntoca (+), YTobbl 4OH6ABUTL HOBbLIV pasmep.
ABakapbl wWenkHUTe be3 UMeHU BBepXy OKHA W BBEAUTE UMSI HOBOIO HECTAHAAPTHOrO pa3mepad.
BesuTe BbICOTY M LUMPUHY HOBOIO HECTAHAAPTHOrO pa3mepa.

o u &~ W

HaxkmuTe cTpenky cnpasa ot nons “Non-Printable Area” (Heneuaraemas obnactb) v Boibepute
NPUHTEpP B PACKPbIBAOLWEMCA CNUCKe. Mnu yrkaxkuTe 3HadveHus noner “Cnesa’, "Cnpasa”, "Ceepxy”
"CHu3y" B pa3gene "Hactpoika nonb3osarens”.

7.  Haxmute OK gnsa coxpaHeHusa HacTpoek.
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Boibop yBegomneHus o 3asepieHnn pabotbl B Windows

Bbl MOXeTe nonyuatb yBegoM/IeHWe O 3aBepLUEHUH NeuaTy paboTebl. [ocie 3aBepLueHns neyaTv Ha
3KpaHe KoMMbloTepa byaeT NOABAATLCSA COOBLEHWE C YKA3AHUEM UMEHU PABOTbI U UMEHU NPUHTEPA.

MpumeyaHure. 3Ta GyHKUMA AOCTYNHA TONbKO Ana KomnbtoTepa ¢ OC Windows, noaKto4eHHOro K
CeTeBOMY MPUHTEpPY.

Bbibop yBefjomnieHus o 3aBepLUeHUU paboTbi:

1. B oKkHe gpaiiBepa NpUHTEPA B HUKHEN YACTH N060M BKIAAKW HADKMUTE KHOMKY JlonoNHUTeNbHble
napameTpbi cTaryca.

2. B okHe "CocTosiHne" BbibepuTe YBeAOMAEHUE U LLLEeSIKHUTE HYXXHbIW NapameTp.
3. 3akpo#nTe okHo "CocTosiHue".

MeyaTb cneymanbHbIX TUNOB paboT

MpumeyaHuve. Ana BbINOSIHEHMA CNELMabHbIX TUMOB PABOT HA NPUHTEpe JOJIKEH ObITb YCTAHOBNEH
OOMOJIHUTENbHbIN XECTKUN AUCK.

MpobHbli KoMnneKT

®yHKuMA "TIPO6HBIM KOMNIEKT" NO3BOAAET HAMEYATATb NPOBHYI0 KOMWI0 PaboThbl, cofepKaLLeH
HECKOJIbKO KOMKWK, N NPUOCTAHOBUTb NeYaTb OCTABLUMXCA KOMWIK HA NpuHTepe. [ina neyatu
[OMOJSTHUTENBHBIX KOMWK Nnocsie NpoBepKU NPOBHOM KOMUKU HYXHO BblbpaTb MMsA paboTbl HA NAHeNr
yrnpasieHna NpuHTepa.

Pa3610KMpoBaHWe OCTANBHOM YACTH paboTbl MOC/e NeyaT NPOH6HOro KOMMIEeKTA:
1.  Ha naHenu ynpasneHus HAXXMUTE KHOMNKy PaboTbl.
2. BbibepuTe B cnucKke cOOTBETCTBYIOLLYIO paboTy neyarw.

[Mpumeyarve. Ha naHenu ynpaBneHus pagom ¢ MMeHeM paboTbl byaeT oTobparkatbesi coobuyeHne
"3anepaHo:MpobHbIM KOMMAeKT".

3.  HaxmuTte kHONKy Pas6bnokuposarsb.
OcTtaBwasnca 4yacTb paboTbl pacneyaTaeTcs, M paboTa yaaJMTCA C ECTKOIo AUCKA NPUHTEpA.

3awuiieHHas nevyarb

3awmileHHas neyaTb AAeT BO3MOXHOCTb N0JIb30BATENIO HA3HAYMTb NAposb U3 4-10 uudp ans paboTbl
neyaTtu Npu oTNPABKe HA NpuHTep. PaboTa yaep:KMBAETCA B NpUHTEPE, MOKA 3TOT NAposb He byaeT
BBEZIEH HA NAHENW YNPAB/IEHUS.

Paz6nokupoBaHue 3aluileHHoN paboTbl A1a neyaTw:
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Ha naHenu ynpasneHus HaxkMuTe KHOMKy PaboTbl.
Haxkmute JInuHble U 3awuuy. paboTbl.

BbibepuTe nnuHyto Nanky.

BBeauTe Ha3HaueHHbIM paboTe naponb 1 HaxmuTe OK.
BbibepuTe B CnMcKe COOTBETCTBYHOLLYIO paboTy neyaTw.

ok wN-=

Haxkmute kHoMKy Meuats.
Mocne neuatn paboTa yaanaeTca ¢ eCTKoro JMCKa NpuHTepa.

CoxpaHeHHas paboTa

®yHKumaA "CoxpaHeHHas paboTa’ CNyXUT AN COXpaHeHWA paboTbl NeyaTuy B nanke Ha npuHtepe. C
NMOMOLLbIO 3/1EMEHTOB YNpaBeHUs B okHe "CoxpaHeHHble paboTbl” MOXXHO MPOCTO COXPAHATL PAbOTbI
WJIM NeuYaTaTb UX U COXPAHATb AJA MOC/EAYIOLLErO UCMOIb30BAHUSA. TAKKE MOXHO YCTAHABMBATD
JOCTyN K paboTam neyatu ciegyowmnm obpasom:

e 06wHmit - naponb He TpebyeTca, NOO6OKM NONL30BATE/Ib MOXKET NeYATATb AAHHbIM Gain ¢ NaHenu
ynpaBfieHUA NpUHTepa.

e JIMyHbI# - Ans neyaty Ganna Nonb3oBaATENSIM TPEOYETCA NAPOSb.

Ecnu coxpaHeHHas paboTa CTAHOBUTCA HEHYKHOW, €e MOXHO YAAIUTb C NMAHENN YNpaB/IeHUs MPUHTepd.

Meyatb obuier coXpaHeHHOM paboThbl;

Ha naHenu ynpaenenuna HaxmuTe KHonKy Pa6oTbil.

Haxkmute Coxp.pabotbi.

Haxkmute kKHoNKy O6LW M.

HaxxmuTe kHonKy KonnuecTBo, BBeAUTE KOJIMYECTBO KOMUIM U HaxkMuTe OK.
BbibepuTe paboTy neyaru.

o> wnN-=

[Jns oTnpaBku paboTbl HA NeYaTb HAXMUTE KHOMKY MevaTs.
Mocne neyatn paboTa OCTAETCA HA KECTKOM [IMCKe NPUHTEPA A Noc/iefytowero UCronb30BaHKUS.

MeyaTtb NMYHOM COXPAHEHHOM paboTbi:

1.  Ha naHenu ynpasieHWs HAOXXMUTe KHOMNKY PaboTbl.

2.  Hakmute Coxp.paboTbl.

3. BbibepuTe nMyHyt0 NaAnky.

4, BeeawuTe Ha3HAYEHHbIM paboTe naponb U HaxkmuTe OK.

Ha skpaHe 0TobpasnTcs CNMCOK COXpAHeHHbIX paboT neyaTw, 41 KOTOPbIX YCTAHOBJ/IEH AAHHbIN
napo’ib.

5. Haxmute kHonky KonuuectBo, BBeMTE KOMUECTBO KONWUK W HaxmKuTe OK.
6. BbibepuTe paboTy neuatw.
7.  [Ans oTnpaBku paboTbl HA NeYyaTb HAXMUTE KHOMKY MevaTs.
Mocne neyatn paboTa oCTAETCA HA KECTKOM [IUCKE NPUHTEPA A1 NOC/IeAYIOLLErO UCMO/Ib30BAHMS.

Phaser 6700 Color Printer 67
PykoBoacTBO nonb3osarens



MeuaTb

Personal Print

Make sure that the printer is set up before installing the printer software. Setup includes enabling the
optional features and assigning an IP address for the Ethernet network connection. If the printer has not
been previously turned on and configured, see the System Administrator Guide at
www.xerox.com/office/6700docs .

To print a personal job:

1.

&~ WwWN

68

Ha naHenu ynpasneHus HaxkMuTe KHOMNKy PaboTbl.

Haxkmute JInuHble U 3awwmuy. paboTbl.

BbibepuTe nnuHyto Nanky.

BbibepuTe B CMcKe COOTBETCTBYHOLLYIO paboTy neyaTy.
HaxmuTe kHoMKy Meuarsb.

Mocne neyatn paboTa yaanseTcs ¢ )eCcTKOro AMCKaA NpuHTepa.

MprmeuaHme. You can also print all jobs in the list at once, delete an individual job, or delete all jobs
in the list.
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B aTom pasgene pacCMaTpmBardTCA cneagyrouime sonpochol.

O6cnyK1BAHME M UUCTKA

70

CueTumkum ydyeTa 1 ncnoJib3oBaHUA

3akas pacxoaHbIX maTtepmnasioB

lNepemelueHne npuHTepa
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Ob6cnyXMBaAHWE M YNCTKA

B 3TOM pasaene paccmMaTpuBaloTCA ceaytoLme Bonpochl.

o O6LME MEPDI MPELOCTOPOIHOCTH eoreernreernrressesseesssessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssss 70
®  HUICTKO MPUHTEP O ceeeeveereeeeeeseessenseasssssesssassssssssssssssssssssssssssssesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssassssessssssssons 71
®  PErYNIAPHOE OOCHYIUBUHME .....cc.ceeeeeereveeseesssesesseesssessasssssssssssssssssssssssssssssssssssssssssssssssssssssssessssessssssssssssssesssssssssssssnessns 82
0 [1EPUOANUECKOE OOCTIYIKUBAHUE ....ocoeeenreernrresssesesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssessss 93

O6ume Mepbl NPEAOCTOPOKHOCTH

A\ BHUMAHME! He ucnonb3yiTe Ans YUCTKKU NPUHTEPA OPraHUYECKUE U CUIIbHBIE XMMUUECKUE
pacTBOPUTENN UK A3PO30JIbHbIE YNCTALLME CPeACTBA. He HOHOCHTE KMAKOCTb HENOCPEeACTBEHHO HA
noBepxHOCTH. [oNb3yiTech TONbKO CPeaACTBAMM U MATEPUAIAMU, PEKOMEHAYEMbIMU B JAHHOM
AOKYMEHTALMH.

A\ NPEAYNPEXAEHUE. XpaHuTe Y1CTALME MATEPUAbI B HEAOCTYMHOM ANs ieTel MecTe.

A\ MPEAYNPEXAEHUE. He npuMeHsiiiTe 3po30/ibHble YUCTALLME CPEACTBA AN YUCTKU NPUHTEPA
CHAPYXW W BHYTpWU. HeKoTopble aapo30/ibHble HANOHUYMKK COAEPKAT B3PbIBOOMACHbIE CMECH U
HenpuroaHbl A1 NPUMEHEHUs HA dNeKTPUYECKOM 060py0BAHMK. MCNOIb30BAHWE TAKUX YACTALLMX
CPeACTB MOBbILLAET PUCK MOXAPA MW B3PbIBA.

& MPEAYMNPEXAEHUE. He cHUMaMTe KPbILWKKW U OFPAXKAEHUSA, 3aKpensieHHble BUHTamMu. He
paspeLuaeTcs OCyLWecTBAATb TEXHUYECKOe 06CNYKUBAHUE MW PEMOHT KOMMOHEHTOB MPUHTEPA,
HOXOAALLMXCS 30 STUMM KPbILIKAMU U OFpaXKAeHUAMW. He BbINoNHANTE AeMCTBUS MO 06CYKUBAHMUIO,
He OMUCAHHbIE B JOKYMEHTAL MK HO NPUHTEP.

& NPEAYNMPEXAEHUE. BHyTpeHHWe aeTanu npuHTepa moryT 6biTb ropsaummn. Cobniogaite
OCTOPOXHOCTb, €C/I1 ABEPLbl U KPbILLKW OTKPbITbI.

e  He ctaBbTe HMYero Ha NpuHTep.

e He octasnsiiiTe KpbilKK U iBEpLbl OTKPbITbIMU B TEYEHWE ASIMTENBHOrO BpEMEHH, 0COBEHHO B APKO
OCBelLeHHbIX NoMeLLeHnnx. Bo3aencTBre cBeTa MOXKET NPUBECTH K NOBPEXAEHWI0 6/10KOB
$GOPMHUPOBAHKA U30OPCIKEHMS.

e He OoTKpbIBaMTe KPbILKKU W ABEpLIbl BO BPEMSA MeyaTH.

e He HaknoHaMTe NpuHTep BO Bpemsi ero paboTbl.

e He TporamTte 3neKTpUYECKHE KOHTAKTbI U MEXAHUYECKUE NPUBOAbI. OTO MOXKET MPUBECTU K
NMOBPEXAEHUIO NPUHTEPA U YXYALLIEHUIO KAYeCTBA NevaTw.

e [Ipexae ueM BKIOUYATL NPUHTEP B CeTb, y6eAUTECH, UTO BCE KOMMOHEHTbI, KOTOPbIE HblM CHATBI BO
BPeMS YUCTKH, YCTAHOBJIEHbI NPABUBHO.

70 Phaser 6700 Color Printer
PykoBoacTBo nonb3osarens



06cnyxuBaHUE

YucTka npuHTepa

B 3TOM pasaene paccMaTpuBatOTCA ClefytoLMe BONpochl.

®  YNCTKO MPUHTEPA CHAPYHM cecerreerreeeeereeesessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnnes 71
®  YUCTKO MPUHTEPA UBHYTPMU ceoeereeeeeeeereeeseessesasesssssssesssessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnnes 72
e  YpcTka AatyMka NAOTHOCTH .74
®  YNCTKO POJTUKOB MOLOUM weueereereereeeserssessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssanes 79

UncTKa NpUHTEpPa CHApPYXXH
PerynsipHo ounwanTe CEHCOPHbIM SKPAH W NAHeNb YNPABAEHWA OT MNbln U FPA3N.

MopAAOK YUNCTKM NPUHTEPA CHAPYHKM:
1. YT0bbl OTKNOUMTL KHOMKK U MEHIO, HAXXMUTE KHOMKY DHeprocbepexeHue.

2. [AnA yaaneHus nateH C NaHeNM ynpaBieHUs U CEHCOPHOMO SKPAHA UCMOMb3YyMTe MATKYHO
6e3BOPCOBYI0 TKAHb.
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3. [1ns BO3BpATA NPUHTEPA B PEXXMM FOTOBHOCTM CHOBA HOXKMWUTE KHOMKY JHeprocbepexeHue.

4, YWCTUTe CHAPYKM BbIXOLHOM JIOTOK, JIOTKKU Ans ByMaru U npoune Hapy»KHble NOBEPXHOCTH
NPUHTEPA MATKOM 6€3BOPCOBOM TKAHbIO.

UncTka npyHTEpa U3HYTPH

Ana yaaneHus NaTeH ¢ BHYTPEHHUX MOBEPXHOCTEN NMPUHTEPA, YXYALLAIOLWMIA KAYeCcTBO NeyaTh,
He06X0AMMO PerynsipHO YUUCTUTb NPUHTEP U3HYTPHU. Kpome Toro, NpUHTEpP CneayeT YNCTUTb U3HYTPU MpU
3ameHe 6,10Kka GOPMUPOBAHUS M30OPAKEHMS.

MprmeuaHme. MNopALOK YUCTKU MOXKHO MOCMOTPETb B BUAEOPOJIUKE HA NpUHTepe. BbibepuTe
MpuHTep > Cuct. cpeactea > NMOUCK U yCTp. Heucnp. > YCTpaHeHWe HENoNaaoK > BepTUkanbHbie
6enble IMHWK UK LITPUXHU OAHOTO LBETA U HAXXMUTE KHOMKY Bocnp. BUAaeo ana npocMoTpa
BMAeopoanka Oyucmume n1a3epHoOe OKHO.

A\ MPEAYMNPEXAEHUE. Bo u3bexaHWe NOPAKEHUN SIEKTPUUECKUM TOKOM Nepes HauasioM paboT no
06CNYKUBAHWUIO HEOHXOAUMO BbIK/IHOUYATH NPUHTEP W BbIHUMATL BUJKY LLHYPA MUTAHKUA U3 PO3ETKH.

1. OTKAOYUTE NUTAHME NPUHTEpA.
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06cnyxuBaHUE

2. OTkpo¥iTe nepeaHioo aABepLy.

3. V3BneKkuTe UUCTALLMIA CTEpIKEHb, PACMONOXEHHbIW C ThIJIbBHOM CTOPOHbI NepefHEN KPbILLKK.

4.  BCTABbTE YACTALLMI CTEPIKEHD B OZIHO U3 UETbIPEX OTBEPCTUI /1A UUCTKM 0 yNopd, 3aTem
u3BnexkuTe ero. MoBTOpHTE 3Ty ONEpaLLMI0 HECKOJIbKO Pas.
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O6cnyxuBaHUe

5. TlosTopuTe 3Ty npoueaypy 4158 YACTKU OCTAJIbHbBIX TPEX OTBEPCTUN.
6. BepHWTE UNCTALLMI CTEPKEHDb B UCXOZHOE MONOXKEHHUE,

7. 3aKpoKTe nepeaHiow0 asepLy.

Mprmeyarve. B KOMNAEKT KaXA0ro HoBoro 6,10Kka GopMHUPOBAHUA M30OPAXKEHUA BXOAUT CMEHHASA
yncTAwas nogywka. MNpu 3ameHe 610Kka GOPMUPOBAHMA M30OPAXKEHUA TAKKE HEOOXOAUMO MEHATD
UMCTALLYIO MOAYLLKY.

YucTtka gaTtymMKa naoTHOCTH

Koraa TpebyeTcs UMCTKA AATYMKA MAOTHOCTH, HA NMAHENW YNPABJIEHUSA BbIBOAMTCA COOTBETCTBYIOLLEE
coobleHue.
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MprmevaHme. NopAfOK YNCTKU MOXKHO MOCMOTPETb B BUAEOPOJIMKE HA NpUHTepe. BoibepuTe
MpuHTep > Cuct. cpeactea > NMoUcK M ycTp. Heucnp. > YcTpaHeHUe Henonaaok > LiBeta cavwkom
CBeT/ible UJIK CJIMLLKOM TeMHbIE W HAXKMWUTE KHONKY Bocnp. BUAeo ans npocmoTpa BMAEOPOMKa
Oyvucmums CTD-0amyux.

& MNPEAYNMPEXAEHUE. Bo n3bexaHue NopaxkeHMs 3N1eKTPUYECKMM TOKOM nepes HadyasioM paboT no
06CNYKUBAHUIO HEODXOAUMO BbIKIHOUATL MPUHTEP U BBIHUMATL BU/IKY LUHYPA MUTAHWS U3 PO3ETKM.

A\ MPELOCTEPEXEHWS.

e  Ybeautecb B OTCYTCTBMU KOHTAKTA PEMHSA NEPEHOCA C NPeAMETAMM, CMOCOBHbIMU
NoBpeAMTb ero NoBepXHOCTb. LlapanuHbl, rpsisb M NATHA HA peMHe MOTYT YXYALWTb
Ka4yecTBO Neyarw.

e [1nAa 3awuTbl 610KOB GOPMHUPOBAHUS M30OPAXKEHUS OT APKOIO CBETA HEOHXOAMMO
3aKpbITb iBepLy 0TceKkd 610KOB pOPMUPOBAHNSA M30OPAKEHUSA B TEUEHWE NATU MUHYT.
AnutenbHoe Bo3aeicTBHE CBETA yXyALLIAET KAQYeCTBO NeydaTy.

1. OTKOUMTE NUTAHUE NPUHTEPA.

& NPEAYNPEXAEHUE. HekoTopble aeTann MoryT 6biTb ropsaunmu. lNpexae yem NpoAoIKUTb,
nogoxaunte 30 MUHYT, NOKA NPUHTEP OCTbIHET.

00:30:00
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2. OTkpo¥iTe nepeaHioo aABepLy.

3. BblHbTe bymary 13 noTka 1 ¥ 3aKpoOMTE NOTOK.
4. OTkpo#MTe npasyto ABepLy, NPUNOAHAB ee 3aLlenKy.

5.

6. BblaBMHBTE pemeHb NepeHoca:
a. BosbmuTech 3a pyuky cnepeam pemHs nepeHoca.
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b. BbiTawmWTe pemeHb NepeHoca, YTobbl CTANA BUAHA JIMHUS HO PEMHE.

7.

8. YcraHoBWTe peMeHb NepeHoCca Ha MecTo:
a. 3aABWMHbTE peMeHb NEPEHOCA B MPUHTEP TAK, YTOObI HE CTAIO BUAHO JIMHUM.

b. Onyctute pyuku.
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C.  3aABMHbTE peMeHb NepeHoca Ao ynopa.

0.

11. Y106bl 3aKpbLITL NPABYIO ABEPLY, MOMECTUTE PYKY PAAOM C 3ALLEIKON U MIOTHO NPUXMUTE ABEpLy K
NpuUHTEpPY.
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[Mpumeuarve. Ecnn npasas asepua He 3aKpbIBAETCA, 3HAYMT peMeHb NePEHOCA BCTABJIEH He A0
KOHL.

12. 3aKpoKTe nepepHio0 ABepLy NpUHTEpA.

13. Bknwouute npuHTEp.

Yuctka POJIMKOB nNoaa4yu

Meproanueckr ocMATPUBAMTE POSIMKK MOAAYN B KAXKAOM U3 YCTAHOBJIEHHBIX JIOTKOB W YUCTUTE UX OT
6YMAKHOW MbinK 1 T.4. [Npy 3arpA3HEHUU POSIMKOB NMOAAYM MOXKET NPOUCXOAWTL 3ACTPEBAHUE bymaru 1
YXYALLIATbCS KAYeCTBO NeyaTy.

1.  BbIHbTE NOTOK U3 NpUHTEpPA.

2. Bpawavite ponvk noaauu Lo nossnaeHusa puxkcaropa.
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[MpumeuaHve. POIMKKM pacrnosnox)eHbl B 0TCEKe NOTKA A4J1A ByMaru Ha paccTossHUKU NPUBAN3UTENBHO
165 mm (6,5 grorima) oT IMUEBOM NAHENW NPUHTEPA.

3.  BbITAHYB dUKCATOP POJIMKA NOAAYM M3 KAHABKKW HA OCH, BbIABUHBLTE POJIMK Briepes.

|

4. AHanorvyHbiM 06paA30M CHUMKUTE BTOPOM POSIMK NOAAYH.
5. TMpoTpuTe ponnKu yucton 6e3B0pCcOBOM TKAHBLIO, CMOYEHHOM BOZOW.
6. CoBMmecTWUTe OTBEpCTUE NEPBOrO POJIMKA MOAAUN C OCbIO OCHOBAHMUS.
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7. HapeHbTe ponvK Noaayy HA oCb M 3aBUHBTE €ro TAK, YTOObI BbICTYMNbl MOJIHOCTLIO BOLLJIW B
yrnybnenus, a GUKcaTop B KAOHABKY.

8. AHOOrMYHbIM 0OPA30M YCTAHOBUTE BTOPOM POJIMK NMOAAUM.
9. [poTpwuTe ponuK Nofaur B NOTKE, MOBOPAYMBAS €rO.
10. BcTaBbTe NOTOK 06PATHO B NPUHTEP.
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PerynapHoe obcnyxxunsaHue

B 3TOM pasaene paccMaTpuBatOTCA ClefytoLMe BONpochl.

®  3OMEHA TOHEP-KAPTPHIMKE ....ceeeormeeeesseresssssssssssssesssssssssssssssssssssssesssssssesssssssssssssssssssssssees

L 3ameHa C60pHVIKCl OTXOLOB.....eeeteeetteeeteeecteeecneeeesneeessaeeesseeeans

e 3amMeHd 6710KOB GOPMUPOBAHUSA UBOOPCIKEHMS.....eccverrrererrersresssssssssssssssssssssssssssssssssenes

¢ 3aMEHA KAPTPUIAMKA CLUMBATEI S cuurverreenreessessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssses

CBELI,EHI/IFI O 30Kd3e pacxoA4HblX MATEPUAUIOB CM. pasaen 3akas pacxoAHbIX MATEPHMANIOB HA CTP. 108.

3ameHa TOHep-KapTpUAKEH

I-(orp,a Tpe6yeTc;1 3aMeHa TOHepP-KapTpruaXa, Ha NnaHenn ynpasaeHna NnoaBnAeTCcAa COOTBeTCTBYyOLWee

coobueHue.
1. OTKpo¥iTe nepeaHIo0 ABepLy NPUHTEpPA.

2. AKKYpOTHO M3BJIEKWUTE 3aMEHSAEMbIA TOHEP-KAPTPULK.
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& BHMUMAHME! He kacavTecb yactem, NOKA3AHHbIX HO PUCYHKE.

/Y BHUMAHME! Npw 06paiieHnm ¢ ToHep-KAPTPHUAKEM COBIIOAANTE OCTOPOXKHOCTb, YTOGbI He
MpocCbINaTb TOHEp.

3.  JocTaHbTe U3 YNAKOBKWU HOBbIW TOHEP-KAPTPUAK.

4, InA paBHOMEPHOro pacnpefeneHus ToHepa BCTPAXHUTE KAPTPUAX 5—6 pas.

& BHUMAHME! MNpun obpalyeHnr c ToHep-KapTPUAKeM COBNI0aMTe OCTOPOKHOCTb, YTOObI He
NpoCbINATb TOHEP.

5. CoBMeCTMB CTPenKy Ha TOHEP-KAPTPUAKE CO CTPEIKOW HA NMPUHTEPE, AKKYPATHO BCTABLTE
KapTPUIXK L0 yrnopa.

6. 3akpoKTe nepenHiol0 ABEPLY NPUHTEPA.
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3ameHa cbopHUKa 0TX0A0B

Koraa TpebyeTca 3ameHa c6OpHMKA OTXOZ0B, HA NMAHENU YNPAB/IEHWA BbIBOAWUTCA COOTBETCTBYIOLLEE
coobLeHue.

1. PacnakyiTe HoBbIM c6OpHHUK 0Tx0A0B. COXpPAHUTE NIACTUKOBBIW NAKET A5 UCMO/Ib30BAHHOTO
CcHbOpHHMKa.

2. OTKpo¥iTe nepeaHIoo ABepLy NpUHTEpPA.

3.

4,
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06cnyxuBaHUE

A\ BHUMAHME! Npm 06paiieHrmn co C6OPHUKOM OTXOA0B COBIII0AANTE OCTOPOKHOCTb, UTO6bI He
npocbINaThb TOHep.

A\ BHAMAHME! Mocne nsBneyeHnsi CGOPHUKA OTXOA0B HE KACANTECH TOW YACTH, YTO MOKA3AHA HA
PUCYHKE HUXKe.

5. TMomecTnTe MCnosb30BAHHbIM COOPHUK OTXOA0B B MNIACTUKOBbLIN MAKET U3 KOMMIEKTA HOBOFO
CHOPHUKA M MIOTHO 3AKPOKTE €ero.

6. BcTaBuB B CNOT HOBBIM C60pHVII-( 0TX0A40B, 3a4BMHbTE €ro A0 ynopa.

7.

3ameHa 6n10k0B $pOpMHUPOBAHHUA U306pAKEHUA
Korpa Tpebyetca 3ameHa 610Kka GopMUPOBAHKA M306pAXKEHHUSA, HO MAHESNM YNPAB/IEHWUS BbIBOLWUTCA

cooTBETCTBYyHOLEE coobuieHue.
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O6cnyxuBaHUe

A

1.

2.

3.

86

BHUMAHME! [1nqa 3awwmnTbl 610K0B POPMUPOBAHUA M30OPAXKEHHUA OT APKOro CBETA HEO6XOAUMO
30KpbITb ABEpLY OTCeKa 610K0B GOPMHMPOBAHNUA U30OPAXKEHNA B TeUeHHe NATU MUHYT. [lanTensHoe
BO3/leMCTBMe CBETA yXyALIAdeT KauecTBO NeyaTu.

OTKpoWTe NepeaHIo ABEPLY NPUHTEPA.

M3BneknTe 3ameHsAemMbl 610K POPMHUPOBAHUA M30OPAKEHUSA:

a. Bo3sbmuTech 3a aepaTenb Ha 610Ke POPMUPOBAHUA U306PAKEHNA U BbIABUHBTE €ro
HAMOJIOBUHY.
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b. OpHol pyKoW Bo3bMHUTECH 30 6510K GOPMUPOBAHMS M30OPAKEHUSA, A APYrOM U BbIHbTE €ro U3
npuUHTepa.

/Y BHMMAHME! He kacaiTecb 4acTei, NOKA3AHHbIX HA PUCYHKE.

A\ BHUMAHME! Mpu o6paiieHnm ¢ 610KoM GOPMUPOBAHUS M306PAXKEHHUs COBIIOAANTE OCTOPOXHOCTD,
4TObbI HE NPOCHINATL TOHEP.

4,  YcTtaHoBMTE HOBbIM 610K GOPMUPOBAHUS U306PAXKEHUSA:
a. Pacnakyite HoBbIM 610K GOPMUPOBAHMA U30OPAXKEHMS.
A\ BHUMAHME! Ans 3awutbl 610Ka GOPMUPOBAHUA M30EPKEHHNS OT A/IMTENILHOMO BO3AEHCTBHS

APKOrO CBETA He YA A/ISINTE OPAHIKEBYHO 3ALMTHYIO HAK/IAAKY, NOKA 610K He ByzeT BCTABNEH B
NpUHTEPp.

b. CHumHTe c HOBOro 6710Ka GOPMUPOBAHMS MU30O6PAXKEHUS [1BE PE3UHOBbIE MOJIOCKU M BbIbpOCHTE
MX.
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C.  AKKypaTHO 3a/1BUHbTE 610K GOPMUPOBAHUS U306PAKEHUS B COOTBETCTBYHIOLLMIA CIIOT.

d. YpanuTe opaHXKeBYIO 3ALLMTHYO HOKAAAKY C YCTAHOBNIEHHOTO 610KA GOPMUPOBAHMSA
M3006paXKeHus U BbibpocbTe ee.
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5. 3akpoiTe aBepuy oTcekd 610K0B GOPMHUPOBAHMSA 30OPAXKEHUS.

6.

7.

8. CHumute UNCTALLYHO NOAYLIKY, OKAB A3bI4YKKW CHU3Y Hee.

E3
—
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9. PacnakywTe HOBYIO YACTALLYIO MOAYLLIKY U3 KOPOOKK 6510KA GOPMUPOBAHUA M306PAKEHUS.
10. lMpuKpenuTe HOBYIO YACTSALLYIO NOAYLLKY K YACTALLEMY CTEPKHIO.

11. BcTaBbTe UMCTALLMIM CTEPIKEHD B OAHO M3 UETbIPEX OTBEPCTHM NS YUMCTKM [0 yNopd, 3aTem
u3BnexkuTe ero. MoBTOpHTE 3Ty ONEpaLLMI0 HECKOJIbKO Pas.

12. BcTaBbTe YUCTALLMI CTEPHKEHD B OCTA/IbHbIE TPW OTBEPCTUSA AJ1A YNCTKMU.
13. BepHuTe UMCTALLMK CTEPKEHDb B UCXOAHOE NOJIOKEHHE.
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14. 3akpoKTe nepefHIo0 ABepLY NpUHTEpA.

3ameHa KapTpUAKa ClLuMBATENSA

KOFLI,C! Tpe6yeTcn 3aMeHa KClprMﬂ,)KCl cuwmBaTtensd, Ha naHenu yI'Ip(JB)'IeHVIFI BbIBOAUTCA COOTBETCTByIOLU,ee
coobueHue.

;i\ MPEAYMNPEXAEHUE. He BoinonHAMTe AAHHYIO Npouesypy BO BpeMs NevaTw.

1. PacnakyiTte HOBbIM KAPTPUAXK CLUMBATENA U CHAMKWTE YNAKOBOYHbLIM MATEpUAU.
2. OTkpoWTe nepeaHtoto AsepLy GUHULLEpA.

3.

W =
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O6cnyxuBaHUe

[MprmeuaHve. MeTannnyeckas YacTb HOBOTO KAPTPUAKA AOJIKHA bbITh onyLyeHa (cMm. puc.).

4, BcTaBbTE HOBbIM KAPTPUAXK CLUMBATENS B chHMLuep.
U
| ‘&\\
// @
A
S.

3aKkpoMnTe nepepHoto asepuy GUHULWEpPA.

/
1

|

i

R ‘
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06cnyxuBaHUE

Mepuoanueckoe o6cny nBaHHUE

B 3Tom pasgene paccmMaTpuBaoTcs cnefytoLme Bonpochi.

®  SOUMEHA PBHOBEPC ccu.verevercveneveeesassssssssssessssessssessssessssessssassasasssssssssessssesssssssssssssssssssssssssssssssssessssessssessssssssssssssesssssssssnsssnessns 93

¢ 30aMEHA HOABOPA 1A OOCTIYIKUBAHMS......oeonrverrreresseesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssses 95

CBefieHHsA 0 30Ka3e pacxofHbIX MATEPMAIOB CM. pa3gen 3aKa3 pacxoHbix MaTeprasios Ha cTp. 108.

3ameHa ¢blo3epa

Mpumeyanue. You can watch a video at the printer that shows the removal procedure. Boibepute
MpuHTep > Cuct. cpeactBa> MNMouck U ycTp. Heucnp. > YcTpaHeHue Henonagok > MoeTopstowmecs
NATHA WK JIMHUK W HAXKMKUTE KHOMKY Bocnp. Bugeo ana npocmoTtpa Buaeoponuka @bro3ep.

& NPEAYMNPEXAEHUE. Bo 13bexaHWe NOpaXKeHUs SNEKTPUUECKUM TOKOM Nepes, HayasioM paboT no
06CNYKMBAHUIO HEOBXOANMO BbIKJIHOUATL MPUHTEP U BBIHUMATL BU/IKY LUHYPA MUTAHMWS U3 PO3ETKM.

& NPEAYNMPEXAEHUE. YTobbl He 06Keubcs, He 3ameHsTe $blo3ep cpasly Nocsie OKOHYaHUSA neuatu. B
npouecce paboTbl Pblo3ep CUILHO HArPEBAETCA.

1. OTKOYMTE NUTAHUE NPUHTEPA.

2. [pexpae yem NpoaoIKUTL, NogoxanTe 30 MUHYT.

00:30:00
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3. BblHbTe bymary 13 n10TKA 1 ¥ 3GKPOMTE NOTOK.
4,  OTkpoWTe npasyto ABepLY, NPUNOAHAB ee 3aLenKy.

5. B3sBwwMchb 3a obe PYYKHN YCTAHOBNE€HHOT O ¢bl03ep(], BbITAHUTE €ero.

6. PacnakyiTte HoBbIM dblo3ep.
7. B3aBlMcb 30 06e pyyku dblo3epa, BCTABLTE €ro B NpUHTEP.
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06cnyxuBaHUE

8. 3akpoiTe npasyio ABepuy.

9. BknwouuTe NpuHTEp.

3ameHa Habopa ana obcnyKMBaHUA

KOFﬂ,Cl Tpe6yeTc;| 3aMeHa H060p0 anAa OGCHy)KMBClHMFI, HA NaHesn ynpasjieHnA BbIBOAUTCA
cooTBETCTBYyHOLLEE COO6LU,GHI/Ie.

MpumeyaHue. You can watch a video at the printer that shows the removal procedure. Boibepute
MpuHTep > Cuct. cpeactBa> Mouck U ycTp. Heucnp. > YcTtpaHeHne Henonagok > MoeTopsAowmecs
NATHA WK JIMHUK W HAXKMKUTE KHOMKY Bocnp. Bugeo ans npocmoTtpa Buaeoponuka Habop ons
06CNyIKUBAHUA.

A\ NPEAYNPEXAEHWUE. Bo M36eKaHWe NOPAKEHHS SNEKTPUUECKUM TOKOM Mepez, Havaaom paboT no
06CNYKMBAHUIO HEODXOANMO BbIKIHOUATL MPUHTEP U BBIHUMATL BU/IKY LUHYPA MUTAHKWSA U3 PO3ETKM.

1. OTKOUMTE NUTAHUE NPUHTEPA.
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A\ MPEAYNPEXAEHUE. HekoTopble AeTanM MOTyT 6biTb ropsunMu. Npexae yem NpoaosiK1Tb,
nogoxaunte 30 MUHYT, NOKA NPUHTEP OCTbIHET.

00:30:00

2. BblHbTe nOTOK 2 M3 NpuHTepa.

3. 3ameHuTe POSIMKK NoAAaYM B MPUHTEpE:
a. BpawaiTe ponuk noaaum Ao nossneHua pukcatopa.
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[MpumeuaHve. POIMKKM pacrnosnox)eHbl B 0TCEKe NOTKA A4J1A ByMaru Ha paccTossHUKU NPUBAN3UTENBHO
165 mm (6,5 grorima) oT IMUEBOM NAHENW NPUHTEPA.

b. BbITAHYB dUKCATOP POJSIMKA NOAAYM U3 KAHABKH HA OCH, BbIABUHBLTE POJIMK Briepes,.

|

¢.  AHanornyHbiM 06pA30M CHUMWTE BTOPOHM POMK NOAAYH.
d. CoBMecTuTe OTBEPCTME HOBOIO POJIMKA C OCbIO OCHOBAHMUS.

1
e. HapeHbTe ponvK Nofaum HA OCb M 30ABUHbTE €0 TAK, YTO6bI BBICTYMbI NMOIHOCTHIO BOLLW B
yrny6nexus, a GUKCaTop B KAOHABKY.
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f.  AHanorvyHbiM 06pa30OM YCTAHOBUTE BTOPOM POJIMK NOLAYM.
4.  3ameHuWTe KAPTPUAXK POJIMKOB MOAAYM B JIOTKE:

MprmeuaHme. NopAfoK 3aMeHbl KAPTPUAKA POSIMKOB NOAAYM B CTAHAAPTHOM WU AOMOSHUTENbHbIX
NOTKOX OAUHAKOBA.

a. OTKpOl‘/‘ITe KPbILWKY OTCEKA POJIMKOB NoAAa4H, CABUHYB €€ BJ1IEBO.

b.

C.
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d. PacnakyiTe HOBbIV KAPTPUAXK POSIMKOB MOAAYM.
e. OTKpOMTe KpbILWKY OTCEKA POJIMKOB NOAAYM, CABMHYB €€ BJIEBO.

f.  BcTaBbTe B OTBEPCTHE NIOTKA CHAYASIA NEPEAHIO 0Cb KAPTPUAKA POSIMKOB NOAAYUH, 3ATEM
3a4H1010.

g. [oBepHUTE KAPTPUAXK POSIMKOB NOAAYM BEBO, UTOObLI 3APUKCUPOBATL ETO.

h.  3akpoiTe KpbILWKY OTCEKA POJIMKOB NMOLAYH, CAABUHYB €€ BMPABO.
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O6cnyxuBaHUe

5.

6.

100

BcTaBbTe 10TOK B NnpuHTEp.

3ameHuWTe PONKK nepeHoca:
a. OTkpo#Te Npasyto ABepLy, MPUMOAHAB ee 3aLLesKy.

b. OcBoboaute aBa GUKCATOPA HA POJSIMKE NEPEHOCA U U3BJIEKUTE €ro, NOJHSB BBEPX.
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06cnyxuBaHUE

c.  BssBwwch 3a ABa PpuKcaTopa c 06enx CTOPOH HOBOTO POJSIMKA NEPEHOCA, COBMECTUTE CTPESKH
HO POJIKE CO CTPESIKAMM HA MPUHTEpE.

d. BcTaBbTe NepeaHo YACTb POIMKA A0 PUKCALMK.

7.  CHumHTe pemeHb NepeHoca:
a. OTkpo#Te NepefHiolo ABEpPLY NPUHTEpPA.

b. OtkporiTe aBepuy oTceKa 610K0B GOPMUPOBAHWUA U30O6PAXKEHHMSA, MOBEPHYB ABA GUKCATOPA.
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O6cnyxuBaHUe

c. Bo3bmuTech 3a pyuKy cnepeau pemMHs nepeHoca.

d.

,i\_ BHUMAHME! He 6eputech 3a 4acCTH, MOKA3AHHbIE HO PUCYHKE. DTO MOXKET NPUBECTHU K YXYALIEHUIO
KayecTBa NeyaTw.
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06cnyxuBaHUE

8. lMoapuraiTe A3bI4OK 30/I0TUCTO-KENTOrO LIBETA BNepeA-Ha3az nATb pas.

9.

10. CHumuHTe 3aWmTY.
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O6cnyxuBaHUe

11. 3ameHuTe peMeHb NepeHoca:
a. Bo3bmuTeCh 30 pyUKM CBEPXY PEMHSA NepeHoca.

& BHUMAHME! He 6eputech 3a 4aCTH, MOKA3AHHbIE HO PUCYHKE. DTO MOXKET MPUBECTHU K YXYALIEHUIO
KayecTBa Neyarw.

b. CoBMecTUTe CTPEe/IKM Ha pEMHE NepeHOCa CO CTPEIKAMM HA NPUHTEpe.
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06cnyxuBaHUE

C.  3aABWHbTE peMeHb NEPEHOCA B MPUHTEP TAK, YTOObI HE CTAI0 BUAHO JIMHUM.

d. OnyctuTte pyykmu.

e. 3aABMHbTE peMeHb NepeHoca Ao yrnopa.
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O6cnyxuBaHUe

13. 3akpoiTe aBepLy oTCceKa 610K0B GOPMUPOBAHKSA M30OPAXKEHUS, MOBEPHYB ABA PUKcaTopd.

15. 3akpo#nTe npaByto asepuy.

Mpumeyarve. Ecnv npasas ABepua He 30KPbIBAETCS, 3HAYMT peMeHb NEePEHOCA BCTABJIEH He A0
KOHLQ.

16. BkniounTe nNpuHTEp.
17. O6HynuTe cueTumK Habopa Ana 06CNYKUBAHUSA:
a. Ha naHenu ynpaeneHus HaOXMWUTe KHomMKy MpuHTep.
b. Mepengute Ha BkNaaky CUCT. cpeacTBa M HAXMKUTE KHOMKY HacTpoiika.
¢. Haxmute CpeactBa 06CnyKUBAHUA.
d. Bbibepute CopocuTb cueTunku HFSI > Habop ans ob6cnyxusanus > C6pPOCUTbL CHETUMK.
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06cnyxuBaHUE

CyeTumku yyeTa U1 ncrnoJib30BaHUA

CueTtumkm ydyeTa 1 UCnoJib30BAHUA OTO6pC1)KC1I'0TCH HA 3KpaHe «CyeTunkm ydeTa» Mcxopa s
0T06pCl)KCleMOFO KO/IM4yecCTBa OTNevYaTKoB NpPorU3BOguUTCA onnara.

1.
2.

Ha naHenu ynpaBneHnAa HaAXXMUTE KHOMKY anHTep.

Ha BKNnagke «MHq)OpMClLI,VIFI» HaKMKUTEe CUETUUKHU ydeTta anda npocMoTpa OCHOBHbIX CHETYHMKOB
OTNEeYAaTKOB:

L] U.BeTHbIX OTNeYATKOB: Y1C/10 CTpClHVILl,, pClCI'Iel-IClTClHHbIX B LLIBETHOM pe)Knme.
e  UYepHo-6enbix OTNEUATKOB: YMC/I0 CTPAHML, PACMIEYATAHHbIX B YePHO-6€/10M pexume,
e  Bcero otneuaTtkoB: obLee YMCI0 LUBETHbLIX U YEPHO-6€/IbIX OTNEYATKOB.

[Mpumeuarve. CTpaHULEN HA3bIBAETCSA OAHA CTOPOHA JIUCTA BymMary, KOTOPYHO MOXHO NeYaTaTb Ha
OZHOM Unu aByx cTopoHax. CTpaHMLa, pacneyataHHas Ha ABYX CTOPOHAX, CYUTAETCA 3d ABA
oTrneyarka.

Ana npocmoTpa Noapo6HOM MHPOPMALIMKM MO UCNOb3OBAHMIO HAXKMHUTE KHOMKY CUETUMKHK
MCNOJIb30BAHMSA.
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O6cnyxuBaHUe

30Ka3 pacxoAHbIX MATEPUASIOB

B 3TOM pasgene paccMaTpuBatoTCA CeaytoLme BOnpochl.

e  ONPENENEHNE CEPUMHOTO HOMEPQ ceonvernreesnresseessrssssessssesssssssssesssssssssssssssssesssssssssssssssssssssssessssessssssssssssssssssassasssasess 108
®  POCXOJHDIE MOTEPUAID «.ceueerverrveresesseesssssassssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnsssssssssnsssnsssssssssssssssssssssssssssssssens 108
e  PerynsipHo 3ameHsieMble KOMMOHEHTbI 109
e  3ameHsieMble NoJsib30BATENEM BI0KM 109
e Korpa 3aKasbiBaTbh pacxoHble MaTepUaIbl 109
e [IpoCMOTpP COCTOSIHWA PACXOAHBIX MATEPHUAIOB MPUHTEP «.eonvernreesnerssresssssssssssssssesssssssssssssssssssssssssssssseses 110
e YTUAM3AUMA PACXOAHbIX MATEPUAIOB 110

OnpeaeneHve cepMMHOro Homepa

lMpu 3aKase pacxofHbIX MATEPUASIOB UM 06PALLEHNH B KOMMNAHWIO Xerox TpebyeTcs coobwuTb
CepuiHbIM HoMep NpuHTepd. CepuiHbIM HOMep YKa3aH C NPABOM CTOPOHbI PAMbI NPUHTEPA Noj,
¢dbto3epom, 3a npasor asepuei. CepriiHbIi HOMEP TAKXKE MOXHO Y3HATb HA NAHENW YNPABIEHHS.

lMpocmoTp cepuitHOro HoMepa C NaHeNU yNpasfeHKUs:
1. Ha nanenu ynpasneHua HaxxmuTe KHonky MpuHTep.
2. Ha Bknapke «MHbopmauus» HaxxMuTe KHonky CBeaeHUs o NnpuHTepe.

Ha Bknagke «06wwme» oTobpaxkaeTcs HAMMEHOBAHWE MOJESHU, CEPUMHBIM HOMep, Bepcus U AaTad
AKTUBALMM.

PacxoaHble matepuabl

PacxoaHbIMK CYUMTAIOTCS TAKME MATEPHUAIIbI, 3AMAC KOTOPbIX UCHEPMbIBAETCA B NpoLiecce paboTbl
npuHTepa. K pacxogHbiM Matepuanam AJisi AAHHOTO NPUHTEPA OTHOCUTCA Crefytollee:

e DuUpMeHHble ToHep-KapTpUaKK Xerox® (rony6o#, NypnypHbIi, }enTbli U YepHbIA)
e KapTpuax cumearens, eciv yCTAHOBAEH AONONHUTENbHbIN GUHMLLIEP

[Mpumeuarmve. K KaxaoMy pacxofHOMY MATEPUAY NPUIIArAeTCsl MHCTPYKLMS MO YCTAHOBKE.

& BHUMAHME! Mcnonb3oBaHKe KAKOro-n1Mbo Apyroro ToHepd, Kpome GUpMeHHbIX TOHEpPOB Xerox®,
MOXEeT HEraTWUBHO MOBMUATL HA KAYECTBO MEYATH U HOAEKHOCTb NPUHTEPA. ITU TOHepbI
pa3paboTaHbl CneuuanbHO A AAHHOTO NPUHTEPd M U3rOTABMBAKOTCA NPU CTPOrOM coboAeHUH
BCEX NpoLeayp KOHTPOS KaYeCTBA KOMMAHWKU Xerox.
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06cnyxuBaHUE

PerynﬂpHo 3amMeHAeMbleé KOMMNOHEHTbI

PerynsipHo 3ameHsieMble KOMMOHEHTbI — 3TO AeTA/IM NPUHTEPd, UMEIOLLME OFPAHUYEHHDIA CPOK CNYKObI 1
Tpebylowne neproandeckoi 3ameHbl. OHY MOTYT NPeACTABNATL COBOM OTAENbHbIE KOMMOHEHTbI UK

H0.60pbl. PerynﬂpHo 30MeHsIeMble KOMMOHEHTbI 06bIUHO 3AMEHSAITCA NOIb30BATENSIMU.

[Mpumeuarve. K Kaxaomy perynsipHo 3aMeHseMOMY PACXOLHOMY KOMMOHEHTY NpUIaraeTcs
MHCTPYKLMA NO YCTAHOBKE.

B uncno perynsipHo 3ameHseMbIX KOMMOHEHTOB AJIA MPUHTEPA BXOAAT CefyoLLMe:
e Bnokun popmrpoBaHUa M306pakeHUs (rony6om, NyprypHbIN, KeNTbIh U YepHbIA)
e  C6opHWK 0TX0A0B

3amMmeHAeMble nosib3oBartesiem 6/10KU

3ameHsAeMble Nonb3oBaTesieM 6710KK — 3TO MOAYHU NMPUHTEPA, KOTOPbIE MOXHO 30MeHATb
CAMOCTOATE/IbHO, He 06paLLAACH B CEPBUCHYIO CNY6Y. HOMUHAIBHBIVM CPOK CNyXObl AAHHBIX 610K
6osnblue, YeM y perynsipHo 3aMeHsAeMbIX MOAYEN.

[Mpumeuarve. K Kaxaomy 3ameHsieMomMy nosb3oBarenem 610Ky NpuaaraeTcst MHCTPYKLMS Mo
YCTAHOBKe.

K 3ameHsAembIM nosib3oBartesieM 6J10KAM A5l AAHHOTO NMPUHTEPA OTHOCKUTCS cneaytoLlee:
e  Oblozep Ha 110 B ans npuHTepa Phaser 6700
e  Obtozep Ha 220 B gns npuHTepa Phaser 6700

e Habop ansa 06CyHUBAHMSA, BK/KOUASA KOMIMIEKT POJIMKOB MOAAYH, POJTIMK NEePeHoCca U peMeHb
nepeHoca

e  Ponuk nogauu notka 1

Koraa 3aka3biBatb pacxogHble Matepuansl

KOFﬂ,Cl pecypcC pacxogHbliX MATeEPHUAIOB 3AKAHYMBAETCA, HA NAHENN ynpaB/eHNA BbIBOOUTCA

npepynpexaeHve. Ybenmrech, UTo y BAC €CTb MATEPUAN A5 3amMeHbl. YTobbl M36exaTb nepepbiBOB B
neyarTu, HYXKHO 30aKA3blBATb MATEPUAJIbI 3ApaHee, noc1e NoABNEHNA NepBOro npeaynpexaeHusa. KOFD,(J
TpebyeTca 3aMeHa PACXOAHOM0 MATEPUAUIA, HO NAHENW YNPAB/IEHWA NOABNAETCS coobuieHne 06 owmnbKe.

Utobbl 3aKa3aTb pacxoaHblie marepuanol, O6pClTl4Ter K MeCTHOMY TOprosomy npeacraBuTento Uin

nocetuTe Beb-cant www.xerox.com/office/6700supplies .
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O6cnyxuBaHUe

A

BHUMAHME! He pekomeHayeTCca MCNONb30BATL PACXOAHbIE MATEPUAIIbI APYTMX NPOU3BOAUTENEN.
FapaHTus Xerox®, cornaiuenue o6 o6cnywmsanmm 1 Total Satisfaction Guarantee (O6Lwas rapaHTs

KA4ecTBa) He pacrnpoCTPAHSIOTCA HA MNOJIOMKH, HEMPABWIIbHYO paboTy MM CHUXEHWE KayecTBd,
BbI3BAHHbIE UCMOJIb30BAHWEM PACXOAHbBIX MATEPUA/IOB APYTMX NMPOU3BOAUTENEN UK
MCMONb30BAHMEM PACXOLHbIX MATEPUAIOB XErox , He NpeAHA3HAYEHHbIX 15 3TOro NpUHTEpd.

lapaHTHa Total Satisfaction Guarantee (O6was rapaHTus kavectsa) feicteyeT B CLLUA n Kanage. B

APYr1X PerMoHax MoryT IeNCTBOBATb [ipYrUe rapaHTUiHbIE YCIOBUA. 3a AOMNOHUTEIbHOM
nHdpopmMaL e obpaLlanTecs B MECTHOE NPeACTUBUTENIbCTBO KOMMAHWM Xerox.

npOCMOTp COCTOAHHNA PACXOOHbIX MATEPHANIOB NPUHTEPQ

CocTosiHMe pacxoAHbIX MATEPHUANIOB NPUHTEPA MOXKHO NPOBEPUTHL B Nitoboe Bpemsi.

1.

MepeWTH Ha BKNOAKY «Pacx. matep.» MOXHO OfHUM W3 CleflytoLnX cCnocoboB:
e Ha naHenn ynpasneHWsa HaxaTb KHOMKY MNpUHTEp 1 OTKpbITb BKAAAKY Pacx. martep.
e  Haxatb 3Ha4ok C, M, Y nnu K B HUXKHEM MpaBOM yrny OCHOBHOIO 3KpAHA.

[na npocmoTpa cBeaeHMI 0 TOHep-KAPTPUAKE, BKoUAA HOMep A4 3akasa, Haxmute C, M, Y unu
K.

[Ans Bo3BpaTa Ha BKAAAKY «Pacx. matep.» HaxMHUTe 3aKpbITb.

[na npocmoTpa cBegeHul o dbrosepe, cbopHUKe 0TX0A0B, 610Kax GOPMUPOBAHMA M306paXKEHHS,
Habope Ans 06CNYHUBAHUA UK KAPTPUANKE CLUMBATENA HAKMUTE KHONKY Jipyrue pacxogHble
MaTtepuabl. C MOMOLLbIO CTPESIKW BBEPX MW BHU3 BblbepuTe B CNIUCKE AdHHbIE A/1s MPOCMOTPA.

[lns Bo3BpaTa Ha 3KpaH «Jlpyrve pacxofHble MaTepuasibi» HAXKMUTE KHonky Hasag,.

YTtobbl pacneyaraTb CTPAHULY UCMONb30BAHWS MATEPUAIIOB, HAXKMUTE 3HaYoK MeuaTtb 1 Bbibepute
Ucnonb3oBaHMe maTepuaos.

[lna BO3BpATA K OCHOBHOMY 3KPAHY HAXXMMUTE KHOMKY OCHOBHbIE peXXHMbl.

yTVI)'IM3ClLI,I/IFI pacxoaHbiX MATEPHUAJIOB

NHbOPMALMIO O MPOrPAMMAX YTUAM3ALMK PACXOAHbIX MaTepuanos Xerox® cMm. Ha Be6-caiiTe
www.xerox.com/gwa .

K pacxogHbiM MaTepuanam NpuaararoTca NpeaoniadeHHble STUKETKW AN BO3BpaTd. Mcnonb3ymTte mx
[J151 BO3BPATA MUCMOJIb30BAHHBIX KOMMOHEHTOB HO BTOPUYHYIO NepepaboTKy, MOMECTUB MX B
NepBOHAYA/IbHbIE KOPOOKHM.
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06cnyxuBaHUE

[lepemelleHne NpUHTEPA

o Obsa3aTenbHO cneayeT BbIK/HOUATE NPUHTEP W KAATH 3aBEpLIEHUS ero paboThbl.

e OTCoefuHWTE LIHYP NUTAHUS HA 3a4HEN NAHeNW NpUHTepa.

e  [IpuHTEp BOMKHBI NOAHUMATH HE MEHEE TPEX YeJIOBEK.

e [lpy nogbeme NpuHTEpA BO3bMUTECH 3d HEFO B TEX MECTAX, YTO YKA3AHbI HO PUCYHKE.
e  [lep»uTe NpUHTEP POBHO, YTO6bLI HE AONYCTUTbL NPOCLINATL TOHEP.

/Y BHUMAHME! HecobniopeHne HOANEKALMX NPABMI NOBTOPHOM YNAKOBKHM NPUHTEPA ANA
TPAHCMOPTUPOBKK MOXKET NPUBECTH K NOBPEXAEHUAM NPUHTEPA, HA KOTOPbIE He pacnpOCTPAHAKTCA
rAaPaHTHIHbIE 06A3aTeNbCTBA Xerox®, cornalleHuii no TeXHUYECKoMy 06CnyuBaHuio 1 Total
Satisfaction Guarantee (06was rapaHTus KavecTa). Ha noBpexkaeHust NpuUHTEPA, BbI3BAHHbIE €r0
HenpaBWbHbIM NepeMeLLeHUeM, He PaCNpOCTPAHAETCA eNCTBME FAPaHTUIHBIX 06A3aTeNnbCTB
Xerox®, cornaLueHmit no TexHUYeCKoMy 06Cy)MuBAHMIO U rapanTum Total Satisfaction Guarantee
(Obwas rapaHTHsa KadyecTea).

/A BHMMAHMUE! Total Satisfaction Guarantee (O6wasn rapaHTus kadectsa) Xerox® aeictayeT 8 CLUA 1
KaHape. B apyrmMx pervoHax MoryT AerNCTBOBATb ApYrMe rapaHTUiHbIE YCI0BUA. 3 AOMONHUTENIbHOM
nHdpopmMaLmer obpalanTecb B MECTHOE MPeaCcTABUTENbCTBO KOMMAHUKN Xerox.
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[loncK n ycTp. Heuncnp.

B aTom pasgene pacCMaTpmBardTCA cneagyrouime sonpochol.

e  General Troubleshooting 114
e  Paper Jams 118
e  Print-Quality Problems 134
e [lonyyeHue cNpaBKu 139
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Mowck u ycTp. Hemcnp.

General Troubleshooting

B 5ToMm pasgene paccmaTpuBaroTcs ciesytolue BONpochl.

®  Printer DOES NOt TUM O ..ottt ssessasssass bbb s ssss s ssss s sass s bbb sens 114
o Printer Resets or TUINS Off FIEQUENTLY .......ovueveeeeeee ettt ssess s sasssa s sas s sae s ssassssenees 114
®  Printing TAKES TOO LONG.u.uiiirierireieiseiseeseissssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssasssssssssssssssssssssssssans 115
e  Document Prints From Wrong Tray ................. OO TP OT OO 115
®  DOCUMENT FAILS 1O PriNTcceeeeeeeeeeeeeese sttt sas bbb ssss bbb sss bbb 116
®  [IPUHTEP USLAET HEOODIUHBIM LLYM ...coonreerreereessreessssssssssssssssssssesssssssesssssssssssssssssssssssssssessssssssssssssssssssssssssssessaess 116
e Automatic 2-Sided Printing ProbBlEMIS ...ttt sssssssssssssssssssssssssssssssssssssans 116
®  Date aNd TimMeE Gre INCOMECT..... vttt tassesssessss et essessase s s ssssssssesassassssas et sasesessessssessnsess 117

B naHHOM paspene npuBeseHbl NpoLesypbl MOUMCKA U YCTPAHEHUs1 HencnpasHocTel. HekoTopble
npobaembl MOXKHO YCTPAHWUTDL, MPOCTO Nepe3arpy3vs NPUHTEP.

Printer Does Not Turn On

Probable Causes Solutions

The power cord is not correctly plugged into | Turn off the printer, and plug the power cord securely into the
the outlet. outlet.

Something is wrong with the outlet e Plug another electrical appliance into the outlet and see if it
connected to the printer. operates properly.

e Try adifferent outlet.

The power switch is not turned on. Turn on the switch.

The printer is connected to an outlet with a Use a power source with the specifications listed in Electrical
voltage or frequency that does not match the | Specifications Ha ctp. 151.
printer specifications.

A\ BHUMAHMUE! Plug the three-wire cord (with grounding prong) directly into a grounded AC outlet.
CnepyeT UCNoONb30BATb TOJIbKO YANMHUTENM, PACCHUTAHHbIE HA paboyee HaNpAXeHWe NPUHTEpPA.

Printer Resets or Turns Off Frequently

Probable Causes Solutions

The power cord is not correctly plugged into | Turn off the printer, confirm that the power cord is correctly plugged
the outlet. into the printer and the outlet, then turn on the printer.
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Mowuck u ycTp. Hemcnp.

A system error occurred.

Contact your Xerox® service representative with the error code and
message. Check the control panel fault history. For details, see
Viewing Error Messages on the Control Panel Ha cTp. 140.

Printing Takes Too Long

Probable Causes

The printer is set to a slower printing mode,

for example, for printing on heavyweight
paper or transparencies.

Solutions

It takes more time to print on certain types of special media. Make
sure that the paper type is set properly in the driver and at the
printer control panel.

The printer is in Energy Saver mode.

Wait. It takes time for printing to start when the printer is coming
out of Energy Saver mode.

The way the printer was installed on the
network could be an issue.

Determine if a print spooler or a computer sharing the printer is
buffering all print jobs and then spooling them to the printer.
Spooling can slow print speeds. To test the speed of the printer,
print some Information pages such as the Office Demo Page. If the
page prints at the rated speed of the printer, you could have a
network or printer installation issue.

The job is complex.

Wait. No action needed.

The print-quality mode in the driver is set to
Photo.

Change the print-quality mode in the print driver to Standard.

The printer quality is set to Photo and the
printer is being used for complex, 2-sided
print jobs.

Increase memory size to 2 GB RAM .

Document Prints From Wrong Tray

Probable Causes

Application and print driver have conflicting
tray selections.

Solutions

=Y

. Check the tray selected in the print driver.

2. Go to the page setup or printer settings of the application from
which you are printing.

3. Set the paper source to match the tray selected in the print

driver or set the paper source to Automatically Select.

Mpumeuarue. Set the paper source tray selection to Auto Selection
Enabled to have the print driver select the tray.

Phaser 6700 Color Printer
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Mowck u ycTp. Hemcnp.

Document Fails to Print

Probable Causes Solutions

Selected tray has wrong paper size installed. | To view the Job Status for a failed print on the touch screen:
1. Ha nanenu ynpaeneHua Haxkmute KHonky MpuHTtep.

2.
3. Find the failed print job in the list.
4

. Note the status of the failed print job, such as Held: Resources
Required.

5. Touch to select the print job for more details, then touch Job
Details.

6. Note the Tray number listed under Resources and the status of
the selected tray.

7. Load the proper size paper in the tray or select another tray.

Application and print driver have conflicting | See Document Prints from Wrong Tray.
tray selections.

[puHTEp N3aaeT HeObbIYHbIV LYM

Bo3moXKHble NPHUUHHDI PeweHun

OLI,VIH M3 JIOTKOB YCTAHOBJIEH HEMPABKJIbHO. OTKpOVITe 1 CHOBQ 3GKPOHTG JIOTOK, U3 KOTOPOIO BbINOJIHAETCA
neyarb.

BHyTpH NnpuHTEpa MmeeTca nomexa. BbikntounTe NpuHTEp KM ycTpaHuTe nomexy. Ecnm npobnemy
YCTPAHUTBL He yadeTcs, 0bpaTuTech B MECTHOE CEPBUCHOE
npeacTaBUTENbCTBO Xerox®.

Automatic 2-Sided Printing Problems

Probable Causes Solutions

Unsupported or incorrect media. Make sure that you are using the correct paper. For details, see Supported
Paper Sizes and Weights for Automatic 2-Sided Printing Ha cTp. 39.
Envelopes, labels, transparencies, reloaded paper, and paper heavier than
163 g/m2 cannot be used for 2-sided printing.

Incorrect setting. In the print driver Properties, select 2-Sided Print on the Paper/Output
tab.
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Mowuck u ycTp. Hemcnp.

Date and Time are Incorrect

Probably Cause Solution

The time zone, date, or time is set incorrectly. 1. Ha nanenu ynpaeneHusa HaxxmuTe KHomnKy MpuHTep.

2. MNepengute Ha BkNaaKy CUCT. cpeacTBa U HAOXXMUTE
KHoOMKy Hactpotika.

3. Touch General Settings > Date/Time.

4. Change the necessary information:

a. Touch Time Zone, then use the Up and Down
arrows to select your geographic region and time
zone, then touch OK.

b. Touch Date, then use the Left and Right arrows
to select the year, month, and day, then touch OK.

c. Touch Time, then touch Hour or Minutes. Use the
keypad to enter the numbers, touch AM or PM,
then touch OK.
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Paper Jams

B 3TOM pasgene paccMaTpuBatoTCA CeaytoLme BOnpochl.

®  LOCALING PAPEE JAMS...oerierierreesreeesisssesesesssssssssssssssssssssssssssssssssssssssssssssssessssessssessssssssssssssssssessssesssssssssssssessssasssssssssess 118
®  CleArNG PAPEE JAMS ..ottt easse s essssesssse s ssss bbbt ssss st a s s sssss s sssassasesen 120
®  MiINIMIZING PAPET JAMIS..cuoeiieeerieirsisisessisssessssssassesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssasasssssssssssssssssssns 129
e YCTpaHeHMWE 3aCTPEBAHUN BYMATM ....oeeeenreerrrerrerersenesenssenns 131
o (Clearing STAPLE JAMS ...t sesssssessssssssssssssssnns et 133

Locating Paper Jams

The following illustration shows where paper jams can occur along the print media path in the basic
printer configuration.

Z

Z

7

\/
5
E

1. Fuser 4. Tray 1
2. Right Side Door 5. Tray 2

3. Duplex Unit
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The following illustration shows where paper jams can occur along the print media path in the printer
configured with the optional trays and finisher.

\
1. Fuser 5. Optional 550-Sheet Feeders (Trays 3 and 4)
2. Right Side Door 6. Optional 110-Sheet Feeder (Trays 5 and 6)
3. Duplex Unit 7. Horizontal Transport Unit
4. Tray 1 8. Finisher

/1 BHUMAHME! Do not attempt to clear any paper jams using tools or instruments. This can
permanently damage the printer.
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Clearing Paper Jams

B 3TOM pasaene paccMaTpuBatOTCA ClefytoLMe BONpochl.

Clearing Paper Jams at Tray T ....cceneennreenneeenseesssesesssessssesnssenne et 120
Clearing Paper Jams at Tray 2 ......creonnreenseesnssessssesssessssssssenns et 122
Clearing Paper Jams at the DUPIEX UNit.....oriorienrienrirerissssessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnssens 125
Clearing Paper JAMS Ot the FUSET ...ttt sssssssessss e s sssssssssssssssssssssassssesens 126
Clearing Paper Jams at the FiNiSher ... e 128
Clearing Paper Jams at the Horizontal Transport Unit et 129

Bo n3bexaHre No1oMOK BCerfa 0CTOPOXHO BbIHUMAMTE 3aCTPABLLYIO0 Bymary, cTapasch He NopBaATh ee.
CrapaiTech BbITACKMBATL Bymary B HanpasaeHUu ee nogauu. JIlobow ocTaBLIMCA B NPUHTEPe 06pbIBOK
MOXET MeLldTb NPOXOXAEHUI0 ByMaru U cTaTb MPUUYMHOW 30CTPEBAHMM. He 3arpy»aiiTe 3acTpsBLyto
6ymary noBTOpPHO.

Clearing Paper Jams at Tray 1

1.

2.

120

lNpumeuaHue. To resolve the error displayed on the control panel you must clear all paper from the
print media path.

Remove any paper from Tray 1.

Close Tray 1.
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3. OTkpoviTe npasyto ABepLy, NPUNOAHAB ee 3aLLeNnKy.

4,

5.

6.
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7. Reinstall the duplex unit.

8. 3akpoiTe npasyto ABepuy.

Clearing Paper Jams at Tray 2

lNpumeuaHue. To resolve the error displayed on the control panel you must clear all paper from the
print media path.

1. OTKpoWTe npasyto ABepLy, NPUNOAHAB ee 3aLleNKy.
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Remove the jammed paper.

Reinstall the duplex unit.
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6. 3akpoKTe NpaByto ABepLy.

7. BbIHbTe NOTOK 2 13 NpUHTEpA.

8. Remove any creased or jammed paper from Tray 2.

9. Reinsert Tray 2 into the printer.
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Clearing Paper Jams at the Duplex Unit

lNprmeuaHme. To resolve the error displayed on the control panel you must clear all paper from the
print media path.

1. OTkpo¥iTe NnpaByto ABEPLY, NPUNOAHSB €€ 3aLLeSIKY.

2.

3.

4.  Reinstall the duplex unit.
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5. 3akpoiTe npasyto aAsepLy.

Clearing Paper Jams at the Fuser

lNprmeuaHue. To resolve the error displayed on the control panel you must clear all paper from the
print media path.

A\ NPEAYNPEXAEHUA.

e  Bo u3beaHre NopaxKeHUs 3N1EKTPUUECKUM TOKOM Nepej HadasaoM paboT no
06CNYKUBAHUIO HEOBXOAMMO BbIKJIHOUATH MPUHTEP W BbIHUMATb BUJIKY LUHYPA NUTAHUSA
M3 PO3eTKMU.

e To avoid burns, do not clear paper jams immediately after printing. The fuser becomes
extremely hot during use.

1. OTkpo¥iTe NnpaByto ABepLY, NPUNOAHSB €€ 3aLLeSKY.

2. Pull out, then press down the tab on the inner cover to hold it open.
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Remove the jammed paper.

3.

Release the inner cover.

4,

3akpomTe Npasyto AsepLy.

5.

127
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Clearing Paper Jams at the Finisher

lNprmeuaHme. To resolve the error displayed on the control panel you must clear all paper from the

print media path.
1. Ensure that the printer is not in operation, and open the front door of the finisher.
Bl
AN 2
2. Rotate the knob clockwise and remove the jammed paper from the paper exit.
"
N =—
VN @ | 15

R ‘

MNpumeuaHue. If the paper jam message remains, repeat this step.

3. 3aKkpoiTe nepeaHioto ABepuy duHULWIEpPA.

Mpumeuanue. If the paper jam message still remains, repeat the entire procedure.
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Clearing Paper Jams at the Horizontal Transport Unit

lNprmeuaHme. To resolve the error displayed on the control panel you must clear all paper from the
print media path.

1. Grasp the handle of the horizontal transport unit and open the cover.

2. Remove the jammed paper.

3. Close the cover of the horizontal transport unit.

Minimizing Paper Jams

The printer is designed to function with minimal paper jams using Xerox® supported paper. Other paper
types can cause jams. If supported paper is jamming frequently in one areq, clean that area of the paper

path.

The following can cause paper jams:
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Selecting the incorrect paper type in the print driver.
Using damaged paper.

Using unsupported paper.

Loading paper incorrectly.

Overfilling the tray.

Adjusting the paper guides improperly.

Most jams can be prevented by following a simple set of rules:

[ )

[ )

°

Use only supported paper. For details, see Supported Paper Ha cTp. 36.
Follow proper paper handling and loading techniques.

Always use clean, undamaged paper.

Avoid paper that is curled, torn, moist, creased, or folded.

Fan the paper to separate the sheets before loading it into the tray.
Observe the paper tray fill line; never overfill the tray.

Adjust the paper guides in all trays after inserting the paper. A guide that is not properly adjusted
can cause poor print quality, misfeeds, skewed prints, and printer damage.

After loading the trays, select the correct paper type and size on the control panel.
When printing, select the correct type and size in the print driver.

Store paper in a dry location.

Use only Xerox® paper and transparencies designed for the printer.

Avoid the following:

Polyester coated paper that is specially designed for inkjet printers.

Paper that is folded, wrinkled, or excessively curled.

Loading more than one type, size, or weight of paper in a tray at the same time.
Overfilling the trays.

Allowing the output tray to overfill.

For a detailed list of supported paper, go to www.xerox.com/paper .
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YcTpaHeHue 3acTpeBaHum bymaru

B 3ToM paspene paccmaTpuBatoTCA cieaytoLme Bonpochl.

e  OAHOBPEMEHHAA MOAAUA HECKOIBKUX JIUCTOB .ccucureerreeesesessessssssssasssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssens 131

e  Paper Misfeeds
¢ Label and Envelope Misfeeds
e  Paper Jam Message Stays On

o Duplex Unit JAmMS.....orerrerreereerrierrneiene

OpHoBpeMeHHaA NoAaYa HECKOJIbKUX JIUCTOB

Bo3moXKHble NpUUHHBI

B NOTOK 3arpyXeHo C/IMLLIKOM MHOTO bymaru.

PeweHun

Y6epute yactb bymaru. He 3arpyxaiite bymary Bbille TMHUM
30aNOIHEHUS NIOTKA.

KpomKku bymaru He BbIpOBHEHDI.

M3BnekuTe bymary, BbIPOBHAMTE KPOMKM JIMCTOB U CHOBA 3Arpy3unTe
6ymary B JIOTOK.

Bymara oTcbipena 13-3a NoBbILLIEHHOM
BJIQXKHOCTH.

M3BnekuTe Bymary 13 10TKA U 30MEHUTE ee HOBOM NAYKOM CyXom
6ymaru.

Hakonuncsa 6onbluoi 3apAag ctatnuyeckoro
3J1IeKTpHuyecTea.

e [lonpobyiTe HOBYIO NAYKY bymarw.

e Kpas cTonky npo3padHbixX NIEHOK Nepes 3arpy3Koi B I0TOK
Pa3BOAMTL BEEPOM He CleflyeT.

Mcnonb3oBaHWe HenoaAepKUBaemon bymaru.

o ®
Mcnonb3yiTe Tonbko bymary, paspeLueHHyto Xerox .
JlononHuTenbHble cBeAEHWS CM. B pasgene ogaepxrsaemas
6ymara Ha cTp. 36.

BnaxkHOCTb CnMLWKOM BbiCOKa anst bymaru ¢
MOKpPbITUEM.

MopaBarTe Bymary B yCTPOMCTBO NO OLHOMY JIUCTY.

Paper Misfeeds

Probable Causes

The paper is not correctly positioned in the
tray.

Solutions

¢ Remove the misfed paper and reposition it properly in the tray.
e Ensure that the paper guides in the tray are set correctly.

The paper tray is too full.

Remove some of the paper. Do not load paper past the fill line.

The paper guides are not correctly adjusted
to the media size.

Adjust the paper guides in the tray to match the size of the media.

Warped or wrinkled paper is loaded in the
tray.

Remove the paper, smooth it out, and reload it. If it still misfeeds,
do not use that paper.

The paper is moist from humidity.

Remove the moist paper and replace it with new, dry paper.
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Unsupported paper of the wrong size,
thickness, or type.

Use only Xerox®-approved paper. For details, see Supported Paper
Ha cTp. 36.

The label sheet is facing the wrong way in the
tray.

¢ Load label sheets according to the instructions from the
manufacturer.

e Load labels face down in Tray ???7??22227?

e Load labels face up in Tray 77?7277

Envelopes are loaded incorrectly in Tray 1.

Load the envelopes in Tray 1 with the flaps closed, flap-side up, and
the short edge leading into the printer.

Envelopes are loaded incorrectly in Trays 2-6.

To load envelopes in Trays 2—6:

e Load #10, Monarch, or DL envelopes with the flaps closed, flaps
down, and flaps on the leading edge, toward the left.

e Load C5 envelopes with the flap closed, flap down, and flap
toward the right.

Label and Envelope Misfeeds

Probable Causes Solutions
The label sheet is facing the wrong way in the tray. Load label sheets according to the instructions from the
manufacturer.

e Load labels face down in Tray 1.
e Load labels face up in Tray 2.

Envelopes are loaded incorrectly in Tray 1.

Load the envelopes in Tray 1 with the flaps closed,
flap-side up, and the short edge leading into the printer.

Envelopes are loaded incorrectly in Trays 2.

To load envelopes in Tray 2:

e Load #10, Monarch, or DL envelopes with the flaps
closed, flaps down, and flaps on the leading edge,
toward the left.

e Load C5 envelopes with the flap closed, flap down,
and flap toward the right.

Paper Jam Message Stays On

Bo3moXKHble MPHUYHUHDI

YacTb 3acTpsaBLel bymarv octandch B
npuHTEpe.

PewweHun

Ewe pas npoBepbTe TPAKT NPOXOXAEHWA BymarK U ybeauTech, UTo
BCA 30CTPABLUAA bymaAra BbiTALLEHA.

OTKpbITa OAHA M3 ABEPEL, NPUHTEpPA.

MpoBepbTe ABepLIbI NPUHTEPA. 3AKPOIiTE BCE OTKPbITbIE ABEPLibI.

Mpumeuanue. Check for, and remove, torn pieces of paper in the paper path.
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Duplex Unit Jams

Probable Causes Solutions J
Unsupported paper of the wrong size, e Useonly Xerox®-approved paper. For details, see Supported
thickness, or type. Paper Ha cTp. 36.

¢ Do not use transparencies, envelopes, labels, reloaded paper, or
paper heavier than 163 g/m2 for automatic 2-sided printing.

Paper type is set incorrectly in the print driver. | Make sure that the paper type is set correctly in the driver and the
paper is loaded in the correct tray. For details, see Supported Paper
Sizes and Weights for Automatic 2-Sided Printing Ha cTp. 39.

Paper is loaded in the wrong tray. The paper must be loaded in the correct tray. For details, see
Supported Paper Ha cTp. 36.

Tray is loaded with mixed paper. Load the tray with only one type and size of paper.

Clearing Staple Jams

Do we want a table here, or a procedure? Northwood has a procedure.
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Print-Quality Problems

B 5Tom pasgene paccmaTpusaroTca ciepytolne BONpPOChI.
®  CoNLrolling Print QUOALILY ...ovuereeereeereeseeeeeeesseesssessesssssssssssssssssssssssssssssssssssessssessssssssssssssssssssssssssssssssssssssessssssssssssssess 134
o Solving Print QUALILY PrODLIEMS ..ottt ssss s sssssssssssssssssssssssssssssssssssssssssssssassanssans 136

MpuHTEp pacCYMTAH HA NOCTOSIHHYIO NEYATb C BbICOKUM KayecTBoM. [pu HannumMm npobnem Kayectsa
neyaTv BOCNonb3yrWTecb CBeleHUSIMU, NPUBELEHHbIMW B STOM pasgesne, As UX AUArHOCTUKM U
ycTpaHeHus. [lna nonyyeHUs AONONHUTENbHbIX CBEAEHUI NMOCETUTE CAMT
www.xerox.com/office/6700support .

A\ BHUMAHME! TapaHTus Xerox®, cornauenus o6 obcnyxusarmm u Total Satisfaction Guarantee
(06was rapaHTHa kayecTsa) Xerox® He paCNPOCTPAHAKTCA HA MOBPEXAEHMS, BbI3BAHHbIE
MCNoJIb30BAHMEM HeMNoaAepKUBaemMorn bymarn Unu cneumanbHbix Matepuanos. Total Satisfaction
Guarantee (06wWan rapaHTUa Ka4ecTsa) Xerox® aencteyet B CLUA n Kanapge. B apyrux pervoHax
MOryT 1eMCTBOBATb APYrue rapaHTUiHbIe ycnoBusa. [Ina nonyyeHusa JonoaHUTENbHbIX CBELLEHWUH
CBSAXKMUTECH C MECTHbIM NPELCTABUTENBCTBOM.

MNpumeyanus.

e To enhance print quality, the toner cartridges and imaging units for many models of
equipment are designed to cease functioning at a predetermined point.

e  Grayscale images printed with the composite black setting increment the color pages counter,
because color consumables are used. Composite black is the default setting on most printers.

Controlling Print Quality

Ha KayecTBO roToBbIX KOMW MOTYT BAUATL Pa3/iMuHble GakTopbl. YTo6bl 06ecneunTb NoCTosHHOE U
ONTUMA/IbHOE KAYeCTBO NeYdaTH, He06X0AMMO UCMOb30BATL ByMary, NPeAHA3HAYEHHYIO ANl AAHHOTO
MPUHTEPA, A TAKXKE NPABUILHO HACTPOUTb PEXMM KAUECTBA NeYaTH 1 napameTpbl ugertda. s
O6eCﬂeq6HMﬂ ONTUMANbHOIO KA4yeCcTBA neyaTtu anHTepa cnep,yﬁTe yKCl3(JHI/IFIM, I'IpI/IBep,eHHbIM B 3TOM
pasgene.

Temperature and humidity affect the quality of the printed output. The guaranteed range for optimal
print quality is:15-28°C (59-82°F) and 20-70 % relative humidity.

EyMClFCl U Mmarepuasibl

MpuHTep NoaaepKUBAET UCMONB30BAHME PA3/IMYHBIX TUMNOB ByMaru U Apyrux matepuanos. [ns

JLOCTUIKEHMA HAMNYYLLIEro KaYecTBa NeyaTH U BO U3beXKaHUe 3aCTpeBaHUs ByMAru BbINoAHANTE

YyKA3aHusa, NpMBeieHHbIE B JAHHOM pasjene.

e lMcnonb3ynTe TONLKO NOAAEPKMBAEMbIE Xerox® Tunbl u dopmaTbl bymaru. lononHUTeNbHbIE
cBefileHua cm. B pasgene [Nogaepxmeaeman bymara Ha cTp. 36.

e Mcnonb3yiTe TONBKO CyXylo, HEMOBPEXAEHHYO Bymary.
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/1 BHUMAHME! HekoTopble Tnbl 6ymMark 1 Apyrix MAarepuanos MOryT 06yc/IaBAMBATE HU3KOE
Ka4eCTBO NeyaTH, YacTble 3aCTPEBAHMA U ACXKe NONOMKM NPUHTEPA. 3anpeLyaeTcs UCMoJib30BaTb:
e rpybyto unu nopucTyto bymary;
e  Bymary ans CTpymHOM neyaTw;
e [niAHUeBYyl0 bymary unun bymary ¢ noKpbITHEM, He MPeAHA3HAYEHHYIO 418 Na3epHbIX
NPUHTEPOB;
e  6ymary, Ha KOTOPOK BbIMOJIHANOCH GOTOKONUPOBAHME;
e CMATYIO WK CNIOXKeHHYo bymary;
e  bywmary c Bblpesamu uav neppopaumen;
e cuwwuTylo bymary;

L KOHBEPTbI C OKOLWKAMH, METANNJTUHECKUMU 3AKUMAMMU, H60OKOBbIMWU CTbIKAMMU U KNEWNKUMMU
YYACTKAMM, 30KPbITbIMKX 3ALWLNTHBIMKU NOJTOCKAMM;

®  KOHBEpPTbl C MArKOM HOOMBKOW;
®  JIACTUKOBbIE MATEPHUAJIbI.

e YbenuTtecb, 4To TMN Bymarw, BbIOPAHHBIN B AparBepe NeyaTu, COOTBETCTBYET TUMy bymaru, Ha
KOTOPOM BbINOJIHAETCA NeYaTb.

e  Ecnun bymara oAHOro TMNA 3Arpy}KeHa B HECKOJIbKO JIOTKOB, ybeuTech B TOM, UTO B ipanBepe
neuarty BbI6pPAH NOAXOAALMIA NIOTOK.

e  /lnA onTMMANbHOIO KayecTBd NeYaTv HeobxoaMmo obecneunTb Hagexdallee XxpaHeH1e bymaru v
martepuanos. lononHWTesbHble CBeAeHWs CM. B pasgese MHCTPYKLMK Mo XpaHeH o bymaru Ha cTp.
37.

Print-Quality Modes

Select the correct print-quality setting for your print job from the print driver. For instructions on setting
the print-quality, see Selecting Printing Options. To control the print-quality:

e  Ensure that the print quality is set to the correct mode. For example, if the image does not appear
as vivid and sharp as you expect, set the print quality to Photo. The default setting is Standard.

e  Use the print-quality settings in the print driver to control print quality. If the print quality is not
suitable, adjust the print-quality setting to a higher level.

e Use only Xerox®-approved paper. For details, see Supported Paper Ha ctp. 36.
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Solving Print Quality Problems

B 3ToM paspene paccmaTpuBatoTcsA cieaytome Bonpochl.

Use the following table to find specific solutions to print-quality problems:

Smears, S

Dark or lig
output.

our

. Run the Fuser Cleaning procedure: At the control panel, select Printer

> Tools > Troubleshooting > Resolve Problems > Smears, Smudges
& Streaks, then run the cleaning procedure. Several blank pages feed
through the printer to remove toner accumulated on the fuser.

If the problem persists, print the Test Pages to help determine which
component is causing the image quality problem.

If the defect occurs only in one color, replace the corresponding
imaging unit.

If the defect occurs in all colors and is visible on all the Test Pages,
replace the fuser.

Repeating
Spot or ling
on the prin

c

SRVIVIVI(VIVI{ME=VIFI(V]]

intervals

To identify the source of repeating defects:
1.

. A page prints with instructions on how to identify the part

Print the Repeating Defect Page to identify the part of the printer
causing the problem: At the control panel, select Printer > Tools >
Troubleshooting > Resolve Problems > Repeating Spots or Lines, then
print the page.

responsible for the repeating spots or lines.

Replace the printer part identified by the Repeating Defects Page to
correct the problem.

[NprmeuaHue. Select the video menu to view a detailed
video for identifying the part causing the repeating defect.

Colors Loo
Colors are

VA

wrong.

. Verify that the printer is on a solid, level, and flat surface.

Perform the Color Registration procedure: At the control panel,
select Printer > Tools > Troubleshooting > Resolve Problems >
Colors Align Incorrectly, then perform the Register Color procedure.
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Problem Solution

Colors Loo ‘— 1. Verify that the printer is on a solid, level, and flat surface.

Colors are - pwrong. |2. Perform the Calibrate Color procedure. At the control panel, select
L ) Printer > Tools > Troubleshooting > Resolve Problems > Colors
Look Wrong, then perform the Calibrate Color procedure.

Colors Too 1. Verify that the paper you are using is the correct type for the printer

The print g light, and is properly loaded. For information on supported paper types

missing, or] bggy. and weights, at the control panel, select Printer > Print Reference
Materials > Paper Tips. Press the Print button to print the Paper Tips
embedded pages.

2. Verify the paper loaded in the tray matches the paper type selected
at the control panel and in the print driver.

3. Print the Graphics Demo Page. At the control panel, select Printer >
Print Reference Material > Graphics Demo. Press the Print button
to print the Page If the Demo Page looks correct, the printer is
printing properly. Print problems are probably caused by your
application or incorrect settings in the print driver.

4. If the Demo Page did not print correctly, perform the Calibrate Color
procedure. At the control panel, select Printer > Tools >
Troubleshooting > Resolve Problems > Colors Look Wrong, then
perform the Calibrate Color procedure.

5. Perform the Clean Color Density Sensor routine.

MpumeuaHme. Select the video menu to view a detailed
video demonstrating the Color Density Sensor cleaning
procedure.

Page Marg
The image
the margin

Use the Image Position tool to adjust the image position on the page.

e page or | At the control panel, select Printer > Tools > Troubleshooting > Resolve
Problems > Page Margins are Inconsistent, then perform the Image
Position procedure.

Sides 1 and 2 U 1. To check alignment, hold your print up to a strong light and look for
The image is age or the shadow cast by side 2.

the margins 2. Perform the Image Position procedure. At the control panel, select
Printer > Tools > Troubleshooting > Resolve Problems > Side 1 & 2
Are Not Aligned. Perform the Image Position procedure.

DS AT A AT 1. Print the Test Pages to identify the affected color.

2. Use the Laser Window Cleaning Wand, located on the back of the
3 bomrnraemr=acscerc o front cover, to clean the laser windows of the affected color.

MprmeuaHme. Select the video menu to view a detailed
video demonstrating the cleaning of the laser window.
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Problem Solution

Toner Misd

. Verify that the paper you are using is the correct type for the printer
and is properly loaded. For information on supported paper types
and weights, at the control panel, select Printer > Print Reference
Materials > Paper Tips. Press the Print button to print the Paper Tips
embedded pages.

2. Verify that the Fuser Envelope Lever is set to the correct position.

3. Select a heavier paper at the control panel.

print or is &
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[lonyyeHue cnpaBku

B 3TOM pasgene paccMaTpuBatoTCA CeaytoLme BOnpochl.

e  CoobuieHna Ha NaHenn ynpaBneHus 139
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ﬂ,ﬂﬂ obecneyeHnn BbICOKOrO KAUeCTBA NeyaTty u AOJIKHOIo ypoBHA NPOU3BOAUTENIBHOCTHU Xerox ©
npeaocrasnAeT pag aABTOMATUHECKUX CPpeacTB ANATHOCTUKMN.

CoobuieHna Ha naHenn ynpassieHus

MaHenb ynpaBneHUa NpUHTEPA NO3BOJIAET NONYYMTb JOCTYN K PA3IMYHBIM CBEJEHUAM M CMIPABKE MO
YCTPAHeHMWIo HencnpaBHocTel. Ecnu Bo3HMKaeT ownbKa nnu ycnosue npeaynpexaeHus, Ha NnaHenu
ynpasfieHna oTobpaxaeTca cooTBeTCTBYoLLee cooblyeHWe. Kak npasuio, Ha naHenb ynpasieHus
BbIBOAMUTCA TAKKE AHUMUPOBAHHOE M306paXKeHHWe, yKa3biBatoLee MeCTo BO3HUKHOBEHWA Npobniembl,
Hanpumep 3acTpeBaHuUsA bymarun. 4nsa MHormMx coobuieHnin 06 owrMbKax 1 cTaTyce B CNPABOYHOM cUCTEME
NaHes M yNpaBAeHUA COAEPKATCA LOMNOSHUTENbHbIE CBEAEHUA.

Control Panel Help

Touch Help to view additional information about error or status messages on the control panel. The Help
button is labeled with a question mark symbol (?).

Most of the control panel menu items also have associated help text that describes the menu item.
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Viewing Error Messages on the Control Panel

1. Ha naHenu ynpaBneHus HaXxXmuTe KHOMNKyY MpuHTep.
2. T[epengute Ha BKNAaKy CUCT. cpeacTBa U HAXKMKUTE KHOMKY MoMUCK K ycTp. Heucnp.
3.  Touch Fault History.
The screen displays the number, date, and time for each Fault Code.
4,  Touch Back to return to the Troubleshooting screen, or touch Home to return to the main screen.

Viewing Current Faults on the Control Panel

When a fault condition occurs, a message appears on the control panel to inform you of the problem.
Fault messages warn you about printer conditions that prevent the printer from printing, or degrade
printing performance. If more than one fault occurs, only one is displayed on the control panel.

To view a list of the current faults on the control panel:
1. Ha naHenu ynpaBneHusa HaXXMUTe KHOMNKY MpuHTep.
2.  Touch Current Faults.
A list of the current faults appears on the screen.
3. Touch a fault to view the fault details.
4.  Touch X to close the screen.
5. Touch Back to return to the Troubleshooting screen, or touch Home to return to the main screen.

Viewing the Fault History on the Control Panel

When faults occur, they are logged in to a fault history file by date, time, and fault code. Use this list to
identify trends and resolve problems.

To view the fault history:
1. Ha naHenu ynpaBneHusa HaxXMuTe KHOMNKY MpuHTep.
2. Tepengute Ha BKNAAKY CUCT. cpeacTBA U HAXKMKUTE KHOMKY MOUCK K ycTp. Heucnp.
3.  Touch Fault History.
The screen displays the number, date, and time for each Fault Code.
4.  Touch a fault to view the fault details.
5. Touch Back to return to the Troubleshooting screen, or touch Home to return to the main screen.

Viewing Job Status on the Control Panel

To view personal and secure jobs on the control panel:
1. Ha naHnenu ynpasieHWs HAOXXMUTe KHOMKY PaboTbl.
2. HaxmuTte JIuuHble W 3awuLy,. paboTbl.

A list of assigned folders appears.
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Touch your assigned private folder.
Do one of the following:

e  BeauTe HasHayeHHbIM paboTe naposnb U HaxkmuTe OK. A list of the stored personal and secure
print jobs appears.

e  Touch Skip Passcode and only show Personal Jobs. A list of your personal jobs appears.
Touch the job you want to view.

The screen displays information about the job such as the owner, type, status, and time submitted
and completed.

To print the job, see Personal Print Ha cTp. 68 or Secure Print Ha cTp. 66.
[lns BO3BpATA K OCHOBHOMY 3KPAHY HAOXXMMWTE KHOMKY OCHOBHbIE PEXUMDI.

To view saved jobs on the control panel:

1.
2.

7.

Ha naHenu ynpasneHns HaxxmuTe KHonKy PaboTbil.
Haxkmute Coxp.pabotbi.

A list of folders appears.

To view public saved jobs, touch Public.

A list of public saved jobs appears.

To view private saved jobs, touch the assigned private folder.
BeeauTe Ha3HaYeHHbIM paboTe naposb U HaxmMuTe OK.

A list of private saved jobs appears.

Touch the job you want to view.

The screen displays information about the job such as the owner, type, status, and time submitted
and completed.

To print the job, see Saved Job Ha cTp. 67.
[na Bo3BpaATA K OCHOBHOMY 3KPAHY HAXXMUTE KHOMKY OCHOBHbIE peXXHMbl.

To view completed jobs on the control panel:

1.
2.

Ha naHenu ynpasneHus HaxkmMuTe KHonky Pa6oTbl.

Touch Completed Jobs.

The Completed Jobs screen displays recent completed jobs.
Touch the job you want to view.

The screen displays information about the job such as the owner, type, status, and time submitted
and completed.

Touch Back to return to the Completed Jobs screen, or touch Home to return to the main screen.

Using the Integrated Troubleshooting Tools

You can use several integrated tools to troubleshoot print-quality problems.
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MNMeuyaTb HHPOPMALMOHHBIX CTPAHULY

Ha naHenu ynpasneHus Haxxmute KHONKy MpuHTep.

Ha Bknagke «MHpopmauma» Haxkmute KHOMKy lMeuwatb cnpaBo4HbIX MATepUANOB.

[na yKa3aHWA KONMYeCTBA KOMUM HAXKMUTE KHOMKY #.

YKQKWTE KOIMYECTBO NeyaTaemMblX KOMUM C KNABUATYPbI UM C MOMOLLbIO KHOMKK + WU -,
Haxkmute kHonky OK.

C nomoLpbto CTpENKX BBEPX MM BHU3 BbibepUTe B CMMCKE CTPAHWLY ANA NeyaTy.

NoubswhN-=

HaxkmuTe KHoMKy Meuarsb.

MpumeyaHme. MHGOPMALMOHHbIE CTPAHMLBI TAKXKE MOXHO pacnedaratb u3 CentreWare Internet
Services.

YKa3saHue NoTKa UCTOUYHUKA Anda neyvyaTtv MH(I)OpMClLI,MOHHbIX CTpaHuy

Ha naHenu ynpaeneHna HaxmuTe KHonKy MpuHTep.

MepeignTe Ha BKNOAKY CUCT. CpeACTBA U HAXKMUTE KHOMKY YNpaBieHre NOTKAMM.
Haxxmnte UCTOUHHUK MHPOPM. CTPAHUL,.

BbibeprTe NOTOK MM HAXKMHUTE ABTOMATHUYECKH.

[na nogTeepxaeHUA HACTPOMKU HaXMUTe KHomnKy OK.

oun>wN-=

[Ans Bo3Bpara Ha BKNAAKY «CUCT. cpeacTBa» HaxXMUTe KHonKy Hasapa. [lns Bo3BpaTa K OCHOBHOMY
3KPAHY HAXKMUTE KHOMKY OCHOBHbIE PEXHUMbI.

MNeuatb oTueTa O KOHPUTYpALUH

1. Ha naHenu ynpaBneHusa HaXXMUTe KHOMNKY MpuHTep.
Ha Bknagke «MHpopmauma» Haxkmute KHOMKy MNeuatb cnpaBoYHbIX MATEPUAIOB.
HaxxmnTe OTUET 0 KOHOUTYpaLUH.

N

Haxkmute kHoMKy Meuatsb.

MpumeyaHue. Mo yMONYAHMIO OTYET O KOHOUTYPALMM NeYaTaeTcs NpuU BKAKYEHMU NpUHTepa. [na
OTKJIOYEHMSA AAHHOM HACTPOMKK BblibepuTe MpuHTep > Cuct. cpeactea > Hacrpoiika > O6wme
HACTPOMKM > HauanbHasa cTpaHvua > BeikniounTn.

npOCMOTp CYETYHUKOB y4yeTa U UCnoJib30BaHUA

1. Ha naHenu ynpaBneHusa HaXXMUTe KHOMNKY MpuHTep.

2.  Ha sknagke «MHpopmauma» Haxxmute CHETUMKM yueTa Aj1a NPOCMOTPA OCHOBHbBIX CHETYUKOB
OTNEeYaTKOoB:

L U.BETHbIX OTNEeYAaTKOB: YHAC/NO0 CTPAHUL, paCnNeyYaTaHHbIX B LUBETHOM peXHUME.
L4 l'|epHO-6€J1bIX OTNeYaTKoB: YN0 CTPpAHUL, paCnevyaTaHHbIX B qepHo-6en0M pexume.
L4 Bcero oTneuaTKos: o6mee YUCJ10 UBETHbIX U l-IepHO-6e}'IbIX OTNEeYaTKoB.
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[Mprumeuarve. CTpaHULEN HA3bIBAETCSA OAHA CTOPOHA JIUCTA ByMary, KOTOPYHO MOXHO NeYaTaTb Ha
OAHOM Unu aByX cTopoHax. CTpaHWLa, pacnedaraHHas Ha ABYX CTOPOHAX, CYUTAETCA 3d ABA
oTneyartka.

3. [na npocMoTpa noapo6bHON MHPOPMALMK MO UCMONb30BAHUIO HAXKMUTE KHOMKY CUeTUMKH
MCNOJIb30BAHUSA.

OnpepeneHne cepUMHOro HOMeEpaA HA NAHENU YNPAB/IEHUS

1. Ha nanenu ynpasneHua Haxxmute KHonky MpuHTtep.
2. Ha Bknapke «MHbopmauus» HaxxMuTe KHonky CBeaeHUs o NnpuHTepe.

Ha Bknagke «O6wue» oTobpaxaeTcs HAMMEHOBAHWE MOAENHW, CEPUMHBIA HOMEP, BEPCUA U AaTd
AKTUBALMH.

npOCMOTp COCTOAHUA paACXOAHDbIX MATEPUAJIOB MNMPUHTEpPA

1. TNepeiTn Ha BKNAAKY «Pacx. marep.» MOXHO OAHWUM U3 CJIeAyIOLLMX CMOCO6OB:
e Ha naHenu ynpasneHus HAXaTb KHoNKy MpuHTEp 1 oTKpbITb BKNAAKY Pacx. martep.
e  Haxatb 3Hauok C, M, Y nnu K B HAXKHEM NpaBOM yrny OCHOBHOIO 3KPAHA.

2. [lna npocMoTpa cBefieHWI O TOHEP-KAPTPHUAKE, BKIOYAA HOMep Ans 3akasa, Haxkmute C, M, Y nnu
K.

3. [inA BO3BpATA HA BKAAAKY «Pacx. maTtep.» HAXMUTE 3aKpbITb.

4,  [Ina npocMoTpa cBefileHWM o Pbto3epe, cbopHUKe 0TX0A0B, 6510Kax GOpMUPOBAHUS U306paKEHUS,
Habope ans 06CNyKMBAHUS UKW KAPTPUZKE CLUMBATENS HAXKMWUTE KHOMKY Jpyrue pacxogHble
MaTepuabl. C MOMOLLbIO CTPESIKU BBEPX MW BHU3 BblbepuTe B CNIUCKE AAHHbIE A4S MPOCMOTPA.

5. Ans Bo3BpaTa HA 3KpaH «Jlpyrve pacxogHble MATEPUAIbI» HAXMUTE KHOMKY Hasaa,

UYtobbl pacneyataTb CTPAHULY UCMONb30BAHWUS MATEPUANIOB, HAXKMUTE 3HadoK Meuartb v BbibepuTte
Ucnonb3oBaHMe maTepuaos.

7. [lna Bo3BpaTA K OCHOBHOMY 3KPAHY HAXMHTE KHOMKY OCHOBHbIE peXXUMbI.

PhaserSMART Technical Support

PhaserSMART Technical Support is an automated, internet-based support system that uses your Web
browser to send diagnostic information from your printer to the Xerox® website for analysis.
PhaserSMART Technical Support examines the information, diagnoses the problem, and proposes a
solution. If the problem is not resolved with the solution, PhaserSMART Technical Support assists you in
opening a Service Request with Xerox Customer Support.

To access PhaserSMART Technical Support:

1. Open your Web browser and go to www.phaserSMART.com .
2. Enter the IP address of your printer in the form fields.

3. Follow the instructions on the page.
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CentreWare Internet Services

ﬂ'OI'IO}'IHI/ITeJ'I bHble CBeJeHNA

ﬂ,OI’IOﬂHMTeﬂbeIe cBe€HHUA O NPUHTEPE MOXHO NOJTY4UTb U3 Ciegyrowmnx NCTOYHHUKOB!

Pecypc

PykoBodcmBo no ycmaHoBKe

Mec eHue

BxoauT B KOMNNeKT npuHTEPA

Kpamkoe pykoBodcmBo nonb3oBamens

BxoauT B KOMNNeKT npuHTEpPA

System Administrator Guide (PykoBodcmBo cucmemHoz2o
aomuHucmpamopa)

www.xerox.com/office/6700docs

YyebHble BUAEOKYpPCbI

Ha naHenu ynpasneHus npuHTEpa 1 Ha Beb-canTe

www.xerox.com/office/6700docs

Recommended Media List (Cnucok pekomeHayembix
MATEpPUAIOB)

CLUA: www.xerox.com/paper
EBpona: www.xerox.com/europaper

TexHuyeckas nogaepxka PhaserSMART no3sonset
ABTOMATHUYECKHU BbIABNIATb Hel/ICI'IpQBHOCTVI anHTepa B
CeTU U NPeANaraeT peLleHUs Mo UX YCTPAHEHHIO.

www.phasersmart.com

ConpoBoauTesibHble CBEAEHUS TEXHUUECKOTO XAPAKTepd:
MHTepHeT-cyx6a noanepxku, cuctema Online Support
Assistant (OHNQMHOBBIM ACCUCTEHT NOALEPKKM) U
3arpysKa AparBepos.

www.xerox.com/office/6700support

CBefeHuA 0 MeHo 1 coobuyeHunsax o6 owmnbke

KHonka «Cnpaeka» (?) Ha NaHeny ynpasnieHus

MHbopMaLMOHHbIE CTPAHMLbI

MeuaTb U3 MeHIO NaHeNn ynpasneHuna

3akas pacxogHblX MaTtepmuanos AsA NpuHTepa

www.xerox.com/office/6700supplies

Pecypc, BKNIOUAIOLLMI MHCTPYMEHTASIbHbIE CPeACTBA U
MHOPMALMIO, HAMPUMEP UHTEPAKTUBHbIE yuyebHble
KYpCbl, WaboHbl ANAa neyaTtu, nosie3Hble COBETbI U
HOCTPAWBAEMbIE PEXMMbI, OTBEUAIOLLME
MHAWBUAYAIbHBIM NOTPEBHOCTAM.

www.xerox.com/office/businessresourcecenter

MecTHble LeHTPbl MPOAMK U NOALAEPIKKH

www.xerox.com/office/worldcontacts

Perncrpauums npuHTepa

www.xerox.com/office/register

MHTepHeT-marasuH Xerox® Direct

www.direct.xerox.com/
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TexHUYeCK1e XapPAKTEPUCTUKM

KoHdurypaumm npuHTepa 1 onumm

Standard Features

The WorkCentre 7500 Series Multifunction Printer provides the following features:
e Print

e  Maximum copy speed of up to 50 pages per minute (ppm) for color and up to 55 ppm black and
white copying on letter size plain paper (speed dependent on configuration)

e 1200 x 2400 dpi laser imaging quality

e  Print document size up to SRA3/12 x 18 in.
e Automatic 2-sided printing

e Color touch screen display on control panel

e  Tray 1 with capacity of up to 520 sheets

e  Bypass tray with capacity of up to 100 sheets
e 2 GB memory plus 1 GB page memory

e Internal 160 GB hard drive

e  PostScript and PCL fonts

e  Ethernet 10/100/1000Base-TX connection
e  Universal Serial Bus (USB 2.0)

e PostScript, PCL, and XPS support

o Server fax

e Job Based Accounting

e Data Security

o Internet Fax (iFax)

e Xerox® Extensible Interface Platform (EIP)
e  USB Memory Print

Available Configurations

Printer Configurations

Features 6700N 6700DN 6700DT 6700DX
Standard memory 1 GB RAM 1 GB RAM 1 GB RAM 1 GB RAM
BcTpoeHHbIN WeCTKUIM aUCK Optional Optional Optional Yes
emKkocTbio 160 I'b
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ABTOMATHYECKASA No Yes Yes Yes
[IBYCTOPOHHSA NeudTb

Standard trays 2 2 3 4
Optional trays Upto4 Upto4 Upto3 Upto2

Options and Upgrades

e  Finisher, including transport unit, with capacity of 1000 sheets
e  Offset stacking arms
e  Stapler with capacity of 5000 staples

e High capacity feeder, consisting of two 550-sheet trays permanently fastened to a base with
lockable front wheels and anti-tip outriggers

o  Single feeder unit, consisting of one 550-sheet universal adjustable paper tray
e Wheeled cart, adjustable to either 220 mm or 295 mm height

e  DELETE THE REST? (BORROWED FROM NORTHWOOD)

e Xerox® Secure Access Unified ID System

e  FreeFlow SMARTsend

e Xerox® Common Access Card Enablement Kit
e Xerox® Copier Assistant (XCA)

e  Foreign Device Interface

o  EFI workflow

e  Unicode Print
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[abapuTHble pa3mepbl 1 BeC

Base Configuration

e Width: 560 mm (22 in.)
e  Depth: 516 mm (20.3in.)
e  Height: 429 mm (16.9 in.)
e  Weight: 42.2 Kg (93 Ib.)

Base Configuration

e Width: 570 mm (22.4in.)
e  Depth: 516 mm (20.3in.)
e Height: 563 mm (22.1 in.)
e  Weight: 53.2Kg (117 Ib.)

Phaser 6700DX Configuration

e Width: 570 mm (22.4in.)
e  Depth: 516 mm (20.3 in.)
e  Height: 697 mm (27.41in.)
o  Weight: 64.2Kg (141.2lb.)

Configuration with Finisher

e  Width: xxx mm (xx in.)

e Depth: xxx mm (xxx in.)

e Height: xxx mm (xxx in.)

e  Weight: 57.9Kg (127.6 |b.)

Clearance Requirements
Provide enough room to open the printer tray, covers, and optional accessories.

tb_007

Printer Clearance Requirements for Base Configuration

Provide enough room to open the printer tray, covers, and optional accessories.
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tb_007

Printer Clearance Requirements for Base Configuration With Finisher
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TpeboBaHMA K OKpyXKatollen cpeae

Temperature
o 10°-32°C
o 50°-89°F

Relative Humidity

Operating: 10 % to 85 % (non-condensing)

Elevation

For optimum performance, use the printer at elevations below 3,700 m. or 10,170 ft.
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TexH1UUYeCK1e XapPAKTEPUCTUKM

Electrical Specifications

Power Supply Voltage Frequency Current Required Power Consumption
(full system)
110-127 VAC+/-10% 50 Hz +/- 3 Hz 13.2A 1584 VA @ 120 V (Max)
60 Hz +/- 3 Hz
220-240 VAC+/-10% 50 Hz +/- 3 Hz 8A 1920 VA @ 240 V (Max)
60 Hz +/- 3 Hz 1760 VA @ 220 V (Max)

Power Supply Voltage and Frequency

Power Supply Voltage Power Supply Frequency
110-127 VAC +/-10 %, (99-144 VAC) 50Hz +/-3Hz
60 Hz +/- 3 Hz
220-240 VAC +/-10 %, (198-264 VAC) 50Hz +/- 3 Hz
60 Hz +/- 3 Hz

Power Consumption

Peak Power Average Power Low Power (Standby) Power Saver Sleep

1500 W 700 W 130W Less than 45 W

ENERGY STAR Qualified Product

As an ENERGY STAR partner, Xerox® Corporation has determined that the DN, DT, and
DX configurations of this product meet the ENERGY STAR guidelines for energy
efficiency.

The ENERGY STAR and ENERGY STAR mark are registered United States trademarks.

The ENERGY STAR Imaging Equipment Program is a team effort between United
States, European Union, and Japanese governments and the office equipment industry
to promote energy-efficient copiers, printers, fax, multifunction printers, personal
computers, and monitors. Reducing product energy consumption helps combat smog,
acid rain, and long-term changes to the climate by decreasing the emissions that result
from generating electricity.

Xerox® ENERGY STAR equipment is preset at the factory to switch to Energy Saver Mode after two
minutes from the last copy or print. For details, see Energy Saver Mode. DEFAULT FOR HAYDEN IS O,
CORRECT?
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JKCMNYATALUMOHHbIE XAPAKTEPUCTUKM

Printing Resolution

Maximum Resolution: 1200 x 2400 dpi

Print Speed

Print Mode Color Black and White
600 dpi 45 ppm 45 ppm

1200 dpi 50 ppm 55 ppm
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TexH1UUYeCK1e XapPAKTEPUCTUKM

XAPAKTEPUCTUKU KOHTPOJIIEPA

Processor

1.25 GHz processor

Memory
Memory Technology Size Clock Speed Specifications
System Memory DDR2, non-ECC 2GB 333 MHz 200-pin SODIMM,

667 MWords/s
EPC Memory DDR2, non-ECC 1GB 133 MHz 200-pin SODIMM,

267 MWords/s, 32 b wide
Flash Memory EEPROM 32 MB NA Daughter card. Derived from
NVM SRAM 512 KB NA the Gawain FLASH/NVM.
JPEG Buffer SRAM 1 MB (256 Kb*32) 200 MHz Soldered to PWBA.
Interfaces

[}

[}

e  Ethernet 10/100/1000 Base T
e USB host
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Available Configurations

Print Speed in ppm

(1-sided and 2-sided)

Phaser 45 color/45 monochrome GET HAYDEN
WC7525_WC7530_WC7535_WC7545_WC7556N
Multifunction Printer

Phaser 50 color/55 monochrome
WC7525_WC7530_WC7535_WC7545_WC7556DN
Multifunction Printer

Phaser
WC7525_WC7530_WC7535_WC7545_WC7556DT
Multifunction Printer

Phaser
WC7525_WC7530_WC7535_WC7545_WC7556DX
Multifunction Printer

Printer Configurations

Features WC7525_WC75 WC7525_WC75 WC7525_WC75 WC7525_WC753
30_WC7535_W 30 _WC7535_W 30 _WC7535_ W 0_WC7535_WC7
C7545_WC7556 C7545_WC7556 C7545_WC7556 545_WC7556DX
N DN DT
Base memory (GB) 1 1 1 1
Hard drive Optional Optional Optional Yes
Automatic 2-sided printing No Yes Yes Yes
Auxiliary trays 1-4 No 1-3, withno hard |1-2

drive installed
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CTAHOAPTAM

JlaHHOe NpunoxKeHne BKIIOYOET:
e OcHOBHble HOpMATHBHbIe TpeboBAHMA 156
e  Material Safety Data Sheets (JJaHHble no 6e30nacHOCTM MATEPUANOB) 158
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CooTBeTCTBME CTAHAAPTAM

OcCHOBHble HOpMATUBHbIE TPebOBAHMKA

Komnaxus Xerox nposena UCMbITAHWS JAHHOMO NMPUHTEPA HA COOTBETCTBHUE CTAHAAPTAM MO
3/1eKTPOMArHUTHOMY M3TYYEHUIO MU MOMEXOYCTOMUYMBOCTU. [lJaHHbIe CTaHAAPTL! pa3paboTaHbl 4sis
CHWXXEHUA YPOBHSA NOMeX, CO3AABAEMbIX MTPUHTEPOM UK BAMAIOLLMX HA €ro paboTy B 06bIUHbIX YCIOBUSAX
oduca.

Mpasuna PepepanbHom Komuccmm no ceasm CLUA

A aHHoe 06opyAOBAHWE NPOTECTUPOBAHO U COOTBETCTBYET CTAHAAPTAM ANs LMdPOBOro 060pya0BAHMS
Kknacca B B cootBeTcTBMM C YacTbio 15 Mpasun QepepanbHon komuccun no cesizu (PKC). ITr Hopmbl
npeAHA3HaYeHbl ANnA obecneyeHUs HEOH6XOAMMOM 3aLMUTbI OT MOMEX NP UCTMOIb30BAHWUM AJAHHOTO
annapara B ycnosuax oduca. JlaHHbIM annapar reHepupyeT, UCNONb3YET U MOXKET U3/1y4dTb SHEPTHIO B
noJsioce pagrMoyacToT. B cnyuae HapyLleHUs HACTOALWMX YKA3AHWM N0 YCTAHOBKE M UCMO/Ib30BAHWIO OHO
MOXET CO3AaBATb BpefHble NoMeXu pagrocesa3su. Mpu aKcnayatauyuy 3Toro annapara B W01 30He
BO3MOXHO BO3HUKHOBEHWE HEA0MYCTUMbIX MOMEX, KOTOPbIE NOJIb30BATE b JO/HKEH YCTPAHATL 3A CBOWM
cyeT.

Ecnu paHHoe obopynoBaHWe SBASETCA UCTOYHUKOM HEA0MYCTUMBIX NOMEX NPUeMy pagmo- 1
Te/IeBU3MOHHBIX CUTHAJIOB, YTO OMPeAeNAeTCs MyTEM ero BbIK/IOUEHWA W BKIIIOUEHUS], MOXHO
nonpo6oBaTb YCTPAHUTL MOMEXH, MPEANPUHSAB NEPEUUCTIEHHBIE HUXKE MEPbI.

o MN3meHuTe OPHEHTALMIO MK paACNONIOKEHHE I'IpMHMM(]I'OLIJ,eﬁ AHTEHHbI.
° YBenuubTte pacctoaHne mexxay O60pyﬂ,OBGHMeM 1 NPpUHUMAKOLWNM yCTpOFICTBOM.

e [logkniounte 0bopynOBAHME K PO3ETKE B PYrOi BETBU CETU SNEKTPOMNWUTAHUSA, OT KOTOPOM He
MUTAETCA NPUHMMAOLLEee YCTPOMCTBO.

e 06paTuTeCch 30 NOMOLLbIO K NPOAABLY M60 KBANMOULMPOBAHHOMY PAZMO- UK TeNIeMACTepy.

BHeceHWe M3MeHeHWIH 1 MoZepHHU3aLMA annapaTa 6e3 paspeLleHrsi KOMNAHUKU Xerox MOXeT NpPUBECTH K
noTepe NpABA 3KCMyATALMK AAHHOIO Annapara.

[Mpumeuarue. ina obecneyeHnsa cootseTcTBUA yacth 15 npasun OKC ncnonbsyite
SKPAHWUPOBOHHbIE MHTepdelcHble Kabenu.

Kanapa
JaHHbI uMdpoBor annapar knacca A cootseTcTyeT ctaHaapTy KaHaabl ICES-003.

Cet appareil numérique de la classe A est conforme @ la norme NMB-003 du Canada.
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CooTBeTcTBME CTAHAAPTAM

Esponencknin Coto3

r’i\. BHUMAHMUE! JanHbii annapat cootBeTCcTBYET Kaccy A. [pr MCNONb30BAHWMK B WO 30HE 3TOT
annapar MoXeT bbITb UCTOYHUKOM pasronomMex. B aTtom cnyyae nonb3osartento Heobxoanmo byaet
npeanpuvHATbL COOTBETCTBYIOLLWE MepbL.

Mapkuposka CE Ha AaHHOM annapare CUMBOIM3UPYET AEKIAPALMIO KOMMAHWUK Xerox o ero
c € COOTBETCTBMU C/leaytoLlnM anpexkTuam EBponeiickoro Coto3a, NPUHATBIM B YKA3AHHbIE
AaTbl:
e 12 pekabpsa 2006 r.: aupekTrea Coseta EC 0 HU3KOBOJILTHOM 060PYAOBAHMM
2006/95/EC
e 15 pekabps 2004 r.: pupekTtnBa Coeta EC 06 3ne€KTPOMArHUTHOM COBMECTUMOCTH
2004/108/EC

Mp# ycnoB1M NPABUIBHOIO MCMOJIb30BAHKWA AAHHOTO NPUHTEPA B COOTBETCTBUU C UHCTPYKLIUAMM OH He
NpeACTaBAAET HUKAKOM ONACHOCTU AN1A NOTPebUTeNnei 1 OKpyxatoLei cpeabl.

B uensx obecneueHusa cootBeTcTBMA cTaHAApTAM EC ncnonb3yiTe sKpAHUPOBAHHbIE MHTEpPdENCHbIe
kabenu.

Konwuio noanvMcaHHOro 3aaBneHMsa 0 COOTBETCTBUM AAHHOIO NPUHTEPA CTAHAAPTAM MOXHO NOY4YUThb B
KOMMOHWK Xerox.

[paBuna orpaHUyYeHnsa CoaepXaHns onacHbix Belects (Typums)

CornacHo Cratbe 7 (d) HACTOAWMM NOATBEPKAAETCSA COOTBETCTBME ANMAPATA HOPMATUBHBIM
TpeboBaHMAm EEE.

"EEE yonetmeligine uygundur.”
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CooTBeTcTBME CTAHAAPTAM

Material Safety Data Sheets (daHHbie no
6e30nacHOCTH MaTepuanos)

Jna nonydyeHusa nHpopmauum o 6e30NacHOCTH MATEPHUASIOB, UCMOJIb3YEMbIX B MPUHTEPE, MOCeTUTE
Be6-canT:

o CeepHas Amepuka: www.xerox.com/msds

e  Eponerickunit Coto3: www.xerox.com/environment_europe

TenedoHbl LeHTPA TEXHUYECKOW NOAAEPKKM YKA3AHbI HA Beb-canTe
www.xerox.com/office/worldcontacts .
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BropunuHas nepepaboTKa

nYTHUJIN3ALUNA

ﬂ,QHHOE NPUNOXKeHUEe BKIKOUAET:

Bce cTpaHbl
CeBepHasa AmepuKa
Esponevickui Coto3

Jpyrve cTpaHbl

160
161
162
165
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BTopuuHas nepepaboTka 1 yTuamsaums

Bce cTpaHbl

Ecnv Bbl 0TBeYdeTe 3a YTUAM3ALMIO U3enus Xerox®, 06patute BHUMAHWE, YUTO MPUHTEP MOXET
COZlepaTb CBUHEL, PTYTb, NePXJIOPATbI U APYrie MaTepuabl, yTUAN3ALUSA KOTOPbIX MOXeT
perynumpoBaTbCa AEUCTBYIOLLIMMU MPABUIAMM 3ALLMTLI OKpYKatoLler cpeabl. CofepaHWe AAaHHbIX
MATEPUAIOB NOSIHOCTBIO COOTBETCTBYET MUPOBbLIM CTAHAAPTAM, MPUMEHUMbIM HO MOMEHT BbIMYyCKA
M3aeNus Ha PbIHOK. ns nonyyeHus HGOPMALMK 0 CNOCcobax BTOPUUHOM NEPepaboTKU U YTUAN3ALUK
annapara o6paTuTecb B MECTHbIE YNONHOMOYEHHbIE OPraHbl. XTOPHOKUC/IbIA MATEPHUAN: 3TO U3JeNne
MOXET COIEPKATb OAHO UM HECKOJIBKO YCTPOMCTB C NEPX/IOPATAMM, HAMPUMEP AKKYMYNATOPbI. 418 HUX
MOXeT 6bITb NpeAyCcMOTPeHda cneuunanbHas o6paboTka, MHopmaLmio CM. Ha Beb-canTe
www.dtsc.ca.gov/hazardouswaste/perchlorate .
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BTopuuHas nepepaboTka 1 yTuamsaums

CeBepHas AmepurKa

KomnaHusa Xerox peanunsyeTca nporpamMmmy no Bo3spary, NOBTOPHOMY MCMO/Ib30BAHWIO U BTOPUYHOWM
nepepaboTke 060pyA0BAHKUA. YTOOBI y3HATL, pACAPOCTPAHAETCA /1M 3TA NPOrPAMMA HA AGHHBIM annapar
Xerox®, 06paTuTech B MeCTHOe TOProBoe NpezCTAaBUTENLCTBO KOMMaHKKM Xerox (1-800-ASK-XEROX).
Noapo6Has UHdopMaLa 06 3KoNorMYecKrx Nporpammax Xerox® coaepuTca no agpecy
www.xerox.com/environment . lns nonyyeHus cBefieHMH o cnocobax BTOPUUHOM NepepaboTKu 1
yTUnusaumum o6opyAoBaHna obpatnTeck B MeCTHblE YNOJIHOMOYEHHbIE OPraHbl.
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BTopuuHas nepepaboTka 1 yTuamsaums

Esponenckunmn Cotos

OpHo u TO e O60py,£I,OBClHMe MOXHO 3KCNJ1yaTUpOBATb KAK B 6bITOBbIX (AOMGLUHMX) YCNoBHUAX, TAK U B
KOMMeEpPYeCKHUX Lenax.

bbiTOBOE MCNONb30BAHUE

Hanunume aaHHoro cMBond Ha annapare yKasbIBAET, YTO
060pyAOBAHWE HeJlb3sl YTUIIM3MPOBATH BMECTE C ObITOBbIMKW OTXOAAMMU.

B cooTBeTCTBMM C €BPONENCKUM 30KOHOAATEIbCTBOM DNIEKTPOTEXHUYECKHUE U DNIEKTPOHHbIE YCTPOMCTBA
MO OKOHUYAHMIO CPOKA CNYXObI CefyeT yTUIIM3MPOBATL OTAENIbHO OT ObITOBbIX OTXOZ0B.

YacTHble fomoBnagenblibl B cTpaHax-uneHax EC moryT 6ecnnatHo BepHYTb MCMOJIb30BAHHOE
3/1EKTPOTEXHUYECKOE U 3NIEKTPOHHOE 060PYA0BAHMWE B NPeAHA3HAYEHHbIE NS 3TOro NYHKTbI cbopa. 3a
nHpopmMaLMei obpaLlanTecb B MECTHbIE YNOJIHOMOYEHHbIE OPTraHbl MO YTUIM3ALMM.

B HekoTopbIx cTpaHax-uneHax EC npu nokynke HOBOro 060pyA0BaHUsi TOProBble OPraHU3dLMK
npeanaratoT 6ecnaaTHbIM NpUeM UCNoNb30BAHHOTO o6opyaoBaHUA. [oagpO6HYI0 MHPOPMALMIO MOXKHO
Moy4YnTb Y PO3HUUYHOIO NPOAABLd.

KOMMep‘-IECKOE MCMNoJib30BAHUE

Hanunuune AAHHOro CMMBOJ1A HO annapare yKasbIBAET HA TO, YTO €ro
cnepyeTt YTUNnM3nMpoBdTb B COOTBETCTBUU C YCTAHOBJIEHHbIMU
HAUMOHAWIbHBIMKX HOPMOAMUK U NPABHUIAMM.

B cooTtBeTCTBMM C eBpOﬂeﬁCKMM 30KOHOAATEJIbCTBOM 3JIEKTPOTEXHUYECKOE U SJTIEKTPOHHOE
060pyAOBO.HVIe, nognexauiee yTmansaumm no OKOH4YaHUKU CPpOKa CBOEM CJ'Iy)'K6bI, HeOGXO,D,MMO
YTUIN3NPOBATb B COOTBETCTBHMU C YCTAHOBJIEHHBIMK NPABUJTIAMHA.

Mepea ytunusauunern obpatutecb K MECTHOMY AWNIEPY MU B NPEACTABUTENBLCTBO Xerox 3a MHopmauuen
no Bo3BpATY 060pYI0BAHKSA N0 OKOHUYAHMWIO €r0 CPOKA CYHKObI.
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BTopuuHas nepepaboTka 1 yTuamsaums

C6op 1 yTnnnsaumnsa o60pya0BAHUA U AKKYMYIATOPOB

Hanuuue Ha n3pennax n COI'IyTCTByPOLIJ,EI‘/II AOKYMEHTAUNN AAHHbIX
CMMBOJIOB O3HAYAET, YTO UCNOJIb3OBAHHbIE 3JIEKTPOTEXHHUYECKHUE U
3JIEKTPOHHbIE NU3eNNUA U AKKYMYJTATOPbI HENb3A Bbl6pCle|BC1Tb BMecCTe
€ 6bITOBbIMU OoTX04AaMM.

Ans obecneuyeHua Hagnexauier obpaboTKK, BOCCTAHOBIEHWUS U
BTOPUYHOWM NepepaboTKU UCMO/Ib30BAHHBIE U3AENNA U AKKYMYSATOPbI
cnefyeT CAABATL B COOTBETCTBYIOLLME NYHKTbI C6OpA, pyKOBOACTBYSChb
HALMOHABbHBIM 3AKOHOAATENLCTBOM U anpekTuBamu 2002/96/EC un
2006/66/EC.

YTUNU3Mpys AAHHbIE U3LeNTUA U AKKYMYNATOPbI HOAJIEXALLUM
06pa3om, Bbl MOMOraeTe 3KOHOMUTb PECYPCbl U NpeaoTBpdALLdeTe
HeraTMBHbIe NOCNEACTBUA A8 300POBbA JIOAEN U OKPYKAIOLLEN
cpeabl, KOTOpPbIE HACTYNAIT B C/lydde HAPYLUEHHWS NPABUA YTUIM3ALMK
OTXOJ0B.

3a nHdpopmaumer no cbopy U BTOpUUHOM NepepaboTke
MCMNONb30BAHHbIX U3LENNI U AKKYMYNATOPOB 0bpallanTecs B MeCcTHble
YNOJIHOMOYEHHbIE OPraHbl, CTYXKObl YTUAU3ALMK OTXOA0B MIIM MO MECTy
npuobpeTeHns TOBAPOB.

HapylieHune npasun yTMAn3aunmM oTXoA0B MOXKET NoBJieYb 3a cObok
WTpadHble CAHKLUWK, NPeayCMOTPEHHbIE€ HOLMOHAIbHbIM
30KOHOAATE/IbCTBOM.

[na kopnopatuBHbIX Nonb3osarenei B EBponerickom Cotose

3a uHbopMaLMEN MO YTUIMU3ALMU DNIEKTPOTEXHUUECKOTO U 3/IEKTPOHHOro 060pyA0BaHMS 0bpawanTecs
K COOTBETCTBYIOLLEMY AUNEPY MKW NOCTABLUMKY.

YTunusauyusa 3a npegenamu Esponenckoro Corosa
JlaHHble cMMBONBI MpeaHa3HayYeHbl TONbKO Ana ctpaH EBponevickoro Cotosa. 3a nHdopmavmer no

YTUIM3AUMK SAHHbBIX M3LeSIMK 06pallaiTech B MECTHbIE YMOJIHOMOYEHHbIE OPraHbl UK K
COOTBETCTBYIOLEMY AUIIEPY.

3ameyaHue no CUMBONY AJ1A AKKYMYSITOPOB

JaHHoe nsobpaxeHne MycopHOro 6aka MoXeT MCNoJb30BATLCA
BMeCTe C CUMBOJIOM XMMHYECKOro 31eMeHTA. 3TO 03HAYAET HaslMune
TpeboBAHWI, NPpelyCMOTPEHHbIX YKA3AHHOW AUPEKTUBOM.
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BTopuuHas nepepaboTka 1 yTuamsaums

3amMeHa GKKyMynSaTOpPOB

3amMeHy OKKYMynATOPOB pa3peLuaeTca NPOU3BOAWUTL TONIbKO CEPBUCHBIM OPraHM3ALMAM,
ynonHomoueHHbIm-NTPON3BOANTENIEM.
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BTopuuHas nepepaboTka 1 yTuamsaums

Apyrue cTpaHsbl

3a MHCI)OpMClLI,MEﬁ no ytuansauuu 06pClLLI,ClﬁTECb B MeCTHbl€ YNOJIHOMOYEHHbIE€ OPraHbl Mo yTUIU3ALHNH
OTXO00B.
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